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Legal Notices

Warranty

The only warranties for HP products and services are set forth in the express warranty statements 
accompanying such products and services. Nothing herein should be construed as constituting an additional 
warranty. HP shall not be liable for technical or editorial errors or omissions contained herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent 
with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and 
Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard 
commercial license.

Copyright Notices

© Copyright 2002-2006, 2009 Hewlett-Packard Development Company, L.P.

Trademark Notices

UNIX® is a registered trademark of The Open Group. 

Windows® is a US registered trademarks of Microsoft Corporation.

Java™ is a US trademark of Sun Microsystems, Inc.

For information about third-party license agreements, see the %ovinstalldir%/license-agreements/SPI 
directory on the product installation CD-ROM.
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Documentation Updates

This guide’s title page contains the following identifying information:

• Software Version number, which indicates the software version.

• Document Release Date, which changes each time the document is updated.

• Software Release Date, which indicates the release date of this version of the software.

To check for recent updates, or to verify that you are using the most recent edition of a document, go to:

http://h20230.www2.hp.com/selfsolve/manuals 

This site requires that you register for an HP Passport and sign-in. To register for an HP Passport ID, go to: 

http://h20229.www2.hp.com/passport-registration.html 

Or click the New users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product support service. 
Contact your HP sales representative for details.
3



Support

You can visit the HP Software Support Online web site at:

http://www.hp.com/go/hpsoftwaresupport 

This web site provides contact information and details about the products, services, and support that HP 
Software offers.

HP Software Support Online provides customer self-solve capabilities. It provides a fast and efficient way to 
access interactive technical support tools needed to manage your business. As a valued support customer, you 
can benefit by using the HP Software Support web site to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also require a 
support contract.

To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp 

To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html 
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1 WebLogic SPI Concepts
The HP Operations Smart Plug-in for BEA WebLogic Server (WebLogic SPI) enables you to 
manage WebLogic Servers from an HP Operations Manager for UNIX (HPOM) console. the 
WebLogic SPI adds monitoring capabilities otherwise unavailable to HPOM. For more 
information on HPOM, see HP Operations Manager for UNIX Concepts Guide.

Introducing the WebLogic SPI

In conjunction with HPOM, the WebLogic SPI offers centralized applications that help you 
monitor and manage systems using WebLogic Server. From the HPOM console, you can apply 
the HPOM performance and problem managing processes to monitor systems using WebLogic 
Server. The WebLogic SPI metrics are automatically sent to the HP Operations agent. These 
metrics can generate alarms or be consolidated into reports and graphs to help you analyze 
trends in server usage, availability, and performance. You can also integrate the WebLogic 
SPI with HP Reporter and HP Performance Manager (both products must be purchased 
separately) to obtain additional reporting and graphing flexibility and capabilities. For details 
on integrating the WebLogic SPI with other HP products see Integrating HP Reporting and 
Graphing Products with the WebLogic SPI.

Smart Plug-in Data

The WebLogic SPI has several server-related metrics that gather data about the following:

• Server availability

• Server performance

• Memory usage

• Transaction rates

• Servlet executing times, time-outs, request rates

• JDBC connection status

• Web application processing

• Java message service processing

• Cluster processing

• Exception counts of scheduled WLS actions
13



Smart Plug-in Uses and Customizations

As a WebLogic Server administrator, you can choose the metrics crucial to the operation of 
WebLogic Server by modifying the WebLogic SPI templates. The templates contain settings 
that allow incoming data to be measured against predefined rules. These rules generate 
useful information in the form of messages. The messages have color-coding to indicate the 
severity level. You can review these messages for problem analysis and resolution. There are 
several pre-defined corrective actions for specific events or threshold violations. These 
corrective actions can be automatically triggered or operator-initiated. When you double-click 
a message, corrective actions appear under the Instructions tab and automatically generated 
metric reports appear under the Annotations tab.

Functions of the WebLogic SPI

The WebLogic SPI messaging, reporting, and action-executing capabilities are based on the 
HPOM concept of templates. For more information, see HP Operations Manager for UNIX  
Concepts Guide. The settings within these templates define various conditions that may occur 
within the WebLogic Server and allow information to be sent back to the HPOM management 
server. This helps you to proactively address potential or existing problems and avoid serious 
disruptions to web transaction processing. The WebLogic SPI performs the following 
functions described in the following sections:

Collecting and Interpreting Server Performance and Availability Information

After you configure the WebLogic SPI, and the templates are deployed to the managed nodes, 
the SPI starts gathering server performance and availability data. This data is compared with 
the settings within the deployed templates. The templates define conditions that can occur 
within the WebLogic Server, such as queue throughput rates, cache use percentages, timeout 
rates, and average transaction times. The templates monitor these conditions against default 
thresholds (set within the templates) and trigger messages when a threshold has been 
exceeded.

Displaying Information

The WebLogic SPI templates generate messages when a threshold is exceeded. These 
messages can appear as:

Messages in the Message Browser– HP Operations agent software compares the values 
gathered for WebLogic Server performance and availability against the monitor template 
settings related to those specific areas. The agent software then forwards appropriate 
messages to the HPOM console. These messages appear with color-coded severity levels in the 
HPOM message browser.
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Instruction Text– Messages generated by the WebLogic SPI programs contain instruction 
text to help analyze and solve problems. You can manually perform corrective actions 
preassigned to events or they can be triggered automatically.

Instruction text is usually present in the message details. Instruction text is also available in 
the HP Operations Smart Plug-in for BEA WebLogic Server Reference Guide.

ASCII-Text Reports– In addition to the instruction text, some messages cause automatic 
action reports to be generated. These reports show conditions of a specific WebLogic Server 
instance. If a report is available, you can find it within the Annotations area of the Message 
Details. 
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Generating Reports Using HP Reporter

You can integrate the WebLogic SPI with HP Reporter to provide you with 
management-ready, web-based reports. The WebLogic SPI Report package includes the 
templates for generating these reports. You can install the Report package on the Reporter 
Windows system.

After you install the product and complete basic configuration, Reporter generates reports of 
summarized, consolidated data every night. With the help of these reports you can assess the 
performance of the WebLogic Server over a period of time.

Reporter uses the WebLogic SPI data to generate reports that illustrate for example, servlet 
request rates, transaction throughput rates, and average transaction execution time.

Figure 1 Reports generated by HP Reporter 

Graphing Data with HP Performance Manager

Metrics collected by the WebLogic SPI can be graphed. The values can then be viewed for 
trend analysis.

You can integrate the WebLogic SPI with HP Performance Manager to generate and view 
graphs. (use the View Graphs application from the WLSSPI Admin applications group to view 
graphs). These graphs show the values of the metrics collected by the WebLogic SPI. You can 
click Perform Action to view graphed data from almost all the WebLogic SPI alarm messages. 
Perform Action is present in the message browser and in the message details (you can access 
details by either double-clicking the message or clicking Details...in the message browser) in 
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the message browser. The action launches your Web browser, where you can choose a graph 
that shows values for the metric that generated the message as well as other related metrics. 
The following is a sample graph.

Customizing Templates and Metrics

You can use the WebLogic SPI templates without customization, or you can modify them to 
suit the needs of your environment. Some of the modifications and customizations that you 
can do are the following:

• Modify the default templates– Within a template, you can change the default settings for:

— Collection interval

— Threshold

— Message text

— Duration

— Severity level of the condition

— Actions assigned to the condition (operator-initiated or automatic)
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• Create custom template groups– You can create custom template groups using default 
templates as base. For more information, see Customizing the WebLogic SPI. 

• Create custom metrics– You can define your own metrics or User Defined Metrics (UDMs) 
to expand the monitoring capabilities of the WebLogic SPI. For more information about 
UDMs see the HP Operations Smart Plug-in for User Defined Metrics User Guide.

Components of the WebLogic SPI

The WebLogic SPI has two main components:

• Applications (including reports)

• Templates

You can use the applications and templates to configure and receive data in the form of 
messages, annotations, and metric reports. These messages (available in the message 
browser), annotations (available through message properties), and metric reports (available 
through applications or message details) provide information about the conditions present in 
the servers running on specific managed nodes. 

The WebLogic SPI configuration applications let you configure the management server’s 
connection to selected server instances on specific managed nodes. After you configure the 
connection, you can assign templates to the nodes. With HP Operations agent software 
running on the managed nodes, you can use the WebLogic SPI reporting applications to 
generate metric reports. In addition, you can generate graphs that show the WebLogic SPI 
data (available through message properties). 

 Applications

The WebLogic SPI applications include configuration, troubleshooting, and report-generating 
utilities. In the Application Bank window, the WebLogic SPI applications are divided into the 
following groups:

• WLSSPI Admin

• WebLogic

• WLSSPI Reports 

• JMX Metric Builder: This application group is available only if you install the SPIJMB 
software. 

WLSSPI Admin Applications Group

WLSSPI Admin applications enable you to configure, control, and troubleshoot the WebLogic 
SPI. You require root user permission to run WLSSPI Admin applications.
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The WLSSPI Admin applications group contains the following applications:

• Configure WLSSPI– Launches the configuration editor and maintains the WebLogic 
SPI configuration.

• Discover WebLogic– Sets basic configuration properties needed for discovery.

• Init Non-Root– Simplifies the configuration of a non-root HTTPS agent on a UNIX 
managed node (OVO 8.x only). For all the steps required to configure a non-root HTTPS 
agent on a UNIX managed node see Configuring a Non-Root HTTPS Agent on a UNIX 
Managed Node (OVO 8.x Only) on page 52.

• Self-Healing Info– Collects data that you can send to your HP Support representative.

• Start Monitoring– Starts the collection of metrics for one application server or all 
application servers on a managed node. Launch the Verify application to determine if 
monitoring is started or stopped. By default, monitoring is on.

• Stop Monitoring– Stops the collection of metrics for one application server or all 
application servers on a managed node. 

• Start Tracing– Starts the collection of tracing information for selected metrics. Launch 
this application only when instructed by your HP support representative.

• Stop Tracing– Stops the collection of tracing information for selected metrics. Launch 
this application only when instructed by your HP support representative.

• Verify– Verifies that the WebLogic SPI is properly installed on the server or managed 
node. 

• View Error File– Enables you to view the contents of the WebLogic SPI error log file. 
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• View Graphs– Enables you to view the WebLogic SPI graphs, generated by HP 
Performance Manager, in a web browser. This requires additional setup. For more 
information see Task 1: Configure the Management Server to Launch Your Web Browser 
on page 37.

For more information about each of the above applications, see Appendix C, Applications.

WebLogic Applications Group

You can manage WebLogic Server functions by using the applications in the WebLogic 
Applications group. 

To access the WebLogic applications double-click WLSSPI  WebLogic in the Application Bank 
window.

The WebLogic group contains the following applications:

• Check WebLogic– Does an interactive status check of the WebLogic Server.

• Start WLS Console– Launches the WebLogic Server Admin console in your Web browser 
(requires setup).

• Start WebLogic– Enables you to start the WebLogic Server from the HPOM console 
(requires setup).

• Stop WebLogic– Enables you to stop the WebLogic Server from the HPOM console 
(requires setup).

• View Deployed Apps– Enables you to view the names and versions of all applications 
that are deployed on a WebLogic Server instance.

• View WebLogic Log– Enables you to view the WebLogic Server log files.

• View WebLogic Servers– Enables you to view the WebLogic domain configuration, 
cluster information, and physical machines.

• View Application Activation Status– Enables you to view the activation status of the 
applications running on a WebLogic Server.
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• View Application Timeout– Enables you to view the time left before retiring 
applications running on a WebLogic Server time out.

WLSSPI Reports Group

The WLSSPI Reports group contains reports that show information about the WebLogic 
Server conditions. 

You can generate these reports manually by dragging a managed node to a report in the 
Application Bank window. Each report shows the status of all configured WebLogic Server 
instances on the managed node in relation to the metric for which the report is generated. The 
following is a sample WebLogic SPI Application Bank report:

Application Bank Reports Generated from Alarms

An alarm condition can generate a report. These reports are generated automatically and are 
context sensitive, relating only to a single server on the managed node. These reports appear 
within the Annotations section of a message.

If you configure the message browser to display the SUIAONE columns, a flag appears under 
the S column (adjacent to the message) when a report is generated.

JMX Metric Builder Applications

The JMX Metric Builder Applications group contains the following applications:

• Deploy UDM– Deploys the UDM file.

• Gather MBean Data–Collects MBean information that is used with the JMX Metric 
Builder.
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• JMX Metric Builder– Launches the JMX Metric Builder application that is used to 
create UDMs and browse MBeans.

• UDM Graph Enable/Disable– Starts/stops data collection for UDM graphs. Also starts/
stops the HP Operations subagent.

For more information about the JMX Metric Builder Applications group and steps to install 
the SPIJMB software, see the HP Operations Smart Plug-in for User Defined Metrics User 
Guide.

WebLogic SPI Template Groups and Templates

WebLogic SPI templates are organized in groups and sub-groups. 

The SPI for WebLogic Server template group contains the following template sub-groups and 
individual templates:

• WLSSPI-Logfiles – Contains templates that generate messages based on log file and 
error text detected in both the WebLogic Server log files and the WebLogic SPI log files. 
The information captured from these log files includes errors that occur in the operation of 
the WebLogic Server or the WebLogic SPI and changes made to WebLogic Server 
configuration.

• WLSSPI-Metrics – Contains metric templates that monitor the performance levels and 
availability of a WebLogic Server.

Each metric template determines the threshold conditions for the monitored metric, the 
message text that is sent to the HPOM message browser when the threshold is exceeded, 
the actions to execute, and instructions that appear.

• WLSSPI-Schedule – Contains collector templates that specify the collection interval of 
the metric templates. Within the name of each collector template is its collection interval. 
For example, the collection interval of the template WLSSPI-1h is one hour (where 1h 
represents one hour). Each collector template is assigned a collection interval of 5 
minutes, 15 minutes, or one hour.

When you open a collector template, you can see the metrics collected within the interval 
(listed by number, following the -m option of the collector/analyzer command 
wasspi_wls_ca).
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Each collector template controls which metrics are collected when. Specifically, the 
collector template does the following: 

— Runs the collector/analyzer at each collection interval

— Specifies which metrics are collected

• WLSSPI-Messages – This is a single template. It intercepts the WebLogic SPI messages 
for the HPOM message browser.

• WLSSPI-Discovery – This is a single template. It updates the configuration on the 
HPOM management server and managed nodes.

In the message browser shown above, the last three messages, which are generated by the 
WebLogic SPI templates, belong to the WebLogic and WLSSPI message groups (see the 
column titled MsgGroup). The WebLogic messages indicate conditions occurring in the 
WebLogic Server, while the WLSSPI messages indicate conditions occurring in the WebLogic 
SPI.
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2 Installing, Removing, and Upgrading the 
WebLogic SPI
Installing the WebLogic SPI

You must install the HP Operations Manager (HPOM) management server and discovery 
package before installing the WebLogic SPI. It is not necessary to stop HPOM sessions before 
beginning the the WebLogic SPI installation. 

The discovery package and the WebLogic SPI are available on the HP Operations Smart 
Plug-ins DVD.

For a complete list of software requirements, see the HP Operations Smart Plug-in for BEA 
WebLogic Server Release Notes.

For an HP-UX 11.23 and 11.31 management server, run the following command:

swinstall -s /cdrom/OV_DEPOT/11.0HPUX.depot WLSSPI

On a Solaris management server the packages are supported in both depot and solaris native 
format.

For a Solaris management server in depot format, type:

swinstall -s /cdrom/OV_DEPOT/SOLARIS.depot WLSSPI

For a Solaris management server in native format,  perform the folowing steps:

1 Before installing the SPI software on the Solaris management server, set 
PKG_NONABI_SYMLINKS to true to avoid breakage of existing links during the 
installation. Type:

PKG_NONABI_SYMLINKS=TRUE

export PKG_NONABI_SYMLINKS

2 The SPIs have dependencies on “DSI2DDF” and “SPI-SVCDISC-OVO”. These two 
packages are not available in the native format of solaris. Hence, install “DSI2DDF” and 
“SPI-SVCDISC-OVO” from SOLARIS.depot before installing from the 
HPOMSpiDVD-8.1.sparc package. 

3 To install from the HPOMSpiDVD-8.1.sparc, type:

pkgadd -d /cdrom/OV_DEPOT/HPOMSpiDVD-8.1.sparc

4 Select the following SPIs for installation:

• HPOvSpiWls

If you want to create UDMs, install the SPIJMB software. For more information about this 
software see the HP Operations Smart Plug-in for User Defined Metrics User Guide.

The instructions that follow show the command line usage of swinstall. On HP-UX systems, 
you can also use the graphical user interface (GUI).
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• HPOvSpiJmx

• HPOvSpiShs

Removing the WebLogic SPI

To completely remove all the WebLogic SPI components, follow these steps:

• Task 1: Remove the WebLogic SPI Software from the Management Server

• Task 2: Remove the WebLogic SPI Software from the Node Group and Managed Nodes

• Task 3: Delete the WebLogic SPI Templates and Template Groups

• Task 4: Delete the WebLogic SPI Application Group

• Task 5: Delete the WebLogic SPI Message and Node groups

• Task 6: Remove the WebLogic SPI Directory

• Task 7: Remove the Report Package (Optional)

• Task 8: Remove the Graph Package (Optional)

Task 1: Remove the WebLogic SPI Software from the Management Server

1 Open a terminal window and log on as root.

2 In the terminal window, enter the following:

• For an HP-UX 11.23 and 11.31 management server, type:

/usr/sbin/swremove WLSSPI or
/usr/sbin/swremove SPIWebLogicAll

• For a Solaris management server, type:

/usr/sbin/pkgrm HPOvSpiWls
/usr/sbin/swremove DSI2DDF
/usr/sbin/swremove SPI-SVCDISC-OVO

The swremove and pkgrm command deletes the files from the file system only. The 
WebLogic SPI templates are not deleted from the HPOM data repository and must be 
deleted manually. Run the command:

cd /opt/OV/wasspi/wls/bin
find . -name “wasspi_wls*” -exec rm {} \;

This deletes all files that begin with wasspi_wls in the directory
/opt/OV/wasspi/wls/bin/

3 Remove the templates and the WebLogic SPI software from the managed nodes before 
deleting the templates from the HPOM data repository.

Task 2: Remove the WebLogic SPI Software from the Node Group and Managed 
Nodes

1 Open the Node Bank and from the Actions menu select Agents  Assign Templates.
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2 Select the WebLogic node group and all managed nodes on which the WebLogic templates 
are deployed.

3 Click Remove nodes/groups.

4 Open the Node Group Bank and select the WebLogic node groups.

5 Select Install/Update SW & Config from the Action menu and select the following check 
boxes:

• Templates

• Actions

• Monitors

• Commands

6 Click Nodes in List.

7 Click Force Update.

8 Click OK to remove the templates, actions, commands and monitors from the managed 
nodes. The following message appears in the message browser:

The following configuration information was successfully distributed: 
Templates Actions Commands Monitors

Task 3: Delete the WebLogic SPI Templates and Template Groups

Delete all the template sub-groups and templates from the SPI for WebLogic Server template 
group. Then delete the SPI for WebLogic Server template group. Follow these steps:

1 From the Windows menu, select Message Source Templates and double-click the SPI for 
WebLogic Server template group.

2 Press Shift and select all the templates and template groups in the SPI for WebLogic 
Server template group. 

3 Click Delete From All...The following message appears:

Do you really want to delete the template(s)?

4 Click Yes.

5  Delete the SPI for WebLogic Server template group.

6 Delete all the customized templates (default WebLogic SPI templates that you modified) 
residing in other HPOM template groups. 

Task 4: Delete the WebLogic SPI Application Group

1 Open the Application Bank.

2 Right-click the WLSSPI application group and select Delete. The following message 
appears:

Do you really want to delete the application group?

3 Click Yes.
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Task 5: Delete the WebLogic SPI Message and Node groups

1 From the Window menu, select Message Group Bank.

2 In the Message Group Bank window, right-click the WLSSPI group and select Delete. The 
following message appears:

Do you really want to delete the message group?

3 Click Yes.

4 Repeat steps 2 and 3 for the WebLogic group.

5 From the Window menu, select Node Group Bank.

6 Right-click each WebLogic SPI and WebLogic Server group and select Delete. The 
following message appears:

Do you really want to delete the node group?

7 Click Yes.

Task 6: Remove the WebLogic SPI Directory

Run the following command from the command prompt:

rm -rf /opt/OV/wasspi/wls

Task 7: Remove the Report Package (Optional)

If you installed the WebLogic SPI report package, remove it (from the Windows system on 
which HP Reporter is running):

1 Go to Settings  Control Panel  Add/Remove Programs.

2 Select the the WebLogic SPI report package and click Remove.

Task 8: Remove the Graph Package (Optional)

If you installed the WebLogic SPI graph packages (on the HPOM management server and on 
your system running HP Performance Manager), remove them:

• For the HPOM management server, run the following command:

/usr/sbin/swremove WLSSPI-GRAPHS

• For a Windows system running HP Performance Manager, follow these steps:

a Go to Settings  Control Panel  Add/Remove Programs.

b Select the WebLogic SPI graph package (HP Operations SPI for WebLogic Server - 
Graphing Component Integration) and click Remove.

• For a HP-UX system (not the HPOM management server) running HP Performance 
Manager, follow these steps: 

a Run the following command to verify that the graph package is installed:

If HP Performance Manager is installed on the HPOM management server, the 
files are removed in Task 1: Remove the WebLogic SPI Software from the 
Management Server.
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swlist | grep WLSSPI-GRAPHS

b Run swremove WLSSPI-GRAPHS, if the graph package is installed.

• On a Solaris system (not the HPOM management server) running HP Performance 
Manager, follow these steps the following:

a Run the following command to verify that the graph package is installed:

/usr/bin/pkginfo HPOvSpiWlsGc

b Run /usr/sbin/pkgrm HPOvSpiWlsGc, if the graph package is installed.

Upgrading the WebLogic SPI

When you upgrade from a previous installation, all your configuration entries are preserved.

To upgrade the WebLogic SPI, complete these tasks:

• Task 1: Remove the WebLogic SPI Software from the Management Server

• Task 2: Delete the WebLogic SPI Templates

• Task 3: Delete the WebLogic SPI Applications

• Task 4: Upgrade the WebLogic SPI

• Task 5: Assign Operator Responsibilities for opc_adm

• Task 6: Assign Templates to the Management ServerTask 7: Distribute Templates to the 
Management Server

• Task 7: Distribute Templates to the Management Server

• Task 8: Customize Templates

• Task 9: Move Nodes to New Node Group

• Task 10: Delete Node Groups

• Task 11: Distribute Actions, Monitors, Commands, and Templates

• Task 12: Launch the Discover WebLogic Application

• Task 13: Install the New Report Package (Optional)

• Task 14: Install the New Graph Package (Optional)

If HP Performance Manager is installed on the HPOM management server, the 
files are removed in Task 1: Remove the WebLogic SPI Software from the 
Management Server.

The existing WLSSPI_RPT_METRICS datasource is automatically deleted when you 
upgrade the SPI from version A.04.00.00 to 4.20. A new datasource is created and the 
existing data is lost.

The datasource is deleted irrespective of whether you are using CODA or HP Performance 
Agent.
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Task 1: Remove the WebLogic SPI Software from the Management Server

1 Open a terminal window and log on as root.

2 Run the following commands:

/usr/sbin/swremove WLSSPI
/usr/sbin/swremove SPIWebLogicAll
/usr/sbin/swremove WLSSP-GRAPHS 

3 Run the following command to delete all the SPI files in the /opt/OV/wasspi/wls/bin/ 
directory

cd /opt/OV/wasspi/wls/bin
find . -name “wasspi_wls*” -exec rm {} \;

This deletes all files that begin with wasspi_wls.

Task 2: Delete the WebLogic SPI Templates

Delete all the WebLogic SPI templates and template groups that appear under the SPI for 
WebLogic Server template group and then delete the SPI for WebLogic Server template group. 
If you customized any of the default templates, note the changes because the customizations 
are not saved. Then, follow these steps:

1 From the windows menu, select Message Source Templates and select the SPI for WebLogic 
Server template group.

2 Double-click the WebLogic group (WebLogic 10.0, 9.x, 8.1, 7.0). Open the template groups 
until the lowest level that is the individual templates.

3 Press Shift and select all the templates.

4 Click Delete From All... The following message appears:

Do you really want to delete the template(s)?

5 Click Yes.

6 Go up a level and open the next group. Repeat steps 2 through 5 till you delete all the 
WebLogic SPI individual and group templates in the Message Source Template window. 

Task 3: Delete the WebLogic SPI Applications

1 Open the Application Bank.

2 Right-click the WLSSPI application group and select Delete. The following message 
appears:

Do you really want to delete the application group?

3 Click Yes.

Task 4: Upgrade the WebLogic SPI

The WebLogic SPI software is available on the HP Operations Smart Plug-ins DVD. 

The instructions that follow show the command line usage of swinstall. For HP-UX systems, 
you can also use the graphical user interface (GUI).
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For an HP-UX 11.23 and 11.31 management server, run the following command:

swinstall -s /cdrom/OV_DEPOT/11.0HPUX.depot WLSSPI

On a Solaris management server the packages are supported in both depot and solaris native 
format.

For a Solaris management server in depot format, type:

swinstall -s /cdrom/OV_DEPOT/SOLARIS.depot WLSSPI

For a Solaris management server in native format,  perform the folowing steps:

1 Before upgrading the SPI software on the Solaris management server, set 
PKG_NONABI_SYMLINKS to true to avoid breakage of existing links during the 
installation. Type:

PKG_NONABI_SYMLINKS=TRUE

export PKG_NONABI_SYMLINKS

2 The SPIs have dependencies on “DSI2DDF” and “SPI-SVCDISC-OVO”. These two 
packages are not available in the native format of solaris. Hence, install “DSI2DDF” and 
“SPI-SVCDISC-OVO” from SOLARIS.depot before installing from the 
HPOMSpiDVD-8.1.sparc package. To install from the HPOMSpiDVD-8.1.sparc, type:

pkgadd -d /cdrom/OV_DEPOT/HPOMSpiDVD-8.1.sparc

3 Select the following SPIs for upgrading:

• HPOvSpiWls

• HPOvSpiJmx

• HPOvSpiShs

Task 5: Assign Operator Responsibilities for opc_adm

1 Log on to HPOM as administrator (opc_adm).

2 Open the User Bank window, right-click the opc_adm user, and select Modify.

3 In the Modify User:opc_adm user window, click Responsibilities. 

4 For WLSSPI and WebLogic Message Groups, ensure that all check boxes are selected.

5 Assign the WLSSPI Node or Message Groups to some other appropriate operators.

6 Click Close.

Task 6: Assign Templates to the Management Server

1 Open the Node Bank window and select the management server.

2 From the Actions menu, select Agents  Assign Templates. The Define Configuration 
window opens.

3 Click Add. The Add Configuration window opens. 

4 Click Open Template Window. The Message Source Templates window opens. 

5 In the Template Groups pane, select the SPI for WebLogic Server template group.

6 From the Message Source Templates window, in the right pane, select the 
WLSSPI-Discovery template group and WLSSPI-Messages template.
Installing, Removing, and Upgrading the WebLogic SPI 31



7 From the Add Configuration window, click Get Template Selections. The WLSSPI-Messages 
and WLSSPI-WebLogic-Discovery templates appear in the right pane.

8 From the Add Configuration window, click OK.

Task 7: Distribute Templates to the Management Server

1 Open the Node Bank window and select the management server.

2 From the Actions menu, select Agents  Install/Update SW & Config. 

3 In the Target Nodes section, select Nodes in List Requiring Update.

4  In the Install/Update Software and Configuration window, select the Templates check box.

5 Select Force Update.

6 Click OK.

The following message appears in the message browser:

The following configuration information was successfully distributed: 
Templates

Task 8: Customize Templates

1 Copy the default templates.

2 Apply the customizations made to the previous version of templates to the copy of the 
current version.

Task 9: Move Nodes to New Node Group

Move all managed nodes (running supported versions of the WebLogic Server) in the SPI for 
WebLogic Server node groups to the new WebLogic node group. Managed nodes running 
supported versions of the WebLogic Server are in the following node groups: WebLogic 10.0, 
WebLogic 9.x, WebLogic 8.1, and WebLogic 7.0. To move the nodes, follow these steps:

1 Open the Node Bank and select the SPI for WebLogic Server node group.

2 Double-click WebLogic 10.0 node group and note the managed nodes in it. Repeat this step 
for the WebLogic 10.0, and WebLogic 7.0 node groups.

3 Go back to the top level of the node bank (where the WebLogic node group is displayed).

4 Drag and drop or copy and paste the nodes (noted in step 2) from the IP submap to the 
WebLogic node group.

Task 10: Delete Node Groups

Delete all versioned node groups that are in the SPI for WebLogic Server node group. This 
might include: WebLogic 10.0, WebLogic 9.x, WebLogic 8.1, and WebLogic 7.0. To delete the 
versioned node groups, follow these steps:

1 Open the Node Bank and select the SPI for WebLogic Server node group.

In this version of the WebLogic SPI, the templates are no longer grouped by WebLogic 
version numbers.
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2 Select a versioned WebLogic node group and, from the Edit menu, select Delete. The 
following message appears:

Do you really want to delete the node group?

3 Click Yes.

4 Repeat steps 2 and 3 until you delete all versioned WebLogic node groups.

Task 11: Distribute Actions, Monitors, Commands, and Templates

1 From the Node Bank window, select the nodes or node groups on which you want to install 
the WebLogic SPI. 

2 From the Actions menu select Agents  Install/Update SW & Config. 

3 In the Install/Update OVO Software and Configuration window, select the following 
component check boxes:

• Templates

• Actions

• Monitors

• Commands

Using this dialog, deploy updated components on the managed nodes.

4 Select the Force Update check box.

5 Select the Nodes in list button. Upon completion, the following message appears in the 
message browser for each managed node:

The following configuration information was successfully distributed: 
Actions Commands Monitors Templates.

Task 12: Launch the Discover WebLogic Application

You must launch the Discover WebLogic application. Re-entering any of the WebLogic SPI 
configuration data is not required because all configuration data is saved. To re-deploy the 
file, you can drag and drop multiple nodes, node groups, or single nodes. When you re-deploy 
the file, relevant information is updated, transmitted, and stored on the node. To launch the 
Discover WebLogic application, follow these steps: 

1 From the HPOM console, select the node in the Node Bank window. 

2 From the Window menu, select Application Bank.

3 In the Application Bank window, select WLSSPI  WLSSPI Admin  Discover. (If the above 
does not appear as described, select Map  Reload). The Introduction window opens. 

4 Click Next. A second Introduction window opens. Information about the properties 
required for the discovery process to work are given in this window

5 Read this information and click Next. The configuration editor opens.

You might see some WebLogic SPI errors in the message browser. These errors are the result 
of the transition to the updated programs and you can ignore them. The WebLogic SPI 
templates and programs are updated on the Management Server and selected managed 
nodes. These errors are resolved when the upgrade is complete.
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6 Make the necessary changes using the configuration editor.

7 Click Next to save any changes and exit the editor. The Confirm Operation window opens.

8  Click OK.

If you click Cancel, all the changes made to the configuration remain in the configuration 
on the management server. To make the changes to the selected managed nodes’ 
configuration, you must select those nodes in the Node Bank window, launch the 
Discovery application, click Next in the configuration editor, and then click OK in the 
Confirm Operation window.

Task 13: Install the New Report Package (Optional)

Remove older versions of the WebLogic SPI report package from your Windows system 
running HP Reporter and install the new WebLogic SPI report package. To install the new 
report package, follow these steps:

1 On the Windows system running HP Reporter, go to Settings  Control Panel  
Add/Remove Programs.

2 Select the WebLogic SPI report package and click Remove.

3 To install the WebLogic SPI report package, follow the steps given in 

4  Integrating with HP Reporter on page 82.

Task 14: Install the New Graph Package (Optional)

• If HP Performance Manager is running on a Windows system, remove older versions of 
the WebLogic SPI graph package and install the new WebLogic SPI graph package. To 
install the new graph package, follow these steps:

a Go to Settings  Control Panel  Add/Remove Programs.

b Select the WebLogic SPI graph package (HP Operations SPI for WebLogic Server - 
Graphing Component Integration) and click Remove.

When setting the configuration using configuration editor, note the following:
• GRAPH_SERVER property is no longer supported in the WebLogic SPI. 

Instead, set the GRAPH_URL property.
• Note the locations of the UDM files on your managed nodes and delete any 

occurrence of the UDM_DEFINITIONS_FILE property from your 
configuration.

• Do not configure UDMs individually on your managed nodes. Instead configure 
these UDMs on the management server in the 
/opt/OV/conf/wlsspi/wasspi_wls_udmDefnintions.xml file (or, set the 
UDM_DEFINITIONS_SOURCE property to use another file).

• After you consolidate the UDMs on the management server, delete the old 
UDM files from the managed nodes and distribute the new UDM file to the 
managed nodes using the Deploy UDM application.

Do not close the Discover application window until the discovery process is complete. The 
discovery process might take several minutes to complete.
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c To install the WebLogic SPI graph package, follow the steps in Integrating with HP 
Performance Manager on page 87.

• If HP Performance Manager is running on a HP-UX system (not the HPOM management 
server), follow these steps: 

a Run swlist | grep WLSSPI-GRAPHS to verify that the graph package is installed. 

b Run swremove WLSSPI-GRAPHS if the graph package is installed.

c To install the WebLogic SPI graph package follow the steps in Integrating with HP 
Performance Manager on page 87.

• If HP Performance Manager is running on a Solaris system (not the HPOM management 
server), follow these steps: 

a Run /usr/bin/pkginfo HPOvSpiWlsGc to verify that the graph package is 
installed.

b Run /usr/sbin/pkgrm HPOvSpiWlsGc if the graph package is installed.

c To install the WebLogic SPI graph package follow the steps given in section.

If HP Performance Manager is installed on the HPOM management server, the 
files are automatically updated when you install the SPI software.

If HP Performance Manager is installed on the HPOM management server, the 
files are automatically updated when you install the SPI software.
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3 Configuring the WebLogic SPI 
To configure the WebLogic SPI, you must complete all configuration prerequisites, the 
WebLogic SPI configuration on managed nodes and the management server, and additional 
configuration based on your environment.

Configuration Prerequisites

Complete the following tasks before configuring the WebLogic SPI:

• Task 1: Configure the Management Server to Launch Your Web Browser

• Task 2: Assign Operator Responsibilities for opc_adm

• Task 3: Assign Templates to the Management Server

• Task 4: Deploy Templates on the Management Server

Task 1: Configure the Management Server to Launch Your Web Browser 

The WebLogic SPI uses the ovweb utility to launch the WebLogic administration console in 
your web browser and for displaying graphs generated by HP Performance Manager. Skip 
this task if you do not want to start the WebLogic administration console from the HPOM 
console and do not use HP Performance Manager.

1 Enter the browser invocation command in the ovweb.conf file. If no browser invocation 
command is included in the ovweb.conf file, ovweb starts the default browser.

The browser invocation command must contain %s to allow the WebLogic SPI to pass a 
URL to the browser. Open the file and insert the command according to the entry syntax 
and example as follows:

 Syntax: Browser: <browser command>%s

To display the WebLogic SPI graphs, ensure that your browser is Java Script enabled. 
Check the setting within the browser’s Preferences. 

2 When running the Discover WebLogic application to configure the WebLogic SPI from the 
management server (see Task 3: Launch Discover WebLogic on page 45), set the following 
conditional properties:

• Set the ADMIN_HOST and ADMIN_PORTS properties, to start the WebLogic console 
from the HPOM console.

• Set the GRAPH_URL property if you are using HP Performance Manager.

The ovweb.conf file must be located in the directory specified by the 
environment variable $OV_CONF (used by HPOM). To see the HPOM directory 
structure on your management server, open /opt/OV/bin/ov.envvars.sh file 
and search for the definition of $OV_CONF.
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For more information about launching a browser in HPOM, see the man pages for ovweb, 
ovweb.conf, and ov.envvars.

Run the following command at the command prompt to access instructions for enabling 
graphs: 

man ovweb

Task 2: Assign Operator Responsibilities for opc_adm

1 Log on to HPOM as the administrator (opc_adm).

2 Open the User Bank window, right-click the opc_adm user, and select Modify. The Modify 
User:opc_adm user window opens.

3 Click Responsibilities. Ensure that all check boxes are selected for WLSSPI and WebLogic 
Message Groups.

4 Follow steps 2 through 4 to assign the WLSSPI Node or Message Groups to another 
appropriate operators.

5 Click Close.

Task 3: Assign Templates to the Management Server

1 Open the Node Bank window and select the management server.

2 From the Actions menu, select Agents  Assign Templates. The Define Configuration 
window opens.
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3 Select a Node/Group and click Add. The Add Configuration window opens.

4 Click Open Template Window. The Message Source Templates window opens.
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5 Select SPI for WebLogic Server template group from the Template Groups pane. A list of 
the WebLogic SPI template sub-groups and templates appears on the right pane.

6 Select WLSSPI-Discovery (from the WLSSI-Schedule group) and WLSSPI-Messages 
templates from the right pane.

7 In the Add Configuration window, click Get Template Selections. The WLSSPI-Discovery 
and WLSSPI-Messages templates appear in the right pane. 

8 Click OK.

Task 4: Deploy Templates on the Management Server

1 Open the Node Bank window and select the management server.

2 Select Actions  Agents  Install/Update SW & Config... The Install/Update OVO Software 
and Configuration window opens.

3 In the Target Nodes pane, select Nodes in list requiring update.

4  Select the Templates check box and click Force Update.

5 Click OK.
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The following message appears in the message browser:

The following configuration information was successfully distributed: 
Templates

The WebLogic SPI Configuration from Managed Nodes

Complete the following tasks for each managed node:

• Task 1: Verify the Application Server Status

• Task 2: Configure a WebLogic Server User

Task 1: Verify the Application Server Status

Check the status of WebLogic Servers in the WebLogic administration console to verify if the 
application servers are running.

Figure 2 The WebLogic Admin Server console

Task 2: Configure a WebLogic Server User

Collect the WebLogic login and password for each WebLogic Administration Server. If you do 
not want to use the existing login and password, create a new login and password. The 
WebLogic SPI discovery process uses the login and password to gather basic configuration 
information, and the WebLogic SPI data collector uses the login and password to collect 
metrics. 

To simplify the WebLogic SPI configuration, keep the login and password for both WebLogic 
Servers and WebLogic Administration Servers similar.
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WebLogic Server Version 7.0 or Later

On WebLogic Server version 7.0 or later, you can log on as the administration user configured 
during installation of WebLogic Server. Or, you can log on as a user that belongs to the 
WebLogic Administrators or Monitors group.

To configure a user belonging to Administrators or Monitors group, you must use the 
WebLogic administration console. For more information about creating a user and assigning a 
user to a group, see the Securing WebLogic Resources manual, Users and Groups section. 
(http://e-docs.bea.com/wls/docs70/secwlres/usrs_grps.html or http://e-docs.bea.com/
wls/docs81/secwlres/usrs_grps.html).

A user that belongs to the Monitors group cannot use the Start WebLogic or Stop WebLogic 
application to start or stop WebLogic Servers from the HPOM console. This user also cannot 
perform the JMX call ‘set’ when implementing JMX actions to assign a value to a specified 
attribute if you are creating UDMs. For more information about JMX Actions see Appendix E 
in the HP Operations Smart Plug-in for User Defined Metrics for UNIX User Guide.
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The WebLogic SPI Configuration from the Management Server

Complete the following tasks from the management server:

• Task 1: Assign WLSSPI-Messages Template to the Managed Node

• Task 2: Distribute Templates, Actions, Monitors, Commands

• Task 3: Launch Discover WebLogic

• Task 4: Set Additional Properties

• Task 5: Verify the Discovery Process

• Task 6: Add Nodes to the WebLogic Node Group

• Task 7: Deploy the WebLogic SPI Templates

• Task 8: Completing Configuration

• Task 9: Verify the WebLogic SPI Configuration

Task 1: Assign WLSSPI-Messages Template to the Managed Node

1 Open the Node Bank window and select the managed nodes.

2 From the Actions menu, select Agents → Assign Templates. The Define Configuration 
window opens.
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3 Click Add. The Add Configuration window opens. 

4 Click Open Template Window. The Message Source Templates window opens. 

5 In the Template Groups pane, select the SPI for WebLogic Server template group and in the 
right pane, select the WLSSPI-Messages template.

6 In the Add Configuration window, click Get Template Selections. The WLSSPI-Messages 
template appears in the right pane.

7 Click OK.

Task 2: Distribute Templates, Actions, Monitors, Commands

1 Select the nodes on which you want to install the WebLogic SPI.

2 Open the Node Bank window and select Actions  Agents  Install/Update SW & Config.... 
The Install/Update OVO Software and Configuration window opens. 

3  Select the following component check boxes:

• Templates
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• Actions

• Monitors

• Commands 

4 Select the Force Update check box.

5 Select the Nodes in list radio button. 

6 After the WebLogic SPI is installed on the selected managed nodes, the following message 
appears in the message browser for each managed node:

The following configuration information was successfully distributed: 
Templates Actions Commands Monitors

Task 3: Launch Discover WebLogic

Launch the Discovery application on one managed node at a time.

1 At the HPOM console, double-click OVO Node Bank. The OVO Node Bank window opens.

2 From the Window menu, select Application Bank. The OVO Application Bank opens in a 
new window.

3 Double-click WLSSPI. The Application Group: WebLogic SPI window opens.

4 Double-click WLSSPI Admin. The Application Group: WLSSPI Admin window opens. All 
the WLSSPI Admin applications appear in this window.

5 Select a node from the OVO Node Bank window and double-click Discover WebLogic (If the 
above does not appear as described, select Map  Reload.) The Introduction window opens. 
This window contains brief information about the Discovery application.

6 Click Next. A second Introduction window opens. This window displays information about 
the properties that might be required for the discovery process to work.

If an instance of WebLogic Server has a server login name and password different from the 
default login and password, before launching the discovery tool you must explicitly configure 
the login details for that server using the configuration editor.
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7 Click Next. If you already set the LOGIN and PASSWORD properties, the configuration 
editor opens. To set additional properties, see Task 4: Set Additional Properties on 
page 47.

If you did not set the LOGIN and PASSWORD properties, the Set Access Info for Default 
Properties window opens.

8 Set the same LOGIN and PASSWORD properties as configured in the WebLogic login and 
password in Task 2: Configure a WebLogic Server User on page 41. You must set the 
LOGIN and PASSWORD properties even if you are using the default login/password or 
the login/password configured during the WebLogic Server installation..

Setting LOGIN and PASSWORD for Different Setups

You can set the LOGIN and PASSWORD for different setups in the following ways:

• If the WebLogic Administration Server login and password are the same for all instances 
of WebLogic on all HPOM managed nodes, follow these steps:

a Set the LOGIN and PASSWORD properties in the Set Access Info for Default 
Properties window.

b Set the additional properties required by the discovery process. See Task 4: Set 
Additional Properties on page 47.

• If the WebLogic Administration Server login and password are different for each managed 
node but are similar for all instances of the WebLogic Administration Server on the 
managed nodes, follow these steps:

a Customize the the WebLogic SPI configuration by setting the LOGIN and 
PASSWORD properties at the NODE level (for more information about the 
configuration structure, see  Structure on page 155)

b In the Set Access Info for Default Properties window, set the most commonly used 
WebLogic login and password as LOGIN and PASSWORD properties.

The LOGIN and PASSWORD properties set in this window are used as the default 
WebLogic login and password (they are set at the global properties level). That is, 
if no NODE level or server-specific LOGIN and PASSWORD properties are set, 
this WebLogic login and password are used by the WebLogic SPI to access all 
WebLogic Administration Servers. For more information about the configuration 
structure, see Structure on page 155.
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c Click Customize. The configuration editor opens. Set the LOGIN and PASSWORD 
properties at the NODE level. For more information about using the configuration 
editor, see Appendix B, The Configuration.

d Set the additional properties required by the discovery process. See Task 4: Set 
Additional Properties on page 47.

• If the WebLogic Administration Server login and password are different for each managed 
node and they are also different for the instances of the WebLogic Administration Server 
on a managed node, follow these steps:

a Customize the WebLogic SPI configuration by setting the LOGIN, PASSWORD, 
NAME, and PORT properties at the server-specific level (for more information about 
the configuration structure, see Appendix B, The Configuration):

a In the Set Access Info for Default Properties window, set the most commonly used 
WebLogic login and password as LOGIN and PASSWORD properties.

b Click Customize. The configuration editor opens. Set the LOGIN, PASSWORD, NAME, 
and PORT properties at the server-specific level. For more information about using 
the configuration editor, see Appendix B, The Configuration.

c Set the additional properties required by the discovery process. See Task 4: Set 
Additional Properties on page 47.

Task 4: Set Additional Properties

The LOGIN and PASSWORD properties are the basic properties needed by the discovery 
process. However, depending on your environment, you might need to provide additional 
configuration information.

You can set the following properties (for more information about these properties, see 
Configuration Properties on page 166): 

• ADDRESS– The domain name or IP address where the WebLogic Server is listening. You 
must set this property if the WebLogic Server is configured to a virtual IP address. 

• ADMIN_PORTS– A list of the port numbers of the WebLogic Admin servers. You must set 
this property if the domain configuration file (config.xml) is not located in the following 
default directories:

— <BEA_Home_DIR>/user_projects/<WebLogic_Domain>/ (WebLogic 7.0 or 
WebLogic 7.0 SP1)

— <BEA_Home_DIR>/user_projects/domains/<WebLogic_Domain>/
(WebLogic 7.0 SP2 or higher)

In this instance, <WebLogic_Install_Dir> is the directory where the WebLogic Server is 
installed, <BEA_Home_Dir> is the directory that contains the registry.xml file, and 
<WebLogic_Domain> is the WebLogic domain name.

• HOME_LIST– A list of directories where the WebLogic Server is installed. You must set 
this property if the BEA registry.xml file is not accurate or cannot be found (You can 
face this problem if you do not use BEA’s installation scripts to install the WebLogic 
Server software and Service Packs). 
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• JAVA_HOME– The default directory where Java is installed. You must set this property if 
Java is installed on more than one directory or if you are using your own Java. 

• NODE_NAMES–You must set this property if a remote WebLogic Server is listening on a 
virtual IP address. If you do not set this property, the WebLogic Server is not discovered.

• EXCLUDE_SAMPLES– You can set this property to ‘true’, at the default properties level, 
to exclude the WebLogic Server sample programs from the discovery process. This will 
reduce the amount of time it takes for the discovery process to run.

• PROTOCOL– You can set this property to specify if the application server port is using 
SSL or non-SSL. You must set this property if you are using SSL on the application server 
port. Valid values for this property are t3 (non-SSL) and t3s (SSL). For more information, 
see Table 1. 

Setting Additional Properties

1 In the configuration editor, set the properties. For information about setting properties 
using the configuration editor, see Appendix B, The Configuration.

2 Click Next to save changes and exit the editor. The Confirm Operation window opens.

3  Verify the nodes on which the operation is to be performed and click OK.

Task 5: Verify the Discovery Process

Depending on the number of managed nodes in your environment, verification could take 
several minutes to complete.

1 Verify that the following messages appear in the Discover WebLogic application window 
(the Discover WebLogic application has completed successfully):

Discovery started on node: <node>
Finished running the Discovery application

If the discovery is not successful, the following message appears in the application 
window:

Failed to run discovery on node <node>

For information on troubleshooting the discovery process see Troubleshooting the 
Discovery Process on page 106.

2 Verify that the following message appears in the message browser for each managed node:

WASSPI-602 - Updating the WLSSPI configuration data with discovered 
information

Depending on the number of managed nodes in your environment, it could take several 
minutes for these messages to display for all managed nodes.

3 If Service Navigator is running, select File  Reload Configurations. 

When you launch the Discover WebLogic tool, JAVA_HOME takes the default 
value. If you specified a different value for JAVA_HOME for any instance of 
WebLogic Server, you must explicitly set that value for JAVA_HOME using the 
configuration editor. For more information about the JAVA_HOME property, see 
Configuration Properties on page 166.

Wait for the discovery process to complete before going to the next task. The discovery process 
could take several minutes to complete. 
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In the Service Map, open the Application node and look for the WebLogic service.

Figure 3 shows a snapshot of the Service Map as it appears after successful discovery. 
Using the Service Map, you can find out the application that has a problem (if any). The 
lines in the Service Map are color coded to show various levels of severity. For example, 
red lines show that the application has critical problems. 

Figure 3 Service Map

4 Launch the Configure WLSSPI application to verify the properties set by the discovery 
process. For more information about the configuration editor, see Configure WLSSPI on 
page 184.

Task 6: Add Nodes to the WebLogic Node Group

The WebLogic SPI automatically creates the WebLogic node group with preassigned template 
groups. To place all nodes running WebLogic Server in this node group, follow these steps:

1 From the HPOM console, open the Node Group Bank and the Node Bank window to view 
the WebLogic node group and the managed nodes side-by-side.

2 Drag and drop managed nodes on which WebLogic Server is running into the WebLogic 
node group. 

Task 7: Deploy the WebLogic SPI Templates

1 Open the Node Group Bank window and select the WebLogic node group.

You can view the Service Map using the Java GUI.
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2 Select Actions  Agents  Install/Update SW & Config. The Install/Update OVO Software 
and Configuration window opens.

3 In the Target Nodes section, select the Nodes in List Requiring Update radio button.

4  Select the Templates and Force Update check boxes.

5 Click OK.

The following message must appear in the message browser:

The following configuration information was successfully distributed: 
Templates

After the templates are deployed, the monitors can now begin running according to their 
specific collection interval.

Task 8: Completing Configuration

To complete the configuration update the configuration information on the management 
server and managed nodes, do one of the following:

• Wait for the automatic configuration template to run (it could take 10 minutes).

• Launch the Configure WLSSPI application (this application updates the configuration 
information on the management server and managed nodes). For more information about 
Configure WLSSPI application see Configure WLSSPI on page 184.

Task 9: Verify the WebLogic SPI Configuration

Launch the Verify application to verify that the WebLogic SPI is properly installed and 
configure. For more information about the Verify application, see Verify on page 189.

1 Open the Node Group Bank window and select the WebLogic node group. 

2 Open the Application Bank window.

3 Select WLSSPI  WLSSPI Admin and double-click Verify. 

For information on integrating WLS-SPI with Reporter for generating WebLogic Server 
reports that show consolidated information, see Chapter 5, Integrating HP Reporting and 
Graphing Products with the WebLogic SPI.
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Additional WebLogic SPI Configuration

Based on your WebLogic Server configuration and application needs, you must finish the 
WebLogic SPI configuration by setting additional configuration properties and installing and 
configuring additional components. 

Conditional Properties

You might have to set one or more of the following conditional properties (these properties are 
not automatically discovered by the discovery process). For more information about the 
properties, see Configuration Properties on page 166.

Setting Conditional Properties

1  In the HPOM console, open the Node Bank window and select the node.

2 From the Window menu, select Application Bank. The Application Bank window opens.

3 Select WLSSPI  WLSSPI Admin  Configure WLSSPI. (If it does not appear as described, 
select Map  Reload.) The Introduction window opens. This window contains basic 
information about the Discovery application.

4 Click Next. A second Introduction window opens. This window contains information about 
the properties required for the discovery process to work.

5 Click Next. The configuration editor opens.

6 Set the properties using the configuration editor. For more information about using the 
configuration editor see Appendix B, The Configuration.

Table 1 Conditional Properties

Condition Property to Set

Running WebLogic Server version 7.x, 8.1, 9.x, or 10.0. VERSION

WebLogic Servers on a system share the same name. The discovery 
process automatically sets the ALIAS property, but you might want to 
edit this value as this is the name used in messages, reports, and 
graphs.

ALIAS

Start or stop a WebLogic Server using the Start WebLogic or Stop 
WebLogic application from the HPOM console.

START_CMD, 
STOP_CMD, and 
USER

Start the WebLogic administration console using the Start WLS Console 
application from the HPOM console.

ADMIN_HOST and
ADMIN_PORTS

Utilize MBean information in the JMX Metric Builder application to 
create UDMs.

COLLECT_META
DATA

Use the View Graphs application from the HPOM console (HP 
Performance Manager must be installed).

GRAPH_URL

A WebLogic Server is configured to a virtual IP address, is on a remote 
node, or is not using the primary IP address of that node.

ADDRESS

The log file’s absolute pathname is not configured in WebLogic. LOGFILE
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7 Click Next. The Confirm Operation window opens.

8 Click OK to save the configuration changes on the selected managed nodes.

Configuring a Non-Root HTTPS Agent on a UNIX Managed Node (OVO 8.x 
Only)

1 Switch the HTTPS agent to a non-root user. For more information, see the HP Operations 
HTTPS Agent Concepts and Configuration Guide for the HP-UX and Sun Solaris 
Management Server Operating Systems.

2 On the managed node, set the OV_SUDO variable and log on as root or HP Operations 
agent user. Follow these steps:

a Run the following command to stop all HP Operations agents:

opcagt -kill

b Run the following command to set the OV_SUDO variable:

ovconfchg -ns ctrl.sudo -set OV_SUDO <sudo_program>

In this instance, <sudo_program> is the location (including the absolute pathname) 
where sudo is installed (for example, /usr/local/bin/sudo).

c Run the following command to start the HP Operations agents:

opcagt -start

d Run the following command to verify that OV_SUDO is set:

ovdeploy -cmd set | grep SUDO

The following line appears:

OV_SUDO=<sudo_program>

3 Configure the managed node. These steps must be completed to successfully run the SPI 
in a non-root HTTPS agent environment. 

a From the HPOM management server, deploy actions, commands, and monitors to the 
managed node.

b Select the node in the Node Bank window. 

c From the Application Bank window, select WLSSPI  WLSSPI Admin  Init Non-Root.

4 Edit the /etc/sudoers file using the visudo editor (installed with Sudo):

a On the managed node, log on as root.

b Open the /<SPI_Config_DIR>/wasspi_wls_sudoers file

where <SPI_Config_DIR> is the location of the SPI’s configuration files on a managed 
node. For more information see Managed Node File Locations on page 153.

c Run the visudo command in a seperate window (for example, type: 
/usr/local/sbin/visudo).

You must install the OS-dependent Sudo software package on the UNIX managed node. Sudo 
is free software available from http://www.sudo.ws. The OS-dependent software packages 
are located at the bottom of the download page (http://www.sudo.ws/sudo/
download.html). See the release notes for more information about Sudo installation.
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d Copy the following lines from the wasspi_wls_sudoers file and append the lines to 
the sudoers file:

Cmnd_Alias WLSSPI_ADMN = /opt/OV/nonOV/perl/a/bin/perl -S 
wasspi_wls_admin *
Cmnd_Alias WLSSPI_COLL = /opt/OV/nonOV/perl/a/bin/perl -S wasspi_wls_ca 
*
Cmnd_Alias WLSSPI_DISC = /opt/OV/nonOV/perl/a/bin/perl 
wasspi_wls_discovery.pl
Cmnd_Alias WLSSPI_LFEN = /opt/OV/nonOV/perl/a/bin/perl -S wasspi_wls_le 
*
Cmnd_Alias WLSSPI_SHSC = /opt/OV/nonOV/perl/a/bin/perl -S 
shs_collector.pl *

Cmnd_Alias WLSSPI_ADMNP = /opt/OV/nonOV/perl/a/bin/perl -S \
/var/opt/OV/bin/instrumentation/wasspi_wls_admin *
Cmnd_Alias WLSSPI_COLLP = /opt/OV/nonOV/perl/a/bin/perl -S \
/var/opt/OV/bin/instrumentation/wasspi_wls_ca *
Cmnd_Alias WLSSPI_DISCP = /opt/OV/nonOV/perl/a/bin/perl \
/var/opt/OV/bin/instrumentation/wasspi_wls_discovery.pl
Cmnd_Alias WLSSPI_LFENP = /opt/OV/nonOV/perl/a/bin/perl -S \
/var/opt/OV/bin/instrumentation/wasspi_wls_le *
Cmnd_Alias WLSSPI_SHSCP = /opt/OV/nonOV/perl/a/bin/perl -S \
/var/opt/OV/bin/instrumentation/shs_collector.pl *
<OV_Agent_username> <nodename> = NOPASSWD: WLSSPI_ADMN, WLSSPI_COLL, \
WLSSPI_DISC, WLSSPI_LFEN, WLSSPI_SHSC, WLSSPI_ADMNP, WLSSPI_COLLP, \
WLSSPI_DISCP, WLSSPI_LFENP, WLSSPI_SHSCP

where <OV_Agent_username> is the HP Operations agent user account and 
<nodename> is the name of the managed node.

e Type wq to save the file and exit the visudo editor.  

Repeat steps 3 and 4 every time the agent user is switched.
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WebLogic SPI in High Availability Environments

High availability is a general term used to characterize environments that are business 
critical and therefore are protected against downtime through redundant resources. Very 
often, cluster systems are used to reach high availability. 

You can configure the WebLogic SPI to accommodate cluster environments where failovers 
allow uninterrupted WLS availability. WebLogic SPI monitoring, when synchronized with the 
cluster environment, can switch off from the failed node to the active node.

Configuration Prerequisites

The prerequisites for using the WebLogic SPI in high availability environments are:

• Management Server: HP-UX

• Node: HP-UX MCSG cluster, Veritas cluster (applicable only for WebLogic server version 
10.0)

• OVO 8.x HTTPS Agent version (for details, see the Agent cluster support matrix)

Configuring the WebLogic SPI for High Availability Environments

Complete the following tasks:

• Task 1: Create the WebLogic SPI monitoring configuration file

• Task 2: Create the clustered application configuration file

• Task 3: Configure the WebLogic SPI

Task 1: Create the WebLogic SPI monitoring configuration file

The WebLogic SPI uses a monitoring configuration file <appl_name>.apm.xml that works 
in conjunction with the clustered application configuration file.

The <appl_name>.apm.xml file lists all the WebLogic SPI templates on the managed node 
so that you can disable or enable these templates as appropriate, for inactive and active 
managed nodes.

To create this clustered application configuration file for your WLS environment, follow these 
steps:

1 Use the following syntax to create the <appl_name>.apm.xml file:

<?xml version="1.0"?>
<APMApplicationConfiguration>

<Application>
<Name> ... </Name>
<Template> ... </Template>
<StartCommand>wasspi_wls_perl -S wasspi_wls_clusterSvrApp -opt 
startMonitor $instance</StartCommand>
<StopCommand>wasspi_wls_perl -S wasspi_wls_clusterSvrApp -opt 
stopMonitor $instance</StopCommand>

<appl_name> is the namespace_name. For more information, see HP Operations for UNIX 
HTTPS Agent Concepts and Configuration Guide.
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</Application>
</APMApplicationConfiguration>

2 Enter the namespace_name under the <Name></Name> tag.

3 After the file is created, save it in the $OvDataDir/bin/instrumentation/conf 
directory.

Sample <appl_name>.apm.xml file

<?xml version="1.0"?>

<APMApplicationConfiguration>

<Application>
<Name>namespace_name</Name>
<Template>All</Template>
<StartCommand>wasspi_wls_perl -S wasspi_wls_clusterSvrApp -opt 
startMonitor $instance</StartCommand>
<StopCommand>wasspi_wls_perl -S wasspi_wls_clusterSvrApp -opt 
stopMonitor $instance</StopCommand>

</Application>

</APMApplicationConfiguration>

Task 2: Create the clustered application configuration file

The clustered application configuration file apminfo.xml, working in conjunction with the 
<appl_name>.apm.xml file of the WebLogic SPI, enables you to associate the WebLogic SPI 
monitored instances with cluster resource groups. As a result, when you move a resource 
group from one node to another, in the same cluster, monitoring stops on the failed node and 
starts on the new node.

To create the clustered application configuration file apminfo.xml follow these steps:

1 Use a text editor to create the file. The syntax is: 

<?xml version="1.0" ?>
<APMClusterConfiguration>

<Application>
<Name>namespace_name</Name>
<Instance>
  <Name><Instance Name></Name>
  <Package><Package Name></Package>
</Instance>

<Application>
</APMClusterConfiguration>

2 Enter namespace_name under the <Name></Name> tag.

3 Save the apminfo.xml file to the $OvDataDir/conf/conf directory.

If there is only one WLS server running on the node, you must mention "All" under the 
<template> tag.

<appl_name>.apm.xml is dependent on the application namespace. It is not dependent on 
the instance level. Therefore, the start and stop actions are provided with the associated 
instance name as their first parameter when they are executed at package switch time. The 
environment variable $instanceName is set by ClAw when start or stop tasks are performed.
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Sample apminfo.xml file

<?xml version="1.0" ?>

<APMClusterConfiguration>

<Application>
<Name>namespace_name</Name>
<Instance>

<Name>instance_name</Name>
<Package>test</Package>

</Instance>
</Application>

</APMClusterConfiguration>

Task 3: Configure the WebLogic SPI

1 Launch the Discovery application with virtual node as the target. For details about 
launching the discovery application, see Task 3: Launch Discover WebLogic on page 45. 

2 Launch the Configure WLSSPI application with the virtual node as target. The 
configuration editor opens.

3 Use the configuration editor to set the following properties (these properties are in 
addition to the ones discovered by the Discovery application) :

• CLUSTERNAMESPACE

• CLUSTERINSTANCE

These properties should have the same value as defined in apminfo.xml file. For 
example, CLUSTERNAMESPACE property must be set to namespace_name and 
CLUSTERINSTANCE must be set to instance_name.

4 Copy the SiteConfig file from active node to passive node. The file is located in the 
$OvDataDir/conf/wasspi directory.

5 Set the value of ADMIN_HOST property to the name of the managed node that was 
activated due to failover.
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Additional Discovery and Configuration Scenarios

This section includes examples about some of the common scenarios.

Use Case 1: Administration Port Turned On (WebLogic Servers are Running in 
HTTPS Mode)

If the Administration Port is enabled for the WebLogic Servers, there are two discovery 
scenarios: 

Scenario 1: The WebLogic admin server is running on t3s (HTTPS) and the WebLogic Servers associated 
with it are running on t3 (HTTP)

Discovery

1 Launch Discover WebLogic. See Task 3: Launch Discover WebLogic on page 45.

2 In the Set Access Info for Default Properties set the BEA WebLogic LOGIN and 
PASSWORD properties (this window will appear only if you have not set the LOGIN and 
PASSWORD earlier).

3 In the configuration editor, set the ADMIN_PORTS property. ADMIN_PORTS is the SSL 
port on which the application server is listening.

4 Set the PROTOCOL property to t3s (t3s is the default value for PROTOCOL). 
PROTOCOL specifies if the application server port is using SSL or non-SSL.

5 If required, set the PASSPHRASE and KEYSTORE properties. Click Next to run discovery 
on the selected nodes.

KEYSTORE is the path to the SSL trust keystore file.

PASSPHRASE is the password that you set for the KEYSTORE in the SSL environment 
of the WebLogic Admin server. 

For more information about setting the properties see Configuration Properties on 
page 166.

Configuration

After Discovery is successful:

1 Launch the Configure WLSSPI application (For instructions on launching this application 
see Configure WLSSPI on page 184).

If the WebLogic Admin server is running on a virtual IP (in a non-clustered 
environment), you must specify the virtual IP address when setting the 
ADMIN_PORTS property. Set ADMIN_PORTS value to <ip address>:port. For 
information about configuration in clustered environment see WebLogic SPI in 
High Availability Environments on page 54

The properties KEYSTORE, PASSPHRASE, and PROTOCOL can be set at any 
level (global, group, node, or server). PROTOCOL is required if you use SSL. You 
must set KEYSTORE and PASSPHRASE only if you use a keystore and 
passphrase in your SSL environment.
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2 In the configuration editor set the value of the PROTOCOL property to t3 for the 
WebLogic Servers.

3 Create a Monitor user in BEA under the active Security Realm. 

4 Set the SERVER_LOGIN and SERVER_PASSWORD properties similar to the credentials 
set for the Monitor user.

5 Repeat steps 1throgh 4 for every instance of WebLogic Server.

Scenario 2: The WebLogic admin server as well as the WebLogic Servers associated with it are running 
on t3s (HTTPS):

1 Run Discover WebLogic and set the properties as mentioned in Scenario 1.

2 After Discovery is successful. 

a Launch the Configure WLSSPI application (For instructions on launching this 
application see Configure WLSSPI on page 184).

b Set the PROTOCOL property to the default value t3s.

c Create a Monitor user in BEA under the active Security Realm. 

d Set the SERVER_LOGIN and SERVER_PASSWORD properties similar to the 
credentials set for the Monitor user.

e Repeat steps a through d for every instance of WebLogic Server.

Use Case 2: Administration Port Not Turned On (WebLogic Application Server is 
Running on a Virtual IP)

If the WebLogic Server is running on a virtual IP and the Administration Port is not turned 
on, follow these steps to run discovery:

1 Launch Discover WebLogic. See Task 3: Launch Discover WebLogic on page 45.

2 In the Set Access Info for Default Properties set the BEA WebLogic LOGIN and 
PASSWORD properties (this window will appear only if you have not set the LOGIN and 
PASSWORD earlier).

3 In the configuration editor, set the NODE_NAMES and ADDRESS properties. 

4 Click Next. The Confirm Operation window opens.

Click OK to run the discovery on the selected managed nodes.

If you do not change the value of PROTOCOL property for the WebLogic Servers 
to t3, PROTOCOL will take up the default value (t3s) set for the Admin Server. 
For more information about configuration property precedence see Configuration 
Properties on page 166.

For information about configuration in clustered environment see WebLogic SPI in High 
Availability Environments on page 54.
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4 Customizing the WebLogic SPI
Introduction

This chapter discusses the following topics: 

• Basic Template Customizations

• Advanced Template Customizations

• Restoring the Default WebLogic SPI Templates

• Viewing Text-based Reports

• Monitoring WebLogic on Unsupported Platforms

• Check the WebLogic SPI Nodes for License Count

For information about creating UDM, see the HP Operations Smart Plug-in for User Defined 
Metrics User Guide.

Basic Template Customizations

Based on the needs of your environment you might want to customize some of the default 
WebLogic SPI templates. Basic customizations, such as changing a threshold (by modifying a 
metrics template) or modifying alarm generation, are covered in this section.

Modifying Metrics Templates

Many metric attributes can be modified for all monitored instances of WebLogic Server. 
Follow these steps: 

1 From the HPOM console, open the Message Source Templates window.

2 Click SPI for WebLogic Server template group. A list of the WebLogic SPI templates 
appears in the right pane.

3 Double-click the WLSSPI-Metrics template group.

4 Select a metric and click Conditions. The Message and Suppress Conditions window opens.

5 Select the condition you want to modify (there is usually only one) and click Modify. The 
Condition window opens.

Make copies of the default templates before you start customizing the templates.
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6 Modify the attributes. See Table 2 for a list of attributes that you can modify.

7 Click OK.

8 Deploy the modified template as described in Task 7: Deploy the WebLogic SPI Templates 
on page 49.

Table 2 Metric Attributes

Attributes Description

Threshold The value which, when exceeded, signifies a problem either about to 
occur or already occurring. 

Duration The length of time for which the established threshold can be 
exceeded by the incoming data values for a metric before an alarm is 
generated.

Severity The level you can assign to a message based on its importance in your 
environment. Click Severity in the Conditions window to select the 
desired severity setting.
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Figure 4 illustrates that a threshold value of 10 is set for metric WLSSPI-0026. Metric 
WLSSPI-0026 monitors the total number of times (per minute) clients must wait for an 
available EJB (enterprise java bean).

The severity level of this metric is Warning. 

The threshold value set for this metric is 10. If the total number of times (per minute) that the 
clients wait for an EJB increases over 10, an alarm is generated (a warning message).

Figure 4 Threshold value for WLSSPI-0026

Message Text A structured, readable piece of information about the status of a 
managed object, an event related to a managed object, or a problem 
with a managed object.
Note: Do not modify any of the parameters—surrounded by <> 
brackets, beginning with $—in a message.

Actions The response to a message. This response is assigned by a message 
source template or condition and can be automatic or 
operator-initiated. You need to set actions if you want to view reports, 
view Performance Manager graphs, or add custom programs. 

Automatic action An action triggered by an incoming event or message. No operator 
intervention is involved. The automatic action delivered with the 
WebLogic SPI generates a snapshot report that shows the data values 
at the time the action was triggered from an exceeded threshold. You 
can view the report in the message Annotations.

Operator-initiated 
action

An action used to take corrective or preventive actions in response to 
a given message. Unlike automatic actions, these actions are operator 
initiated. The operator-initiated action delivered with the WebLogic 
SPI enables you to view a graph of the metric whose exceeded 
threshold generated the message along with other related metric 
values (to view the graph, click Perform Action within a message’s 
details window).

Table 2 Metric Attributes

Attributes Description
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Modifying Alarm Generation

You can set the number of times an alarm is generated by modifying the Message Generation 
setting in the Modify Threshold Monitor window. 

To modify Message Generation, follow these steps:

1 Open the Message Source Templates window. 

2 Select the SPI for WebLogic Server template group.

3 Select the WLSSPI-Metrics template group from the right pane.

4 Select a template.

5 Click Modify. The Modify Threshold Monitor window opens. 

6 Select one of the following Message Generation settings:

• With Reset: Alarms are generated once when the threshold value is exceeded. At the 
same time, a reset threshold value is activated. Only when the reset threshold value is 
exceeded, does the original threshold value become active again. Then, when the 
threshold value is again exceeded, another alarm is generated and the process starts 
all over again.

• Without Reset: Alarms are generated once when the monitoring threshold value is 
exceeded. Alarms reset automatically when metric values are no longer in violation of 
the thresholds. Alarms are generated again when the threshold is exceeded.

• Continuously: Messages are sent, or alerts are generated, each time the metric 
values are collected and the threshold is exceeded. 

7 Click OK.

8 Deploy the modified templates as described in Task 7: Deploy the WebLogic SPI 
Templates on page 49.
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Advanced Template Customizations

Template modifications include making copies of default template groups to customize a few 
settings and deleting metric groups within a template’s command line. All modifications 
described require some advanced knowledge of the WebLogic SPI metrics.

Choosing Metrics to Customize

Determine which metrics you want to customize and what templates within the group you 
want to use. Then, follow these steps:

1 Open the Message Source Template window.

2 Select SPI for WebLogic Server from the Template Groups pane. A list of template appear 
in the right pane.

3 Select the template group you want to use and click Copy...The Copy Template Group 
window opens.

4 Rename the group and click OK to save.

5 Within the renamed template group, copy each original template and rename it.

6 Delete the original templates within the renamed template group.

7 Customize the renamed templates within the group as necessary. 

Creating a new template group enables you to keep custom templates separate from the 
original default templates. 

Using the WebLogic SPI Collector/Analyzer Command with Parameters

The wasspi_wls_ca command is used in every collector template. The collector template is 
named according to its collection interval. You can view the default command line parameters 
within each collector template in the Command box of the Modify Schedule Action window. 

Using the WebLogic Server Command Parameters

The WebLogic SPI data collections are started with the wasspi_wls_ca command, to which 
you can add other parameters, as identified in the following table.

Parameter Function Syntax

-e

(exclude)
Enables you to exclude specific 
servers. This option must not be 
used with the -i option.

-e <server_name>
Example: -e server2,server4

-i

(include) 
Enables you to list specific servers to 
monitor. This option must not be 
used with the -e option.

-i <server_name>
Example: -i server1,server3

-m

(metric) 
Specifies the metric numbers or 
number ranges on which to collect 
data.

-m
<metric_number|metric_number_range>
Example: -m 1,3-5,9-11,15
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Syntax Examples

• To collect specific data on all configured servers:

wasspi_wls_ca -m 10-14,25,26

• To collect data from specific servers only:

wasspi_wls_ca -m 245,246,26 -i server1,server2

-matchver

(match 
version) 

Specifies the specific WebLogic 
Server version to monitor. This 
option must not be used with the 
-minver nor -maxver options. If no 
matching versions are found, the 
command does not execute.

-matchver <version_number>
Example: -matchver 7

-maxver

(maximum 
version) 

Specifies the highest WebLogic 
Server version to monitor. Use with 
-minver to specify a range of 
versions. If no versions are found, 
the command does not execute. 

-maxver <version_number>
Example: -maxver 10

-minver

(minimum 
version)

Specifies the lowest WebLogic Server 
version to monitor. Use with 
-maxver to specify a range of 
versions. If no versions are found, 
the command does not execute.

-minver <version_number>
Example: -minver 7

-r

(report)
Generates an ASCII report for the 
specified metric(s).

-r

-t

(tag) 
Creates a new template group by 
adding a prefix to an existing 
collector template and specifying the 
metric number(s). 

-t <prefix>-
Example: wasspi_wls_ca -t DEV-

-x Enables you to specify a property/
value as follows:

-x <property>=<property_value>

alarm: When off, overrides any 
alarming condition as set up in the 
metric monitor template.

-x alarm=off

prefix: Default: JMXUDM_. Specify 
the prefix of the metric ID.

-x prefix=SALES_

print: When on, prints the metric 
name, instance name, and metric 
value to STDOUT in addition to any 
configured alarming or logging.

-x print=on

graph: When off, prevents graphing 
functions.

-x graph=off

report: When off, prevents reporting 
functions.

-x report=off

Parameter Function Syntax
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• To not collect data from specific servers:

wasspi_wls_ca -m 220-225 -e server1,server2

Using the JMX Command Parameters

The command parameters described in this section are used to run JMX actions. JMX actions 
are one or more JMX calls (invoke, get, set) performed on an MBean instance or type. A single 
JMX call can be performed from the command line. Multiple JMX calls can be specified in an 
XML file or as a Metric sub-element in a UDM file.

Table 3 JMX Command Parameters

Parameter Function Syntax

-a

(action)
Required

 Indicates a JMX action is 
performed.

-a

-i

(include)
Specifies servers on which 
to perform the JMX actions. 
If this parameter is not 
specified, the JMX actions 
are performed on all 
configured servers.

-i <server_name>
Example: -i server1,server3

-m

(metric)
Specifies the metric ID 
containing the action to 
perform. This metric ID 
must be defined in a UDM 
file. This option must not be 
used with the -mbean nor 
-xml options.

-m <metric_id>
Example: -m TestUDM_1000
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-mbean Performs a JMX call on the 
specified MBeans. This 
option must not be used 
with the -m nor -xml 
options.

-mbean <objectname> <action>
Example: -mbean *:*, 
Type=JMSServerConfig -get 
MessagesMaximum\

In the above syntax, <action> (a JMX call) is one of the following:

-get Returns the value of the a specified 
attribute.
Syntax: -mbean <objectname> -get 
<attribute>
Example: -get MessagesMaximum

-invoke [-type] Executes an MBean operation with the 
specified parameters. An operation might 
not require parameters (therefore, -type is 
not specified). A type parameter must be 
specified for operations which accept 
parameters. -type supports operation 
overloading.
Syntax: -mbean <objectname> -invoke 
<operation>
[-type <parameter_type> 
<parameter_value>]...
where <parameter_type> is one of the 
following:
short, int, long, double, float, boolean, 
java.lang.Short, java.lang.Integer, 
java.lang.Long, java.lang.Double, 
java.lang.Float, java.lang.Boolean, and 
java.lang.String.
Example: -invoke stagingEnabled -type 
java.lang.String examplesServer

-set Assigns the specified value to the specified 
attribute.
Syntax: -mbean <objectname> -set 
<attribute> <value>
Example: -set MessagesMaximum 250000

-o (object) Specifies an MBean 
instance.

Syntax: -o <mbean_instance>
Example: -o examplesJMSServer

-xml Specifies the XML file that 
contains the JMX action(s) 
to perform. This option 
must not be used with the 
-m nor -mbean options.

Syntax: -xml <filename>
Example: -xml myJMXActions.xml

Table 3 JMX Command Parameters

Parameter Function Syntax
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Examples

• Set the maximum threads for an alarming WebLogic execute queue to 50 (where 
<$OPTION(instancename)> specifies an alarming instance):

wasspi_wls_perl -S wasspi_wls_ca -a 
-mbean “PetStore:*,Type=ExecuteQueueConfig” 
-set ThreadsMaximum 50 -o <$OPTION(instancename)>

• Set the MessagesMaximum attribute to 25000 on multiple MBean instances:

wasspi_wls_perl -S wasspi_wls_ca -a 
-mbean *:*,Type=JMSServerConfig -set MessagesMaximum 250000 -i 
examplesServer

• Set the MessagesMaximum attribute to 25000 on a specific MBean instance:

wasspi_wls_perl -S wasspi_wls_ca -a 
-mbean *:*,Type=JMSServerConfig -set MessagesMaximum 250000 -i 
examplesServer -o examplesJMSServer

• Invoke an operation on multiple MBean instances:

wasspi_wls_perl -S wasspi_wls_ca -a 
-mbean *:*,Type=ApplicationConfig -invoke staged 
-i examplesServer

• Get the MessagesMaximum attribute (after a set command, used to verify that the 
attribute was set):

wasspi_wls_perl -S wasspi_wls_ca -a 
-mbean *:*,Type=JMSServerConfig -get MessagesMaximum 
-i examplesServer

• Use the sample UDM TestUDM_1000 in the wls_UDMMetrics-sample.xml file:

wasspi_wls_perl -S wasspi_wls_ca -a -m TestUDM_1000 -i examplesServer

Changing the Collection Interval for All Scheduled Metrics

To change the collection interval for all scheduled metrics, change the Polling Interval in the 
appropriate collector template. For example, to change the collection of default metrics from 5 
minutes to 10 minutes for the WLSSPI-05min collector template, follow these steps:

1 Select the Message Source Templates window.

2 Select the template group SPI for WebLogic Server and open WLSSPI-Schedule.

3 Select the collector template WLSSPI-05min.

4 Click Modify.... The Modify Schedule Action window opens.

5 Change the Schedule Action Name to WLSSPI-10min.

6 In the Minute box, change the polling interval from 5 minute to 10 minutes. For example, 
0, 10, 20...

7 Distribute the new templates (described in Task 7: Deploy the WebLogic SPI Templates on 
page 49). 
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Changing the Collection Interval for Selected Metrics

To change the collection interval for selected metrics, copy the appropriate collector template 
and rename with a name reflecting the new interval. Delete all but the metrics you are 
changing. Set the new interval. Remove the metrics you changed from the original template.

For example, to change the collection interval to 10 minutes for metrics 70-81, follow these 
steps:

1 Open the Message Source Templates window.

2 Select the template group SPI for WebLogic Server and open WLSSPI-Schedule.

3 Select the template WLSSPI-05min.

4 Click Copy.... The Copy Schedule Action window opens.

5 Change Scheduled Action Name to WLSSPI-10min.

6 In the Command box (see figure above), delete all metrics after the -m except 70-81.

7 Change the Polling Interval to 10m.

8 Click OK.

9 In the WLSSPI-Schedule template group, select the WLSSPI-5min template.

10 Click Modify. The Modify Schedule Action window opens

11 Delete 70-81 from the Command box.

12 Re-distribute the modified templates as described in Task 7: Deploy the WebLogic SPI 
Templates on page 49.

Cutomize Threshold Values for Different Applications/EJB/Servlet/JDBC

In your environment some applications might be more critical than others, also, within an 
application some of the EJBs/Servlets/JDBC datasource might be critical, and others might 
not. You can set threshold values per application or per EJB/Servlet/JDBC datasource 
depending on their criticality.

To do so, you must copy the existing condition and modify it. Follow these steps:

1 Double-click to open the metric for customization (for example, WLSSPI-0012). The 
Message and Suppress Conditions window opens.

2 Select the desired condition and press the Copy... button to make a copy of the condition. 

3 In the Object Pattern field, enter the following details (enter only the necessary fields, see 
Examples):

<ServerName>:<ServerPort>:<NodeName>:<ApplicationName>:<EJBName/
ServletName/JDBC DataSource>:<Instance Name>

4 In the Threshold column, change the threshold value. 

5 Deploy the template to the corresponding node.
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Before customizing the threshold value, you might want to see the list of applications/EJBs/
Servlets/JDBC datasource running on a server. For this you can use the following WebLogic 
SPI applications:

•  View WebLogic Servers: This gives you details of all running application servers and the 
corresponding ports.

• View Deployed Apps: Gives a list of all applications deployed on a particular server.

Examples

The following examples illustrate how to enter details in the Object Pattern field:

• Example 1: To set threshold for the application MedrecEAR, and if the application name 
is unique across all the nodes, enter the following:

 <*>:<*>:<*>:MedrecEAR:<*>:<*>

• Example 2: To set the threshold for the application MedrecEAR that is available on node 1 
and node 2, then to set the threshold only on node 1, enter the following:

<*>:<*>:node1:MedrecEAR:<*>:<*>

• Example 3: To set the threshold for the Servlet- FileServlet under the application 
MedrecEAR, and FileServlet is unique across all the nodes, enter the following:

 <*>:<*>:<*>:MedrecEAR:FileServlet:<*>

Creating Custom, Tagged Templates

Another advanced customization option is to use the tag option (-t on the command line), 
which allows the collector or analyzer to recognize customized templates that have a tag 
attached to the name. This option provides you with the flexibility of using more than a single 
set of templates to define conditions pertaining to specific installations of WebLogic Server.

When multiple nodes are managed by a number of groups, this option enables you to create 
specially tagged templates that are obviously separate from your original setup. In such a 
case, you would make copies of the templates, rename them with the tag and re-work the 
collector template to pick up the tagged names, assign them to the various groups. 

For example, you might create a group of templates and change each template name to 
include CLIENT01 in it. A metric monitor template might be named 
CLIENT01-WLSSPI_0012 (retaining the metric number, which must be used). The collector 
template would be named FIRST_CLIENT-05min. You could then set up another group for 
SECOND_CLIENT and change all those templates to include the CLIENT02 in the name.

To create the new template group

1 Copy the original template group. In the Message Source Templates window, select the 
group, and click Copy....

2 Name the new group according to how you plan to identify the new monitor and collector 
templates. For example, if you are including CLIENT01 in the template names, include 
CLIENT01 within the new template group name as well.

3 In the Message Source Template window expand, the new template group to show all 
templates and select each template you plan to use, click Copy..., and rename it according 
to your naming scheme. 
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• The names you give the new metric monitor templates in the group would contain the 
new name followed by the original metric number. For example, a copy of 
WLSSPI-0001 could be called CLIENT01-WLSSPI_0001. 

• The name you give the new collector monitor template would also contain the 
identifying name. You would also modify the scheduled collection for the new group by 
inserting the -t property on the command line. For example: 

wasspi_wls_ca -m 16 -t CLIENT01-

4 Delete all original templates from the new group.

Template Variables

The following variables are used by the WebLogic SPI templates. If you are creating your own 
templates, you can use these variables.

Restoring the Default WebLogic SPI Templates

When the WebLogic SPI templates are installed in HPOM, the commands given in the table 
below automatically upload the templates when swinstall is run. Any customized template 
settings you might have done for the previous installation are overwritten. 

To restore the default SPI for BEA WebLogic Server template group you originally installed, 
delete all current templates first, run one of the commands in the following table (depending 
on the version of HPOM):

Name Description

instancename The instance for which the metric is being reported for multi-instance 
metrics.
Example: medRecServer_MedRecServer_wl_management_
internal2_com.bea.wli.bpm.runtime.JwfServlet_20

map_port See port.

map_servername The application server name with spaces replaced with underscores (“_”). 
Used for service map keys where spaces are prohibited.
Example: my_server

node The node on which the application server is running.
Example: moo1.hp.com

port The port on which the application server is listening. Corresponds to the 
PORT configuration property.
Example: 9001

servername The application server name. Corresponds to the NAME configuration 
property.
Example: my server
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Scripts run by swinstall 

Alternatively, you can use the -verbose option instead of the -silent option.

Viewing Text-based Reports

Some templates have actions defined with threshold violations or error conditions that 
automatically cause reports to appear in the message Annotations. These reports are 
snapshots of data values collected form the server around the time that the alarm occurred.

Other templates have operator actions associated with them that enable you to generate a 
graph. 

• To view message details, double-click a message in the HPOM message browser or 
right-click the message and select Details.

• To view reports, open both the Node Bank and Application Bank windows. Continue to 
open application windows WLSSPI  WLSSPI Admin  Reports. Select a node and drag it 
onto the WLSSPI metric report you need. These reports show all server data on a node. 

• To view graphs, open both the Node Bank and Application Bank windows. Continue to 
open application windows WLSSPI  WLSSPI Admin. Drag a node onto the View Graphs 
application to launch your Web browser, which displays the graphing feature available in 
HP Performance Manager (which must be purchased separately).

Automatic Action Reports

Many metrics generate Automatic Action Reports. These reports are generated as soon as an 
alarm is triggered in HPOM. Automatic Action reports show the state of the system soon after 
the alarm occurs.

When an Automatic Action report is executed from HPOM, the server is queried for additional 
data. If you set your message browser to display the SUIAONE column, you will notice the 
letter “S” under the “A” column (see Figure 5) when a report is available in the Annotations 
area of the Message Details.

HPOM 
Version Scripts

>8.x /opt/OV/bin/OpC/opccfgupld -silent -replace 
-subentity /var/opt/OV/share/tmp/OpC_appl/wasspi/wls_set

The reports discussed in this section should not be confused with those generated by HP 
Reporter, which show more consolidated, historical data generated as web pages in 
management-ready presentation format. 
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Figure 5 Message Browser

To View Automatic Action Reports

You can view Automatic Action reports in the Annotations window. Do one of the following:

• Select the message for which a report is and click Annotations. The Annotations window 
opens.

• Right-click a message and select Annotations. The Annotations window opens.

Automatic Action reports show data values on a single server. Column descriptions in the 
window provide more information.

Application Bank Reports

You can use Application Bank Reports to manually generate a report similar to an Automatic 
Action report. Application Bank reports run for all WebLogic Server instances configured on 
the managed node, in contrast to Automatic Action Reports, which are generated for a single 
WebLogic Server instance. The reports generated from the Application Bank reflect the 
current state of WebLogic Server on the managed node. 
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To Manually Generate a Report

Follow these steps:

1 At the HPOM console, double-click HPOM Node Bank. The HPOM Node Bank window 
opens.

2  From the Window menu, select Application Bank. The HPOM Application Bank window 
opens.

3 Double-click WLSSPI. The Application Group: WebLogic SPI window opens.

4 Double-click WebLogic SPI Reports. The Application Group: WebLogic SPI Reports window 
opens. All the WebLogic SPI Reports appear in this window.

5 Drag the managed node from the Node Bank window to the desired report in the 
Application Bank window.

Sample Reports

Two samples, one each of Automatic Action report and manually generated report 
(Application Bank report) are given below.
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Automatic Action Report

Figure 6 shows the format of an automatically generated WebLogic SPI report.

Figure 6 Report on metric B011
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Manually generated Report

Figure 7 shows the format of a manually generated WebLogic SPI report.

Figure 7 Manually Generated WebLogic SPI Report
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Monitoring WebLogic on Unsupported Platforms

The WebLogic SPI supports monitoring WebLogic Servers installed on systems running 
HP-UX, Linux (Red Hat), Solaris, and Windows 2000. However, it is possible to configure the 
WebLogic SPI to monitor a WebLogic Server installed on systems running on unsupported 
platforms—systems referred to as “remote systems.” 

The intent of this section is to help you determine if your environment is conducive to setting 
up remote monitoring. If your environment meets the criteria described below, this section 
offers an example to get you started.

Requirements for Monitoring Remote Nodes (Running on Platforms Not 
Supported by the WebLogic SPI)

For a WebLogic Server installation on a system running on a platform other than HP-UX, 
Linux (Red Hat), Solaris, or Windows 2000, you can use the WebLogic SPI to monitor that 
remote system if the following conditions apply. The last condition is optional:

• The remote system is covered by a purchased license (using Tier 1 pricing).

• The WebLogic SPI runs on at least one managed node on a supported platform: HP-UX, 
Solaris, or Windows 2000.

• (Optional, for logfile monitoring) The remote system runs on a platform supported by the 
HP Operations agent software.

Overview

This section provides an overview of remote monitoring and shows how it is implemented. It 
also explains how to set up the WebLogic SPI to access WebLogic Server metrics and logfiles 
on unsupported platforms by using both the WebLogic SPI and HP Operations agent 
software.

Remote Monitoring

In a standard configuration, the WebLogic SPI programs and templates are deployed on the 
local, managed node. In a non-standard configuration, the local system is used as a proxy 
through which remote metric information becomes accessible.

Remote system data collection and interpretation relies on the local, managed node to act as 
the proxy on which data collection is configured (see Figure 8).
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Figure 8 Remote System Data Collection

Configuration entries requirement: Within the configuration, entries for both local and 
remote systems are included. You can include multiple remote system entries in a local 
system’s section. See the example on page 78, that shows how the remote entry appears (with 
system IP address).

Template deployment requirement: Templates must be deployed on the local node. If you 
need a separate template group, you can copy and rename the existing templates and specify 
the WebLogic Server name on the command line using the -i or -e options. For details on using 
these command line parameters, see Using the WebLogic Server Command Parameters on 
page 63. 

HP Operations agent deployment requirement (optional logfile monitoring): To access 
remote WebLogic log files, ensure that the HP Operations agent software is installed on the 
remote system. Using standard HPOM processes, you can modify the standard logfile 
templates included with the WebLogic SPI to specify the correct logfile names, and deploy 
them to the remote system. 

Configure Remote System Monitoring

To monitor WebLogic Servers remotely on systems other than those running on HP-UX, 
Linux (Red Hat), Solaris, or Windows 2000 platforms, complete these tasks:

Monitoring remote systems using logfile versioning is not supported.
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Task 1: Configure the Remote WebLogic Server

Use Configure WebLogic SPI application in the WebLogic Application Bank, to configure each 
local managed node that communicates with a remote WebLogic Server. In the configuration 
add entries for remote WebLogic Servers. 

1 Select the WebLogic managed node from which you want to monitor the remote WebLogic 
Server.

2 In the configuration, include an entry for each remote WebLogic Server: 
SERVER<n>_ADDRESS=<DNS server name or IP address>.

Make sure that the property NUM_SERVERS is set to the correct number of servers 
(<n>) and that HOME and JAVA_HOME properties are set at the global level. 

The illustration below shows how local and remote WebLogic Servers are configured in 
the same file. Notice, however, that for the remote servers the 
SERVER<n>_ADDRESS=<IP_address> line is added:

SERVER2_ADDRESS=15.75.27.109

 or 

SERVER2_ADDRESS=hardey.hp.com

If you are configuring one local (SERVER1) and one remote (SERVER2) WebLogic Server, 
your configuration might look like the following: 

There are two WebLogic Servers configured in the preceding configuration. SERVER1 is the 
local server, running on an HP-UX managed node. SERVER2 is running on an HPOM 
managed node, that is a non-Red Hat Linux system (a platform unsupported by the 
WebLogic SPI). The remote system is configured similar to that of the local system but 
contains the new line SERVER2_ADDRESS=hardey.rose.hp.com. 

3 To verify that the SPI is monitoring the remote node, run the following command:

wasspi_wls_perl -S wasspi_wls_ca -m 5 -i <remote_server_NAME|ALIAS> -x 
print=on

You must use ALIAS if it is set for the remote server.

Task 2: Integrate HP Performance Agent (Optional)

The HP Performance Agent collection occurs on the managed node, not the remote system. If 
you use PerfView and would like to graph the remote system data, you must ensure that HP 
Performance Agent integration is enabled on the local managed node.
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Task 3: Assign Local Node to WebLogic node group 

Assign the local managed node to the WebLogic node group. Make sure you are deploying the 
configuration on the same WebLogic Server version node as the remote system.

Configuring Remote Monitoring for Logfiles (Optional)

Monitoring remote system logfiles is supported, if the following critera are met

1 The remote system that has an HP Operations agent running on it.

2 The system does not re-version logfiles when they roll.

To set up logfile monitoring, at the HPOM console, copy the WLS-SPI logfile template and 
then configure, assign, and deploy the copied logfile template to the remote system.

Configure the Logfile Template for Remote Logfiles

To configure the Logfile templates for remote monitoring, follow these steps:

1 Open a copy of the WebLogic Log Template located under the WebLogic version Group.

For example, SPI for WebLogic Server  WLSSPI-Logfiles

2 In the Logfile text box, enter the location of the logfile on the remote system: 
/<path>/<filename>.

3 Assign and deploy the logfile template to the remote HPOM managed node.

The Log File Template and the HP Operations Agent, both present on the remote system, 
make WebLogic Server logfile monitoring possible.
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Remote Monitoring Limitations

Remote monitoring has the following limitations:

• The WebLogic SPI and the HP Operations agent do not support access to logfiles that are 
re-versioned each time the logs are rolled.

• When no HP Operations agent is present on the remote system, monitoring of WebLogic 
logfiles on the remote system cannot occur.

• In the HPOM Application Bank, the WebLogic SPI applications cannot be executed on 
remote systems.

Check the WebLogic SPI Nodes for License Count

You can use an HPOM reporting utility to check the number of templates you installed on 
your managed nodes. In reviewing the number of templates per managed node, you can see if 
you consistently installed templates across your managed systems. In addition, by running 
this report, you can also ensure that the number of licenses you purchased is in compliance 
with the report results.

To run the report, follow these steps:

1 At the HPOM console, select the node or node group that you want to check.

2 From the Actions menu, select Utilities  Reports....

3 In the Reports window among the reports listed, select WLSSPI License Check.

4 Select an output destination and click OK.
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5 Integrating HP Reporting and Graphing 
Products with the WebLogic SPI
The WebLogic SPI can be integrated with the following HP reporting and graphing products 
(these products must be purchased separately): 

• HP Reporter: Reporter produces management-ready, web page reports, showing 
historical and trending information. This is not the version of Reporter that is included 
with HPOM. 

Working in conjunction with Reporter, the WebLogic SPI produces a variety of reports 
showing consolidated information on the WebLogic Application Server.

For more information on how to integrate the WebLogic SPI with Reporter, see 
Integrating with HP Reporter on page 82. After you integrate the WebLogic SPI with 
Reporter, Reporter generates reports, every night, that show the performance and 
availability of a WebLogic Application Server on configured managed nodes.

• HP Performance Agent: HP Performance Agent collects, summarizes, time stamps, and 
detects alarm conditions on current and historical resource data across your system. It 
provides performance, resource, and end-to-end transaction response time measurements, 
and supports network and database measurement information. See the HP Performance 
Agent for UNIX User’s Manual for more information about HP Performance Agent. 

If you are using HP Performance Agent, the WebLogic SPI automatically uses it. If you 
want to use the HP Operations subagent, CODA, that is included with HPOM (does not 
support HP Performance Agent), you must configure your managed nodes to do so. See  
Integrating with CODA on page 82 for more information.

• HP Performance Insight: HP Performance Insight is a network management system 
that collects, processes, and reports data. The data is used to generate reports. See the HP 
Performance Insight Administration Guide for more information about HP Performance 
Insight. See the Application Server Report Pack User Guide for more information about 
the WebLogic SPI reports and how to integrate the WebLogic SPI with HP Performance 
Insight.

• HP Performance Manager: HP Performance Manager provides graphing capability of 
the WebLogic SPI metrics. This is not the version of HP Performance Manager that is 
included with HPOM.

For more information on how to integrate the WebLogic SPI with HP Performance 
Manager, see Integrating with HP Performance Manager on page 87. After integrating 
the WebLogic SPI with HP Performance Manager, graphs are available the following day. 
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Integrating with CODA

The WebLogic SPI can detect if you are using HP Performance Agent. If you are using HP 
Performance Agent, the WebLogic SPI installation automatically uses it. 

If you want to use the HP Operations subagent, CODA, included with OVO 7.x and later, you 
must configure the managed nodes to do so. This configuration does not support HP 
Performance Agent. 

To use CODA, set up an empty file named nocoda.opt and store it on the managed node:

1 On the managed node, create a nocoda.opt file in the following directory:

If the directory dsi2ddf does not exist, create it.

2 Save the empty file.

Integrating with HP Reporter 

You must configure the WebLogic SPI (see Chapter 3, Configuring the WebLogic SPI) before it 
can be integrated with Reporter.

If you are upgrading the WebLogic SPI report package, you must remove the old version 
before installing the new version. See Task 13: Install the New Report Package (Optional) on 
page 34 for information on how to remove the WebLogic SPI report package.

You must install the WebLogic SPI report package on a Windows system running Reporter. 
To install the report package, follow these steps: 

1 On the Windows client system, insert the Smart Plug-ins DVD-ROM (that contains the 
reporting packages) into the DVD-ROM drive, and in Windows Explorer, double-click:

\OV_REPORTER\WebLogic_SPI_06.00.000\WLSSPI-Reporter.msi 

2 Follow the instructions as they appear.

3 Check the Reporter status pane (see the illustration that follows) to note changes to the 
Reporter configuration.

Operating System File Location

HP-UX, Linux, Solaris /var/opt/OV/conf/dsi2ddf/ 

Windows \usr\ov\conf\dsi2ddf\

For Windows 2000 managed nodes, during the installation an error message 
might appear that indicates the installer has detected an older version of the 
installer on your system. You can safely ignore the message and continue.
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The status pane (at the bottom of the Reporter window) shows you information on the 
programs running and any errors occurring. You can check the status pane to see that 
Reporter has been updated with the WebLogic SPI reports. 

You can find instructions in the Reporter Help for assigning the WebLogic SPI reports to 
the targeted nodes. To access Help, select Reports or Discovered Systems in the left panel 
of the Reporter main window and right-click it. Select Report Help or Discovered Systems 
Help from the submenu that appears and see the topic to assign a report definition to a 
Discovered Systems Group.

4 Add group and single system reports by assigning reports as desired. (See the Reporter 
Help and the online Concepts Guide for complete information).

Group and single system WebLogic SPI reports require that you identify systems 
by their full name. For example, abc.xyz.com is acceptable while abc is not.
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The WebLogic SPI Reporter Reports

The reports available through the integration of HP Reporter and the WebLogic SPI show 
consolidated data on server performance and availability on WebLogic Server systems. In 
addition, other reports show data for single systems. These reports are available the day 
following your installation of the WebLogic SPI report package on the Reporter Windows 
system. (See Integrating with HP Reporter on page 82, if you have not yet completed the 
report package installation.)

The tables that follow show all pre-defined reports.

 

Table 4 Performance

Report Title Description
WebLogic 
Version Metric

TOP 20 Queue 
Throughput

Shows the average throughput for the top 20 
execute queues of all servers. 

7.0, 8.1, 9.x, 
10.0

10

TOP 20 Servlet Average 
Execution Times

Shows the average execution time for the top 
20 requested servlets for all servers.
Along with the servlet name the associated 
application name is also displayed.

7.0, 8.1, 9.x, 
10.0

240

TOP 20 Servlet Request 
Rates 

Shows the total servlet request rate being 
received by the top 20 servers
Along with the servlet name, the associated 
application name is also displayed.

7.0, 8.1, 9.x, 
10.0

242

Execute Queue Thread 
Utilization 

Shows the execute queue`s thread utilization 
as a percent for the top 20 execute queues of 
all servers.

7.0, 8.1, 9.x, 
10.0

11

TOP 20 Average 
Transaction Throughput 

Shows the average transaction throughput 
for the top 20 servers.

7.0, 8.1, 9.x, 
10.0

76

TOP 20 EJB Free Pool 
Wait Rate

Shows the number of times per minute that a 
request had to wait for an EJB to become 
available for the top 20 servers.

7.0, 8.1, 9.x, 
10.0

25

TOP 20 EJB Timeout 
Rate

Shows the number of times per minute that a 
request timed out while waiting for an EJB 
to become available for the top 20 servers.

7.0, 8.1, 9.x, 
10.0

26

TOP 20 EJB Transaction 
Throughput

Shows the average EJB transaction 
throughput for the top 20 servers.

7.0, 8.1, 9.x, 
10.0

35

Table 5 Availability

Report Title Description
WebLogic 
Version Metric

Server Availability Contains a daily histogram showing the 
percentages of uptime, downtime for all 
servers.

7.0, 8.1, 9.x, 
10.0

2
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Table 6 Single System Reports

Report Title Description
WebLogic 
Version Metric

Server Availability 
Details 

Contains spectrum graphs showing minutes 
of uptime by day and hour for each WebLogic 
Server.

7.0, 8.1, 9.x, 
10.0

2

JDBC Throughput And 
Connection Utilization 

Charts the throughput against the 
utilization for the JDBC connection pools for 
each WebLogic Server. Shows the JDBC data 
source and the associated application name 
(if any). 

7.0, 8.1, 9.x, 
10.0

260, 
262

Throughput And 
Utilization Of JMS 
Server By Byte Count 

Charts the throughput against the queue 
utilization by byte count for destinations on 
the JMS servers for each WebLogic Server.

7.0, 8.1, 9.x, 
10.0

252, 
256

Throughput And 
Utilization Of JMS 
Server By Message 
Count 

Charts the throughput against queue 
utilization by message count on the JMS 
servers for each WebLogic Server.

7.0, 8.1, 9.x, 
10.0

251, 
255

Queue Utilization versus 
Throughput On Server

Shows the throughput against the thread 
utilization for each WebLogic Server.

7.0, 8.1, 9.x, 
10.0

10,11

TOP 20 Servlet Request 
Rate On Server 

Shows a stacked area chart with the request 
rate (requests per second) for the top 20 
servlets for each day and a table with data of 
the top 100 servlets for each WebLogic 
Server.

7.0, 8.1, 9.x, 
10.0

242

Transaction Throughput 
On Server 

Shows the average transaction throughput 
for each WebLogic Server by day.

7.0, 8.1, 9.x, 
10.0

76

Transaction Rollback 
Types 

Shows the transaction rollbacks by error 
type for each WebLogic Server.

7.0, 8.1, 9.x, 
10.0

72-75

TOP 20 Stateful and 
Entity EJB Cache 
Utilization

Shows the EJB cache utilization percent for 
the top 20 EJBs for each WebLogic Server. 
Along with the EJB instance, the associated 
application name also will be displayed

7.0, 8.1, 9.x, 
10.0

238
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HP Performance Insight Reports for the WebLogic SPI

The reports available through the integration of HP Performance Insight and the WebLogic 
SPI show consolidated data on server performance and availability on WebLogic Server 
systems. See the Application Server Report Pack User Guide for more information about the 
WebLogic SPI reports and how to integrate the WebLogic SPI with HP Performance Insight.

The table that follow shows all pre-defined reports.

Report Title Description Metric

Server Availability—
Throughput

The server availability chart plots the availability status 
of the application server on an hourly, daily, and monthly 
basis. The transaction throughput chart displays the 
number of transactions processed by the application 
server per second.

2, 76

EJB Pool Utilization The percentage of EJB pool utilization. 235

JDBC Throughput—
Utilization

The percentage of available JDBC connection in the 
connection pool and the number of clients serviced by the 
connection pool per second.

260, 
262

Near Real Time Server 
Availability

The server status for the last six hours. 2, 76

Servlet Request Rate—
Response Time

The servlet request rate measures the number of requests 
for a servlet per second. The servlet response time chart 
shows the average execution time for an individual 
servlet.

240, 
242

EJB Cache Utilization The percentage of EJBs in the cache in use. 238

EJB Transaction Reports The EJB Free Pool Wait Rate measures the number of 
times per minute that no stateless session beans were 
available from the free pool. The EJB Load Timeout Rate 
measures the number of times a client timed out waiting 
for an EJB. The EJB Transaction Throughput measures 
the number of EJB transactions per second.

25, 26, 
35

Execute Queue 
Throughput—Utilization

The Execute Queue Throughput rate measures the 
number of requests serviced by an execute queue per 
second. The Queue Utilization chart shows the percentage 
of threads used for a server’s execute queue.

10, 11

JMS Throughput—
Utilization

The JMS Throughput report indicates the number of 
messages/bytes that have passed through the JMS per 
second. The JMS Utilization report indicates what 
percentage of a JMS queue is filled based on the number of 
messages or bytes.

251, 
252, 
255, 
256

Near Real TIme Execute 
Queue Throughput—
Utilization

The throughput or utilization trend of execute queues for 
the last six hours.

10, 11

Server Transaction 
Rollback

The percentage of transactions that are rolled back due to 
resource, application, timeout, or system error.

72 - 75
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Integrating with HP Performance Manager

To integrate the WebLogic SPI with HP Performance Manager, follow these steps:

1 Install and configure the WebLogic SPI. Verify that you have completed Task 1: Configure 
the Management Server to Launch Your Web Browser on page 37. Also, verify that you 
have set the GRAPH_URL property. For more information about the GRAPH_URL 
property, see Property Definitions on page 167.

2 If you are upgrading the WebLogic SPI graph package, you must remove the old version 
before installing the new version. For information on removing the WebLogic SPI graph 
package, see Task 14: Install the New Graph Package (Optional) on page 34.

3 Install the graph package.

If HP Performance Manager is running on a Windows system, follow these steps:

a Insert the Smart Plug-ins DVD-ROM (that contains the reporting packages) into the 
DVD-ROM drive, and in Windows Explorer, double-click:

\OV_PM\WebLogic_SPI_06.00.000\WINDOWS\HPOvSpiWlsGc-06.00.000.msi

b Follow the instructions as they appear.

If HP Performance Manager is running on a HP-UX system that is not the HPOM 
management server, follow these steps (if HP Performance Manager is installed on the 
HPOM management server, the files are installed automatically when you install the SPI 
software):

• Mount the Smart Plug-ins DVD-ROM (that contains the reporting packages) and 
type:

swinstall -s <mount_point>/OV_PM/WebLogic_SPI_06.00.000/HPUX/
HPOvSpiWlsGc-06.00.000.depot WLSSPI-GRAPHS

If HP Performance Manager is running on a Solaris system that is not the HPOM 
management server, follow these steps (if HP Performance Manager is installed on the 
HPOM management server, the files are automatically installed when you install the SPI 
software):

• Mount the Smart Plug-ins DVD-ROM (that contains the reporting packages) and 
type:

/usr/sbin/pkgadd -d <mount_point>/OV_PM/WebLogic_SPI_06.00.000/
SOLARIS/HPOvSpiWlsGc-06.00.000.sparc all

4 To graph any WebLogic Server metric, use the data source name WLSSPI_METRICS.

For information on how to view the graphs, see the HP Performance Manager documentation. 
You can view the graphs one day after the integration.

Viewing Graphs that Show Alarm Conditions

For graphing purposes, the WebLogic SPI organizes metrics according to type. When a 
message is generated for any metric appearing in a table in the section that follows, you can 
view a chart of its and other metric values. 

To uninstall the Graph package, follow the steps given in Task 8: Remove the Graph Package 
(Optional) on page 28
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To view a graph associated with an alarm condition (Operator-initiated action has been 
defined with the WebLogic SPI monitor template), complete these steps:

1 In the HPOM message browser, double-click the message. The Message Details window 
opens.

2 Click Perform Action.

The WebLogic SPI graph for the metric appears. The value of this metric is charted along with 
the values of other metrics in the same group. 

Viewing Graphs that Show Past or Current Conditions

You can manually generate any of the four available graphs using the View Graphs 
application. Follow these steps:

1 At the HPOM console, double-click HPOM Node Bank. The HPOM Node Bank window 
opens.

2 From the Window menu, select Application Bank. The HPOM Application Bank opens in a 
new window.

3 Double-click WLSSPI. The Application Group: WebLogic SPI window opens.

4 Double-click WLSSPI Admin. The Application Group: WLSSPI Admin window opens. All 
the WLSSPI Admin applications appear in this window. 

5 Select a node in the Node Bank window and double-click View Graphs to view the graphs.

The WebLogic SPI Metrics Available for Graphs

The tables that follow show the graphs available for mapping collected metric values. You can 
use the View Graphs application to view graphs of any of the metrics listed in the tables 
below. The graph will appear in your Web browser. 

Table 7 JVM

Metric Number and Name Metric Description

B005_JVMMemUtilPct Percentage of heap space used in the JVM. 

Table 8 Server Performance

Metric Number and Name Metric Description

B010_ExQueThruRate Number of requests serviced by an execute queue per second.

B011_ExQThrdUtilPct Percentage of threads in use for a server’s execute queue.

B012_ExQueWaitCnt The number of client requests waiting to be serviced 

B013_ SocketTrafficRt Number of socket connections opened per second.

B014_ActiveSocketCnt Number of socket connections opened.
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Table 9 Enterprise Java Beans (EJB)

Metric Number and Name Metric Description

B025_EJBPoolWtRtSum Number of times per minute that no EJB beans were 
available from the free pool.

B026_EJBTimeoutRtSum Number of times per minute a client timed out waiting for an 
EJB bean.

B035_EJBTranThruRt Number of EJB transactions per second.

B036_EJBTranRbRt Number of EJB transactions rolled back per second.

Table 10 JDBC

Metric Number and Name Metric Description

B061_JDBCConPlWtCnt Number of clients waiting for a connection from connection 
pools.

B063_JDBCConLkRtSum Number of unclosed JDBC connections and JDBC 
connections that have exceeded their maximum idle times in 
the connection pool per minute.

Table 11 Connector Service

Metric Number and Name Metric Description

B078_CnctrLeakRtSum Number of unclosed connector connections and connector 
connections that have exceeded their maximum idle times in 
the connection pool per minute.

Table 12 Transaction

Metric Number and Name Metric Description

B070_TranAveTime Average commit time for transactions.

B071_TranRollbackPct Percentage of transactions rolled back, based on the total.

B072_TranResErrRbPct Percentage of the transactions rolled back due to resource 
error.

B073_TranAppErrRbPct Percentage of transactions rolled back due to application 
error.

B074_TranTimErrRbPct Percentage of transactions rolled back due to a timeout error.

B075_TranSysErrRbPct Percentage of the transactions rolled back due to system 
error.

B076_TranThruRate Number of transactions processed per second.

B077_TranHeurCnt Percentage of transactions returning a heuristic decision.

B079_TranCapUtil Percentage utilization of transaction capacity.
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Table 13 Cluster

Metric Number and Name Metric Description

B080_ClsOutMesFailRt Number of multicast messages per minute to cluster re-sent.

B081_ClsInMesFailRt Number of multicast messages per minute from cluster lost 
by server.

Table 14 Security

Metric Number and Name Metric Description

B085_InvLoginAttCnt Number of invalid login attempts.

Table 15 WebLogic Time Service

Metric Number and Name Metric Description

B091_TimeSerThruRt Number of triggers executed per second.
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Launching the Web Page Display with an Operator Action that Generates 
Graphs

Performance Manager graphs can be generated from most WebLogic SPI alarm messages by 
clicking Perform Action from the message details, Properties, or the message browser. The 
operator action launches your Web browser, which displays a graph of the metric that 
generated the message, as well as other related metrics. 

Specifying a Date Range

Within the web page display, you can specify a date range of one day, one week, one month, or 
one year. See the online help for instructions on changing display settings.

Example Integration

The following is an example of how to graph multi-instance data stored in a data source by 
reporting each OBJECTNAME for the METRICID for each SERVERNAME. The result is all 
data for all instances are reported in one graph. The data for each SERVERNAME can also be 
displayed in a separate graph. 
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This example also uses the Java interface option of HP Performance Manager.

1 Start the Java Interface option of HP Performance Manager. The Performance Manager 
Java Interface window opens.

2 From the Performance Manager Java Interface window,

a Click the Display tab at the top of the window.

b In the Display pane click the Sources tab.

c Click  button next to the Datasource box and select a data source.

d Click  button next to the Default Selection box and select the node on which the 
data source resides.

3 Click the General tab at the right of the window. 
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4 From the General pane,

a Select line from the Type drop-down list. This generates a line graph.

b Enter a Date Range.

c Enter an interval using the Points Every drop-down list.

d Select Label (alphabetical) option for the Metric Display Order, if you want the graph 
key sorted alphabetically.
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5 Click the Metrics tab at the right of the window and click Add. The Metric Selection 
window opens. 

6 From the Metric Selection window,

a Click + to expand the WLSSPI_RPT_METRICS data source options tree.

b Select the VALUE checkbox.

c Click OK.
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7 In the window with the Metrics tab selected, VALUE is displayed. Select the line on which 
VALUE is displayed and click Properties. The Metric Properties window opens. 

8 From the Metric Properties window,

a In the Label box, enter: 

— @@SERVERNAME:@@OBJECTNAME if you are creating one graph with all 
SERVERNAMEs 

— @@OBJECTNAME if you are creating one graph with one SERVERNAME

b In the Marker drop-down list, select any marker other than none.

c In the Missing Data drop-down list, select:

— previous to use the previous value if data is missing from the data source

— zero to use the value zero if data is missing from the data source

d Click  next to the Filter box. The Metric Filter window opens.

9 From the Metric Filter window,

a Select METRICID from the first drop-down list.

b Select = from the second drop-down list (if it isn’t already selected).

c Enter a metric number (for example, 11) in the box.

d Click OK.

10 From the Metric Properties window,

a In the Filter box, append the following:
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— &&SERVERNAME=@&&OBJECTNAME=@@ if you want one graph to display all 
SERVERNAME/OBJECTNAME combinations.

— &&SERVERNAME= “<server_name>”&&OBJECTNAME=@ if you want one graph to 
display one SERVERNAME and all OBJECTNAMEs associated with the 
multi-instance metric.

If you cannot edit the Filter box, you can edit this item in the graph template file. See 
step 13 for more information.

b Click OK.

11 Click Save As at the top of the window. The Save As window opens.

12 From the Save As window,

a Enter a family (for example, WLSSPI_Graphs) in the Family box. The family name 
serves as a group to organize the graphs.

b Enter a name (for example, metric_11) in the Name box to uniquely identify the 
graph.

c Entering text into the Category box is optional. 

d Click OK. The information is saved in a graph template file named 
VPI_GraphsUser<family>.txt (for example, 
VPI_GraphsUserWLSSPI_Graphs.txt).

For more information about this window, see the online help.
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13 Edit the graph template file. The file is located in the HPOM data directory on the system 
of the HP Performance Manager instance on which you are working. The graph file might 
look similar to the following:

There can be more than one set of data for a graph in the graph template file.

a Add SUMFROMRAW: at the end of the first section of each graph (in the example above, 
add SUMFROMRAW: after SYSTEMNAME: moo1). This allows HP Performance Manager 
to summarized data from the data source and cannot be added using the GUI.

b If you were unable to edit the Filter box in the Metrics Properties window in , edit the 
FILTER field.

c Save the file. The graph file now contains the following:

#*********************************************

#* user Defined Graph Templates

#* Last Updated: 07/25/04 04:31_30 AM by [1.2.3.4] moo1

#**********************************************

FAMILY: WLSSPI_Graphs

GRAPH: Metric11

#* OpenView Performance Manager

GRAPHBACKGROUND: None
DATERANGE: 1 day
GRAPHMULTIPLEGRAPHS: Yes
POINTSEVERY: raw
DATASOURCE: mwa
SYSTEMNAME: moo1

CLASS: WLSSPI_RPT_METRICS:WLSSPI_RPT_METRICS
METRIC: VALUE
FILTER: METRICID=11&&SERVERNAME=@&&OBJECTNAME=@
LABEL: @@SERVERNAME:@@OBJECTNAME
COLOR: Auto
MARKER: rectangle
MISSINGDATA: previous
END_GRAPH:

#*---------------------------------------------------
GRAPH: Metric11_2
GRAPHBACKGROUND: None
DATERANGE: 1 day
GRAPHMULTIPLEGRAPHS: Yes
POINTSERVERY: raw
DATASOURCE: mwa
SYSTEMNAME: moo1

CLASS: WLSSPI_RPT_METRICS:WLSSPI_RPT_METRICS
METRIC: VALUE
FILTER: METRICID=11
LABEL: @@SERVERNAME:@@OBJECTNAME
COLOR:Auto
MARKER: rectangle
MISSINGDATA: previous
END_GRAPH:
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14 From the Performance Manager Java Interface window, click the Display tab.

#*********************************************

#* user Defined Graph Templates
#* Last Updated: 07/25/04 04:31_30 AM by [1.2.3.4] moo1
#**********************************************
FAMILY: WLSSPI_Graphs
GRAPH: Metric11

#* OpenView Performance Manager

GRAPHBACKGROUND: None
DATERANGE: 1 day
GRAPHMULTIPLEGRAPHS: Yes
POINTSEVERY: raw
DATASOURCE: mwa
SYSTEMNAME: moo1

CLASS: WLSSPI_RPT_METRICS:WLSSPI_RPT_METRICS
METRIC: VALUE
FILTER: METRICID=11&&SERVERNAME=@&&OBJECTNAME=@
LABEL: @@SERVERNAME:@@OBJECTNAME
COLOR: Auto
MARKER: rectangle
MISSINGDATA: previous
END_GRAPH:

#*---------------------------------------------------
GRAPH: Metric11_2
GRAPHBACKGROUND: None
DATERANGE: 1 day
GRAPHMULTIPLEGRAPHS: Yes
POINTSERVERY: raw
DATASOURCE: mwa
SYSTEMNAME: moo1

SUMFROMRAW:

END_GRAPH:
MISSINGDATA: previous
MARKER: rectangle
COLOR:Auto
LABEL: @@SERVERNAME:@@OBJECTNAME
FILTER: METRICID=11&&SERVERNAME=@&&OBJECTNAME=@
METRIC: VALUE
CLASS: WLSSPI_RPT_METRICS:WLSSPI_RPT_METRICS

SUMFROMRAW:
98 Chapter 5



15 In the Display tab window,

a Navigate to the server on which the data source resides (It is mentioned in the box 
below the Sources box).

b In the Graphs box, navigate to the family of graphs and select the graph you created.

c Enter information into the Date Range dialog box and Points Every box.

d Click Draw. The graph opens. See Figure 9.
Integrating HP Reporting and Graphing Products with the WebLogic SPI 99



Figure 9 Graph

16 From the SPI, enable graphing Follow these steps:

a From the HPOM console, open the Node Bank window and select a node or groups of 
nodes on which you want to enable graphing. 

b From the Window menu, select Application Bank. The Application Bank window 
opens.

c Select WLSSPI  WLSSPI Admin. 

d Double-click UDM Graph Enable.

If you edit the graph from the Design tab, the SUMFROMRAW: entry is deleted from the graph 
template file. You must edit the graph template file and re-enter this entry.
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6 Basic Troubleshooting and Error Messages
Using the Self-Healing Info Application

The Self-Healing Info application gathers SPI troubleshooting data and stores it in a file that 
you can submit to HP support for assistance. For more information about using this 
application, see Self-Healing Info on page 187.

The file created by the Self-Healing Info application might be hidden on some Windows 
managed nodes. If you do not see the file, open Windows Explorer and, from the Tools menu, 
select Folder Options. Click the View tab. Under Hidden files and folders, select Show hidden 
files and folders.
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Log and Trace Files

Management Server

The following log file is found on the management server (typically, /<%OvInstallDir%>/ is
/var/opt/OV)

UNIX Managed Nodes

The following log and trace files are found on the managed nodes running on UNIX (typically, 
/<OvAgentDir>/ is /var/opt/OV/ or /var/lpp/OV/):

File Type Log

Filename /<%OvInstallDir%>/log/wlsspi 
<managed_node>_disc_server.log

Description Records the updates done by the WLSSPI Discovery policy to the 
management server’s configuration for each managed node. Log files 
are overwritten each time the discovery policy is run on the managed 
node. Logging to this file is always enabled.

File Type Log

Filename /<OvAgentDir>/log/javaagent.log

Description HPOM discovery agent log file containing the status of the HPOM 
discovery agent. By default, logging to this file is enabled at 
LOG_LEVEL 3. Set the LOG_LEVEL variable in <OvAgentDir>/conf/
svcDisc/OvJavaAgent.cfg to 6 or higher (up to 9) to capture 
troubleshooting information (the higher the number, the more 
information is collected). To disable this log, set the LOG_LEVEL to 0. 
Additional information can be configured in this file to define log file 
size and the number of archived files kept. By default, the log file size 
is 1MB and five archived versions are kept.

File Type Log

Directory /<OvAgentDir>/log/wlsspi/config.log

Description Records output from the WebLogic SPI configuration scripts. 

File Type Log

Directory /<OvAgentDir>/log/wlsspi/errorlog

Description Records the WebLogic SPI error messages. This log file is monitored 
by the WebLogic SPI policies.
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File Type Log

Directory /<OvAgentDir>/log/wlsspi/wasspi_wls_discovery.log

Description Records output from the WebLogic SPI discovery process.

File Type Trace

Filename /<OvAgentDir>/log/wlsspi/wasspi_wls_discovery.trc 
(archived files have a three digit number appended to the filename)

Description Discovery binary trace file used by your HP support representative. 
By default, tracing to this file is enabled. To disable tracing, in 
<OvAgentDir>/bin/instrumentation/
wasspi_wls_discovery.pl, set the $trace_on variable to 0. To 
enable this trace, set the $trace_on to 1. When instrumentation is 
deployed, the wasspi_wls_discovery.pl file is overwritten 
(therefore, if you disable tracing, it becomes enabled when 
instrumentation is deployed). Five archived versions are kept. A new 
trace file is created when the discovery policy is run.

File Type Trace

Directory /<OvAgentDir>/log/wlsspi/trace.log (archived files have a 
three digit number appended to the filename)

Description Trace file used by your HP support representative. This file gives 
information about the CollectorServer, regardless of whether the 
Collector is set to PERSISTANT or TRANSIENT mode in the 
SPIConfig file. The default value of the Collector Mode is 
'PERSISTENT'.

By default, tracing to this file is disabled. To enable this tracing, use 
the Start Tracing application.

File Type Trace

Directory /<OvAgentDir>/log/wlsspi/traceCollectorClient.log 
(archived files have a three digit number appended to the filename)

Description Trace file used by your HP support representative. This file gives 
information about the CollectorClient when the Collector is set to 
'PERSISTENT' mode in the SPIConfig file. The default value of the 
Collector Mode is 'PERSISTENT'.

By default, tracing to this file is disabled. To enable this tracing, use 
the Start Tracing application.
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Windows Managed Nodes

The following log and trace files are found on the managed nodes running on Windows 
(typically, <OvAgentDir> is 
\Program Files\HP OpenView\Installed Packages\{790...}\): 

File Type Log

Filename \<OvAgentDir>\log\javaagent.log

Description HPOM discovery agent log file containing the status of the HPOM 
discovery agent. By default, logging to this file is enabled at LOG_LEVEL 
3. Set the LOG_LEVEL variable in 
<OvInstallDir>\conf\svcDisc\OvJavaAgent.cfg to 6 or higher 
(up to 9) to capture troubleshooting information (the higher the 
number, the more information is collected). To disable this log, set the 
LOG_LEVEL to 0. Additional information can be configured in this file 
to define log file size and the number of archived files kept. By default, 
the log file size is 1MB and five archived versions are kept.

File Type Log

Directory \<OvAgentDir> \wasspi\wls\log\config.log

Description Records output from configuration scripts.

File Type Log

Directory \<OvAgentDir> \wasspi\wls\log\errorlog

Description Records the WebLogic SPI error messages. This log file is monitored by 
the WebLogic SPI policies.

File Type Log

Directory \<OvAgentDir> \wasspi\wls\log\wasspi_wls_discovery.log

Description Records output from the WebLogic SPI discovery process.

File Type Trace

Filename \<OvAgentDir>\wasspi\wls\log\wasspi_wls_discovery.trc 
(archived files have a three digit number appended to the filename)

Description Discovery binary trace file used by your HP support representative. By 
default, tracing to this file is enabled. To disable tracing, in
\<%OvInstallDir%>\bin\instrumentation\
wasspi_wls_discovery.pl, set the $trace_on variable to 0. To 
enable this trace, set the $trace_on to 1. When instrumentation is 
deployed, the wasspi_wls_discovery.pl file is overwritten 
(therefore, if you disable tracing, it becomes enabled when 
instrumentation is deployed). Five archived versions are kept. A new 
trace file is created when the discovery policy is run.
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File Type Trace

Directory \<OvAgentDir> \wasspi\wls\log\trace.log (archived files have a 
three digit number appended to the filename)

Description Trace file used by your HP support representative. This file gives 
information about the CollectorServer, regardless of whether the 
Collector is set to PERSISTANT or TRANSIENT mode in the 
SPIConfig file. The default value of the Collector Mode is 
'PERSISTENT'.

By default, tracing to this file is disabled. To enable this tracing, use 
the Start Tracing application.

File Type Trace

Directory \<OvAgentDir>\wasspi\wls\log\traceCollectorClient.log 
(archived files have a three digit number appended to the filename)

Description Trace file used by your HP support representative. This file gives 
information about the CollectorClient when the Collector is set to 
'PERSISTENT' mode in the SPIConfig file. The default value of the 
Collector Mode is 'PERSISTENT'.

By default, tracing to this file is disabled. To enable this tracing, use 
the Start Tracing application.
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Troubleshooting the Discovery Process

Problem: The WLSSPI Discovery template does not automatically discover and update the 
WebLogic SPI configuration.

Solutions:

1 Check for errors in the message browser of the managed nodes not being discovered. 
Follow the instruction text of any error messages displayed.

2 Verify that a WebLogic application server is installed on the managed node. If an 
application server is not installed, install an application server, and complete the 
configuration tasks listed in Chapter 3, Configuring the WebLogic SPI.

3 Verify the WebLogic application server status. The application server must be running. 
See Task 1: Verify the Application Server Status on page 41 for more information.

4 Verify that the LOGIN and PASSWORD properties are set and that the WebLogic user 
configured has the correct permissions. See Chapter 3, Configuring the WebLogic SPI for 
more information.

5 On a Windows managed node, if the HKEY_LOCAL_MACHINE\\Software\\BEA 
Systems\\BEAHOMELIST registry key does not exist, configure it, create the 
file%SystemDrive%\BEA\beahomelist, or set the BEA_HOME_LIST property for that 
managed node.

6 Verify the Java home directory (see Verifying the Java Home Directory on page 107).

7 If you are running WebLogic Server 7.0 or WebLogic Server 7.0 SP1 and did not save the 
domain configuration file (for example, config.xml) in the default directory 
(<BEA_Home_Dir>/user_projects/<WebLogic_Domain_X>/, where 
<BEA_Home_Dir> is the directory that contains the registry.xml file), do one of the 
following:

• Manually set the server using the Configure WLSSPI application.

• Manually configure ADMIN_PORTS, the port number(s) of the WebLogic Admin 
server(s) listed in the domain configuration file, using the Configure WLSSPI 
application. The global LOGIN and PASSWORD must be set for the node on which 
these WebLogic Admin servers are running.

8 If you are running WebLogic Server 7.0 SP2 or higher and did not save the domain 
configuration file (for example, config.xml) in the default directory (<BEA_Home_Dir>/
user_projects/domains/<WebLogic_Domain_X>/, where <BEA_Home_Dir> is the 
directory that contains the registry.xml file), do one of the following:

• Manually set the server using the Configure WLSSPI application; or

• Manually set ADMIN_PORTS, the port number(s) of the WebLogic Admin server(s) 
listed in the domain configuration file, using the Configure WLSSPI application. The 
global LOGIN and PASSWORD must be set for the node on which these WebLogic 
Admin servers are running.

9 If you are running multiple versions of  WebLogic Server on the same system, set the 
HOME property.

10 On a UNIX managed node, verify that BEA_HOME_LIST and HOME_LIST directory 
path names do not include spaces. The discovery process currently does not support 
spaces in directory names.
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11 Verify that the Configure WLSSPI application is not running. Only one process can access 
the configuration at a time. If Configure WLSSPI is running, other processes that must 
access the configuration (like the discovery process) hang until the configuration becomes 
available.

12 Check if the HPOM management server is suppressing duplicate messages: 

a From the HPOM console, select Actions Server Configure. The Configure 
Management Server window opens.

b Look for the “Suppress and count duplicate messages” check box. If this box is 
selected, clear it.

13 Restart the HPOM management server:

a Stop all HPOM GUIs that are running by selecting File  Exit.

b Stop the HPOM management server processes. Enter: /opt/OV/bin/ovstop opc 
ovoacomm

c Delete all HPOM temporary files. All pending messages (messages not saved in the 
database) and all pending actions (automatic actions, operator-initiated actions, 
scheduled actions, and command broadcast) are lost. Enter: rm -f /var/opt/OV/
share/tmp/OpC/mgmt_sv/*

d Restart the HPOM management server process. Enter: /opt/OV/bin/OpC/opcsv 
-start/opt/OV/bin/OpC/opcsv -status

e Restart the HPOM GUI. Enter: opc

• Problem: The WLSSPI Discover template is adding inaccurate information to the 
configuration.

Solutions:

a Verify LOGIN and PASSWORD are correct. See Task 2: Configure a WebLogic Server 
User on page 41 for more information.

b Verify the Java home directory. See Verifying the Java Home Directory on page 107 for 
more information.

c Update the configuration and clear the AUTO_DISCOVER check box in the 
configuration editor to prevent the WLSSPI-Discover template from overwriting the 
configuration information.

Verifying the Java Home Directory

To successfully use the WLSSPI-Discover template, the Java home directory (on both a 
Windows and UNIX managed node) must be configured correctly.

Although the WLSSPI-Discover template searches for this information, if they cannot find 
this information or the information is not accurate, the WLSSPI-Discover template does not 
function completely.

On each managed node on which you want to run the WLSSPI-Discover template, verify one 
of the following (listed in the order of precedence used by the WLSSPI-Discover template):

• JAVA_HOME is correctly defined in the configuration. To edit or view the configuration, 
launch the Configure WLSSPI application (for steps see Configure WLSSPI on page 184):

a In the configuration editor, set the JAVA_HOME property. See The Configuration 
Editor on page 157 for more information about using the configuration editor.
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b Click Save to save the changes made to the configuration. Once you save your 
changes, you cannot automatically undo them.

c Click Finish or Next to save any changes and exit the editor.

If you click Next, the Confirm Operation window opens. Click OK.

d Launch the Discover WebLogic application on the managed nodes on which the 
JAVA_HOME property was added or edited. Running the Discover WebLogic 
application updates the service map.

• Java is installed in each of the BEA home directories (each directory listed in the file 
beahomelist).

• The JAVA_HOME system variable is correctly defined.

On a Windows managed node, follow these steps:

a From the Start menu, select Settings  Control Panel.

b Double-click System.

c Select the Advanced tab.

d Select Environment Variables...

e Scroll through the System variables list. Verify the JAVA_HOME value. If 
JAVA_HOME does not exist, it is not defined.

On a UNIX managed node, follow these steps:

a Type echo $JAVA_HOME

b Verify the output. If no output is returned, JAVA_HOME is not defined.

If you click Cancel in the Confirm Operation window, the changes made to the 
configuration remain in the configuration on the management server. To make the 
changes to the selected managed nodes’ configuration, you must select those nodes 
in the Node Bank window, launch the Discovery application, click Next in the 
configuration editor, and then click OK in the Confirm Operation window.
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Troubleshooting the Configuration

• Problem: The WebLogic SPI configuration does not have complete or accurate 
information for a WebLogic managed server.

Solution: Verify LOGIN and PASSWORD are correct. See Task 2: Configure a WebLogic 
Server User on page 41 for more information. This is the most common reason for 
incorrect information for a WebLogic managed server running on a remote node (not 
running on a HPOM managed node).

• Problem: The WLSSPI-Discover template overwrites the configuration with inaccurate 
information.

Solution: Update the configuration and clear the AUTO_DISCOVER check box in the 
configuration editor to prevent the WLSSPI discover template from overwriting the 
configuration information.

• Problem: The Server status is unknown (down) message appears in the message 
browser, but the server is running.

Solution: Check that you correctly set the PORT, PROTOCOL, and PASSPHRASE (if 
required) properties:

— Verify that PROTOCOL is set to one of two values: t3 (for non-SSL) or t3s (for SSL).

— If the application server is using SSL, verify that the PORT is set to a valid SSL port 
number and that PROTOCOL is set to t3s.

— If the application server is not using SSL, verify that the PORT is set to a valid 
non-SSL port number and that PROTOCOL is set to t3.

— If the keystore has a password defined, re-set the PASSPHRASE in case it has been 
typed wrong.
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Troubleshooting the Applications

• Problem: Configuration variable SERVER<n>_START_CMD missing for server "Default 
Server"

Solution: Before you can successfully launch the Start WebLogic application, you must 
set the START_CMD and USER properties. Set these properties using the Configure 
WLSSPI application. See Configure WLSSPI on page 184 for more information about this 
application.

• Problem: Configuration variable SERVER<n>_STOP_CMD missing for server "Default 
Server"

Solution: Before you can successfully launch the Stop WebLogic application, you must 
set the STOP_CMD and USER properties. Set these properties using the Configure 
WLSSPI application. See Configure WLSSPI on page 184 for more information about this 
application.

• Problem: When launched, the Verify application gives improper output.

Solution: Before you launch the Verify application ensure that you installed the latest 
version of Self-Healing Service (SHS) component (version 2.20) from the SPI DVD. If you 
upgrade the WebLogic SPI without the SPI DVD, you must upgrade the SHS component 
also. You can download the SHS component from
http://support.openview.hp.com/self_healing_downloads.jsp.

• Problem: When launched, the Self-Healing Info application gives improper output.

Solution: Ensure that you installed the latest version of Self-Healing Service (SHS) 
component (version 2.20) from the SPI DVD. If you upgraded the WebLogic SPI without 
the SPI DVD, you must upgrade the SHS component also. You can download the SHS 
component from
http://support.openview.hp.com/self_healing_downloads.jsp.

• Problem: Check WebLogic application shows a wrong status for a server instance or does 
not give any output.

Solution: If a server is up and running but Check WebLogic application returns the 
server status as NOT_RUNNING (or does not give any output), turn ON the monitoring 
for that particular server by using the Start Monitoring application.

• Problem: When launching the applications, the applications hang or there is no output.

Solution: The applications will not work if the memory is low. Check the performance of 
the node and the management server. The physical memory available must be more than 
500 MB.

• Problem: View WebLogic Log application lists duplicate (redundant) log file names.

Solution: This problem occurs if there are duplicate entries in the SiteConfig file. 
Relaunch the Configure WLSSPI application to remove the duplicate entries. 

• Problem: Datasource not getting created on RHEL 4.0 platform.

Solution: Ensure that you installed the latest version of DSI2DDF component 
(02.22.000) from the SPI DVD. If you upgraded the WebLogic SPI without the SPI DVD, 
you must upgrade the DSI2DDF component also. To get the latest DSI2DDF component 
contact HP Software Support.
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Error Messages

This section provides detailed information on error messages resulting from conditions 
detected in the operation of the Smart Plug-in for BEA WebLogic Server (WebLogic SPI) and 
not the WebLogic Server. These error messages belong to the WLSSPI Message Group.

In the following  figure, the last two messages are a result of errors in the operation of the 
WebLogic SPI. These errors are identified as belonging to the WLSSPI Message Group (see 
the MsgGroup column in the illustration below).

For any given problem, only the most recent error message is displayed (the older error 
message is automatically acknowledged). This reduces the number of error messages 
displayed in the message browser.

WASSPI-1

Description Unable to create the lock file <filename>. File already exists.

Severity Critical

Help Text Probable Cause
Temporary lock files are used to avoid collisions when multiple WebLogic SPI data collector 
processes attempt to access the same data file. This error occurs when the lock file could not 
be created after several attempts because it already exists.
Suggested Action
If a file by the same name already exists, it might not have been deleted by a previous run of 
the WebLogic SPI data collector. You should delete this file manually.
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WASSPI-2

WASSPI-3

Description Cannot access the SPI configuration.

Severity Critical

Help Text Probable Cause
A WebLogic SPI configuration file could not be located or accessed. Either they do not exist or 
there was a problem reading the files.
Suggested Action
1 Verify that the schedule template that runs the WebLogic SPI data collector specifies the 

correct directory on the command line. The option 
-Dwasspi.config.dir=<configDirectory> must be specified on command line invocation of 
the data collector. <configDirectory> must be /var/opt/OV/conf/wlsspi on Unix 
platforms or \usr\OV\wasspi\wls\conf on Windows platforms.

2 Verify that the WebLogic SPI was configured correctly by running the Verify utility from 
the Application Bank. If the configuration is not correct, run the WebLogic SPI 
configuration utility from the Application Bank to reinstall the files.

3 See the text following the error message in the WebLogic SPI error log to help identify the 
underlying cause of the problem, for example an I/O exception. You can view the SPI error 
log for a managed node by using the View Error File application in the Application Bank 
window. You can view the SPI error log for a managed node by using the 'View Error File' 
application in the Application Bank window. The error message can be identified by the 
date/time stamp.

Description Error parsing command line.

Severity Critical

Help Text Probable Cause
The WebLogic SPI data collector command line is incorrectly specified in a schedule template.
Suggested Action
1 See the text following the error message in the WebLogic SPI error log to help identify the 

data collector command line syntax error. You can view the SPI error log for a managed 
node by using the View Error File application in the Application Bank window. The error 
message can be identified by the date/time stamp.

2 If the error occurred in a schedule template that shipped with the WebLogic SPI, reinstall 
the SPI and run the WebLogic SPI configuration utility from the Application Bank.

3 If the error occurred in a schedule template not shipped with the WebLogic SPI, correct the 
schedule template that contains the incorrect command line. See the HP Operations Smart 
Plug-in for BEA WebLogic Server Configuration Guide for more information on the 
WebLogic SPI data collector command line.
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WASSPI-4

WASSPI-5

Description Error getting the metric definitions.

Severity Critical

Help Text Probable Cause
The WebLogic SPI data collector could not read the metric definitions XML document. This 
error can be caused by a missing configuration property, an I/O error, an XML parsing error, 
a missing file, or a corrupted serialized data file.
Suggested Action
1 See the text following the error message in the WebLogic SPI error log to help identify the 

underlying cause of the problem. You can view the SPI error log for a managed node by 
using the View Error File application in the Application Bank window. The error message 
can be identified by the date/time stamp.

2 If the METRIC_DEFINITIONS_FILE property is missing from the WebLogic SPI 
configuration file, reinstall the SPI and run the SPI configuration utility from the 
Application Bank.

3 If the problem is with the metric definitions file (MetricDefinitions.xml) that is shipped 
with the WebLogic SPI, reinstall the WebLogic SPI. Run the SPI configuration utility from 
the Application Bank.

4 If the problem is with a user-defined metric definitions file that is not shipped with the 
WebLogic SPI, verify that this XML file adheres to the MetricDefinitions.dtd specification. 
See the WebLogic SPI's User's Guide for more information on writing user-defined metrics. 
Reinstall your user-defined metric definition file. Run the SPI configuration utility and 
verify that the UDM_DEFINITIONS_FILE property in the SPI configuration file, is 
specified correctly.

5 If the underlying error is ClassNotFound, this is an internal error. Report this to HP 
support.

Description Error processing metric <metric_number>.

Severity Major

Help Text Probable Cause
An error occurred while trying to collect data or perform calculations for the specified metric. 
Suggested Action
See the text following the error message in the WebLogic SPI error log to help identify the 
underlying cause of the problem. The error messages previous to this one might also provide 
more information about the problem. You can view the SPI error log for a managed node by 
using the View Error File application in the Application Bank window. The error message can 
be identified by the date/time stamp.
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WASSPI-6

WASSPI-7

Description Required property <property_name> is missing from the WebLogic SPI configuration.

Severity Major

Help Text Probable Cause
The specified required property is missing from the WebLogic SPI configuration file. 
Suggested Action
1 Run the WebLogic SPI configuration utility from the Application Bank. Verify that you 

specified the correct server information for the WebLogic Servers on this managed node.
2 Verify the property is specified correctly in the WebLogic SPI configuration file /var/opt/

OV/wasspi/conf/wlsspi/SiteConfig on Unix platforms or \usr\OV/
wasspi\wls\conf\SiteConfig on Windows platforms on the managed node in 
question.

Description Unable to contact server <server_name> at url=<URL>, port=<port>.

Severity Critical

Help Text Probable Cause
The specified server is not running at the specified port.
Suggested Action
1 Run the WebLogic SPI configuration utility from the Application Bank. Verify that you 

specified the correct server name and port information for the WebLogic Servers on this 
managed node.

2 Verify that the properties, SERVERx_NAME and SERVERx_PORT, are specified correctly 
in the WebLogic SPI configuration file (/var/opt/OV/conf/wlsspi/SiteConfig on 
Unix platforms or \usr\OV\wasspi\wls\conf\SiteConfig on Windows platforms) on 
the managed node in question.

3 Verify that the WebLogic Server is running on the managed node.
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WASSPI-8

WASSPI-9

Description Error saving graphing or reporting data to file <file_name>.

Severity Critical

Help Text Probable Cause
If the error message specifies the reporting data file, the agent on the managed node might be 
in an inconsistent state.
Suggested Action
Restart the agent on the managed node.
Probable Cause
The specified graphing or reporting data file could not be found or an I/O error occurred when 
trying to access the file.
Suggested Action
1 See the text following the error message in the WebLogic SPI error log to help identify the 

underlying cause of the problem. You can view the SPI error log for a managed node by 
using the View Error File application in the Application Bank window. The error message 
can be identified by the date/time stamp.

2 Identify the steps to reproduce the problem.
3 Turn on tracing and reproduce the problem. See the HP Operations Smart Plug-in for BEA 

WebLogic Server Configuration Guide for instructions on how to turn on tracing.
4 Run the Gather Info application.
5 Contact HP support with the information gathered in the previous steps.

Description Unable to retrieve property <property_name>.

Severity Critical

Help Text Probable Cause
A required property is missing from one of the WebLogic SPI configuration files.
Suggested Action
1 See the text following the error message in the WebLogic SPI error log to help identify the 

missing property. You can view the SPI error log for a managed node by using the View 
Error File application in the Application Bank window. The error message can be 
identified by the date/time stamp.

2 Run the WebLogic SPI configuration utility from the Application Bank. Verify that you 
specified the correct  information for the WebLogic Servers on the managed node in 
question.

3 Verify that the missing property is now specified in the WebLogic SPI configuration file (/
var/opt/OV/conf/wlsspi/SiteConfig on Unix platforms or 
\usr\OV\wasspi\wls\conf\SiteConfig on Windows platforms) on the managed node 
in question.
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WASSPI-10

WASSPI-11

WASSPI-12

Description Encountered problem accessing file <filename>.

Severity Critical

Help Text Probable Cause
The specified file could not be found, created, or accessed. This file could be a temporary file. 
Suggested Action
1 See the text following the error message in the WebLogic SPI error log to help identify the 

file in question and the underlying cause of the problem. You can view the SPI error log for 
a managed node by using the View Error File application in the Application Bank window. 
The error message can be identified by the date/time stamp.

2 Verify that you have enough disk space to create temporary files.

Description No servers have been specified in the WebLogic SPI configuration file. 

Severity Major

Help Text Probable Cause
The number of WebLogic Servers specified in the WebLogic SPI configuration for the 
managed node in question is 0.
Suggested Action
1 Run the WebLogic SPI configuration utility from the Application Bank. Verify that you 

specified the correct server name and port information for the WebLogic Servers on this 
managed node.

2 Verify that the property, NUM_SERVERS, in the WebLogic SPI configuration file (/var/
opt/OV/conf/wlsspi/SiteConfig on Unix platforms or 
\usr\OV\wasspi\wls\conf\SiteConfig on Windows platforms) is set to the number of 
WebLogic Servers on this managed node.

Description Command <command> returned error exit code <exit code>.

Severity Critical

Help Text Probable Cause
A command started by the WebLogic SPI collector has returned an error (non-zero) exit code.
Suggested Action
1 Identify the steps to reproduce the problem.
2 Turn on tracing and  reproduce the problem. See the HP Operations Smart Plug-in for 

BEA WebLogic Server Configuration Guide for instructions on how to turn on tracing.
3 Run the Gather Info application.
4 Contact HP support with the information gathered in the previous steps.
116 Chapter 6



WASSPI-13

WASSPI-14

WASSPI-15

Description Exception occurred while running an opcmon process. 

Severity Critical

Help Text Probable Cause
The WebLogic SPI data collector attempted to run a process to execute an opcmon call. Either 
the process could not be created or was interrupted.
Suggested Action
For UNIX systems, make sure the kernel configurable parameters NPROC and MAXUPRC 
are set high enough to allow process creation.

Description Unable to find file <filename>. 

Severity Critical

Help Text Probable Cause
A file required by the WebLogic SPI data collector could not be found. 
Suggested Action
1 See the text following the error message in the WebLogic SPI error log to help identify the 

file in question and the underlying cause of the problem.You can view the SPI error log for 
a managed node by using the View Error File application in the Application Bank window. 
The error message can be identified by the date/time stamp.

2 Reinstall the WebLogic SPI on the managed node.
3 Run the WebLogic SPI configuration utility from the Application Bank.

Description Error parsing XML document <filename>. 

Severity Critical

Help Text Probable Cause
An error occurred while parsing the specified XML document. 
Suggested Action
1 See the text following the error message in the WebLogic SPI error log to help identify the 

underlying cause of the problem. You can view the SPI error log for a managed node by 
using the View Error File application in the Application Bank window. The error message 
can be identified by the date/time stamp.

2 If the XML document was provided by the user, correct the document. See the HP 
Operations Smart Plug-in for BEA WebLogic Server Configuration Guide for more 
information about the correct format for a user-defined metric definition document.

3 If the XML document is a document that is shipped with the WebLogic SPI, run the SPI 
configuration utility from the Application Bank to reinstall the WebLogic SPI 
configuration files.
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WASSPI-16

WASSPI-17

Description A bad filter was specified for metric <metric_number>. 

Severity Major

Help Text Probable Cause
A metric filter is incorrectly specified in the metric definitions XML document.
Suggested Action
1 If the metric is specified in an XML document that was provided by the user, correct the 

document. See the HP Operations Smart Plug-in for BEA WebLogic Server Configuration 
Guide for more information about the correct format for a user-defined metric definition 
document.

2 If the metric is a pre-defined metric that is shipped with the WebLogic SPI, run the SPI 
configuration utility from the Application Bank to reinstall the WebLogic SPI 
configuration files.

Description Could not access MBean server on server <server_name> at url=<URL>, 
port=<port_number>. 

Severity Critical

Help Text Probable Cause 
A problem occurred while the WebLogic SPI data collector was requesting access to the JMX 
MBean server on the WebLogic Server. This could be caused by:
1 The JNDI lookup to find the JMX MBean server in the application server failed.
2 The login name specified in the WebLogic SPI configuration does not have the correct 

permissions in the application server.
3 The password specified in the WebLogic SPI configuration file is incorrect.
Suggested Action
1 See the text following the error message in the WebLogic SPI error log to help identify the 

underlying cause of the problem. You can view the SPI error log for a managed node by 
using the View Error File application in the Application Bank window. The error message 
can be identified by the date/time stamp.

2 Run the WebLogic SPI configuration utility from the Application Bank. Verify that the 
login name and password are correct for the server in question.

3 In the WebLogic Administration Console, verify that the user is a valid WebLogic user and 
has the correct permissions. To set the correct permissions, see the HP Operations Smart 
Plug-in for BEA WebLogic Server Configuration Guide.

4 In the WebLogic Administration Console, verify that the MBean server 
(weblogic.management.home.<server_name>) is in the JNDI tree of the server in 
question. Right-click the server in the left pane to view the JNDI tree. If it is not there, 
restart the WebLogic Server.
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WASSPI-18

WASSPI-19

WASSPI-20

Description Error logging to datasource <datasource_class_name>. Logging process returned exit code 
<exit_code>.

Severity Warning

Help Text Probable Cause
The agent on the managed node might be in an inconsistent state.
Suggested Action
Restart the agent on the managed node.
Probable Cause
The ddflog process started by the WebLogic SPI data collector returned a non-zero error code.
Suggested Action
1 Identify the steps to reproduce the problem.
2 Turn on tracing and reproduce the problem. See the HP Operations Smart Plug-in for BEA 

WebLogic Server Configuration Guide Tracing for instructions on how to turn on tracing. 
3 Run the 'Gather Info' application.
4 Contact HP support with the information gathered in the previous steps.

Description Encountered problem instantiating XSLT transformer with <filename>. 

Severity Major

Help Text Probable Cause
The XSL document that specifies the auto action report output contains errors.
Suggested Action
1 Reinstall the WebLogic SPI.
2 Run the WebLogic SPI configuration utility from the Application Bank.

Description Encountered problem creating report for metric <metric_number>. 

Severity Major

Help Text Probable Cause
An error occurred while producing a text report for the specified metric.
Suggested Action
1 Reinstall the WebLogic SPI.
2 Run the WebLogic SPI configuration utility from the Application Bank.
Basic Troubleshooting and Error Messages 119



WASSPI-21

WASSPI-23

Description Encountered problem instantiating factory implementation '<class name>'.

Severity Critical

Help Text Probable Cause
The java property specifying the class name is incorrect or the class does not implement the 
AppServerFactory interface.
Suggested Action
Verify that the java property appserver.implementation is set to the fully qualified name of 
the class which implements the AppServerFactory interface. 
For example, if set on the java command-line:
-Dappserver.implementation=com.hp.openview.wasspi.WLSAppServerFactory

Description Error initializing collector analyzer for server <server_name>.

Severity Critical

Help Text Probable Cause 
An exception was encountered while preparing to monitor server <server_name>
Suggested Action 
1 See the text following the error message in the WebLogic SPI error log to help identify the 

underlying cause of the problem. You can view the SPI error log for a managed node by 
using the View Error File application in the Application Bank window. The error message 
can be identified by the date/time stamp.

2 Identify the steps to reproduce the problem.
3 Turn on tracing and  reproduce the problem. See the HP Operations Smart Plug-in for BEA 

WebLogic Server Configuration Guide for instructions on how to turn on tracing.
4 Run the Gather Info application.
5 Contact HP support with the information gathered in the previous steps.
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WASSPI-24

WASSPI-26

Description Error logging in to server <server_name> with login <login>.

Severity Critical

Help Text Probable Cause
A security exception occurred while logging in to server <server_name>.
Suggested Action
1 Run the WebLogic SPI configuration utility from the Application Bank.
2 Verify that you specified the correct login and password on the managed node on which the 

error occurred.
3 Verify the login has appropriate permissions.

Description The data logging process for <server_name> timed-out.

Severity Major

Help Text Probable Cause
Depending on your configuration, either HP Performance Agent or CODA failed to exit before 
the time-out.
Suggested Action
1 Restart CODA using the command opcagt -start.
2 Restart HP Performance Agent using the command mwa restart.
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WASSPI-27

WASSPI-30

WASSPI-31

WASSPI-32

Description RMI collector unable to process <command>.

Severity Warning

Help Text Probable Cause 
An exception was encountered while performing an rmid related operation.
Suggested Action 
1 See the text following the error message in the WebLogic SPI error log to help identify the 

underlying cause of the problem. You can view the SPI error log for a managed node by 
using the View Error File application in the Application Bank window. The error message 
can be identified by the date/time stamp.

2 Identify the steps to reproduce the problem.
3 Turn on tracing and  reproduce the problem. See the HP Operations Smart Plug-in for 

BEA WebLogic Server Configuration Guide for instructions on how to turn on tracing.
4 Run the Gather Info application.
5 Contact HP support with the information gathered in the previous steps.

Description Failed to start <rmid_path> on port <port>.

Severity Critical

Help Text Probable Cause
The specified path is already in use.
Suggested Action
Run the WebLogic SPI configuration utility from the Application Bank. Set the RMID_PORT 
property to a port number which is not currently in use.

Description Lost connection to RMI collector while processing <command>.

Severity Warning

Help Text N/A

Description Unable to retrieve metadata for mbean <JMX-ObjectName>.

Severity Warning

Help Text N/A
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WASSPI-33

WASSPI-34

WASSPI-35

WASSPI-36

Description No actions matched server <server name>, version <version>.

Severity Warning

Help Text Probable Cause 
JMXAction element(s) define FromVersion and ToVersion tags which do not match the server 
version.
Suggested Action 
If the action is valid on the server, either adjust the JMXAction definition's FromVersion/
ToVersion elements or the server's VERSION property. 

Description Metric <metric id> does not define any actions.

Severity Warning

Help Text Probable Cause 
The metric ID specified with the action -m option does not define a JMXActions element.
Suggested Action 
Correct the action -m option if an incorrect metric ID was specified. Otherwise, add a 
JMXActions definition to the metric definition. 

Description Error executing action <action command-line>.

Severity Major

Help Text Probable Cause 
An unexpected error occured while executing the action.
Suggested Action 
View the managed node's errorlog to determine the root cause which is logged following the 
error message. 

Description MBean <JMX objectname> on server <server name>, does not expose operation
<operation name>.

Severity Warning

Help Text Probable Cause
An action's JMXCalls element defines an operation not exposed by the specified MBean.
Suggested Action
Correct the JMXCalls element or remove the operation from the element.
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WASSPI-37

WASSPI-38

WASSPI-39

Description MBean <JMX objectname> on server <server name>, does not expose attribute 
<attribute name> for write.

Severity Warning

Help Text Probable Cause 
An action's JMXCalls element defines a write attribute exposed by the specified MBean as 
read-only.
Suggested Action 
If it is a custom MBean, update the MBean's management interface so the attribute is 
writable. Otherwise, remove the attribute definition from the JMXCalls element.

Description MBean <JMX objectname> on server <server name>, does not expose attribute 
<attribute name>.

Severity Warning

Help Text Probable Cause 
An action's JMXCalls element defines an attribute not exposed by the specified MBean 
ObjectName.
Suggested Action 
Correct the JMXCalls element or remove the attribute from the element. 

Description Error invoking operation <operation name> on MBean <JMX objectname>.

Severity Major

Help Text Probable Cause 
An unexpected error occurred while invoking an operation on the specified MBean. The 
managed resource might have thrown an exception.
Suggested Action 
View the managed node's errorlog to determine the root cause which is logged following the 
error message.
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WASSPI-40

WASSPI-41

WASSPI-42

Description Error setting attribute <attribute name> on MBean <JMX objectname>.

Severity Major

Help Text Probable Cause 
An unexpected error occurred while setting an attribute on the specified MBean. The 
managed resource might have thrown an exception.
Suggested Action 
View the managed node's errorlog to determine the root cause which is logged following the 
error message.

Description Error getting attribute <attribute name> from MBean <JMX objectname>.

Severity Major

Help Text Probable Cause 
An unexpected error occurred while getting an attribute from the specified MBean. The 
managed resource might have thrown an exception.
Suggested Action 
View the managed node's errorlog to determine the root cause which is logged following the 
error message.

Description Error running command <command>.

Severity Critical

Help Text Probable Cause 
A command started by the WebLogic SPI collector reported an error.
Suggested Action 
1 Identify the steps to reproduce the problem.
2 Turn on tracing and  reproduce the problem. See the HP Operations Smart Plug-in for 

BEA WebLogic Server Configuration Guide for instructions on how to turn on tracing.
3 Run the Gather Info application.
4 Contact HP support with the information gathered in the previous steps.
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WASSPI-43

WASSPI-201

WASSPI-202

Description Error publishing event <event-type>.

Severity Major

Help Text Probable Cause 
An unexpected error occurred while a publisher was handling a metric or collect event.
Suggested Action 
View the managed node's errorlog to determine the root cause which is logged following the 
error message.

Description File <filename> not found.

Severity Critical

Help Text Probable Cause 
A configuration file could not be found.
Suggested Action 
Run the WebLogic SPI configuration utility from the Application Bank. Verify that the correct  
information has been specified for the WebLogic Servers on the managed node on which the 
error occurred.

Description Cannot read file <filename>.

Severity Critical

Help Text Probable Cause
1 A file could not be opened or it could not be found.
2 Permissions might be incorrect or a directory might be corrupt.
Suggested Action
1 Run the WebLogic SPI configuration utility from the Application Bank. Verify that the 

correct  information has been specified for the WebLogic Servers on the managed node on 
which the error occurred.

2 Verify that the permissions are correct for the ITO user to read this file.
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WASSPI-203

WASSPI-204

Description Cannot write file <filename>.

Severity Critical

Help Text Probable Cause
Permissions might be incorrect, or a file or directory might be corrupt.
Suggested Action
1 Run the WebLogic SPI configuration utility from the Application Bank. Verify that the 

correct  information has been specified for the WebLogic Servers on the managed node on 
which the error occurred.

2 Verify that the permissions are correct for the ITO user to write this file.

Description Error sending opcmsg <message>.

Severity Critical

Help Text Probable Cause
There was a problem running opcmsg. opcmsg might be missing or not have permissions to 
execute (ITO installation errors) or the system process table might be full.
Suggested Action
1 Confirm that ITO is properly installed and deployed to the managed node. 

Ensure that the process table is not full. If it is, consider having the system administrator 
increase it.
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WASSPI-205

WASSPI-206

WASSPI-207

Description Error sending opcmon <command>.

Severity Critical

Help Text Probable Cause
There was a problem running opcmon. opcmon might be missing or not have permissions to 
execute (ITO installation errors) or the system process table might be full.
Suggested Action
1 Confirm that ITO is properly installed and deployed to the managed node.

Ensure that the process table is not full. If it is, consider having the system administrator 
increase it.

Description Cannot read directory <directory>.

Severity Critical

Help Text Probable Cause
The permissions on the directory prevent the ITO user from reading it or the directory is 
corrupt.
Suggested Action
Verify that the permissions are correct for the ITO user for this directory.

Description Cannot move <filename> to <filename>.

Severity Critical

Help Text Probable Cause
1 Insufficient permissions.
2 Insufficient disk space.
3 File table problems.
Suggested Action
1 Verify that the permissions are correct for the ITO user.
2 Verify that there is enough disk space to create files.
3 Run the WebLogic SPI configuration utility from the Application Bank. 
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WASSPI-208

WASSPI-209

WASSPI-210

Description WebLogic SPI must be configured before it can be used.

Severity Critical

Help Text Probable Cause
The WebLogic SPI has not been configured on this node.
Suggested Action
1 Run the WebLogic SPI configuration utility from the Application Bank. Verify that you 

specified the correct  information for the WebLogic Servers on the managed node on which 
the error occurred.

2 Run the Verify utility from the application band to confirm that the SPI has been 
successfully configured.

Description Cannot contact WebLogic Server.

Severity Critical

Help Text Probable Cause
1 The server could be down or not responding.
2 The WebLogic SPI might be configured incorrectly.
Suggested Action
1 Verify that the WebLogic Server is up and running properly.
2 Run the WebLogic SPI configuration utility from the Application Bank. Verify that you 

specified the correct  information for the WebLogic ServerWebLogic Servers on the 
managed node on which the error occurred.

Description Cannot configure the SPI.

Severity Critical

Help Text Probable Cause
The SPI configuration process failed.
Suggested Action
1 See the text following the error message in the WebLogic SPI error log to help identify the 

underlying cause of the problem. The error messages previous to this one will provide more 
information about the problem. You can view the SPI error log for a managed node by 
using the View Error File application in the Application Bank window. The error message 
can be identified by the date/time stamp.

2 Reinstall the WebLogic SPI and run the WebLogic SPI configuration utility from the 
Application Bank.
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WASSPI-211

WASSPI-212

WASSPI-213

Description Cannot create directory <directory>.

Severity Critical

Help Text Probable Cause
There are insufficient permissions for the ITO user to create the directory or there is 
insufficient disk space.
Suggested Action
Verify that the permissions are correct for the ITO user for this directory. Verify that there is 
enough disk space.

Description WLS-5 monitor running on this node but no WLS-5 servers configured

Severity Critical

Help Text Probable Cause
The ITO template for WebLogic 5 is assigned to a node but the SPI configuration does not 
indicate that any WebLogic 5 servers are located on this node.
Suggested Action
1 If there are no WebLogic 5 server located on this node, unassign the WebLogic 5 templates 

from this node and redeploy ITO to the managed node.
2 If there is a WebLogic 5 server located on this node, run the WebLogic SPI configuration 

utility from the Application Bank and specify the correct information in the configuration.

Description  Improper parameters to program <name>. Usage: <usage>.

Severity Critical

Help Text Probable Cause
The parameters to the program are incorrect.
Suggested Action
Correct the parameters.
130 Chapter 6



WASSPI-214

WASSPI-215

WASSPI-216

Description Cannot run program <program_name>.

Severity Critical

Help Text Probable Cause
The program failed to run. It might be missing, permissions might be incorrect, or the process 
table might be full.
Suggested Action
1 Verify that the file exists. If it is a SPI program and the file is missing, reinstall the 

WebLogic SPI and run the WebLogic SPI configuration utility from the Application Bank. 
2 Verify that the permissions are correct for the ITO user. 

Description A WebLogic Server was not found in <directory>.

Severity Critical

Help Text Probable Cause
The directory specified as WL_HOME in the WebLogic SPI configuration does not exist on the 
managed node.
Suggested Action
1 Verify that a WebLogic Server is installed on the managed node.
2 Run the WebLogic SPI configuration utility from the Application Bank. Verify that the 

correct information has been specified for WL_HOME on the managed node on which the 
error occurred.

Description Configuration variable <name> missing for server <server_name>.

Severity Critical

Help Text Probable Cause
A required SPI configuration property was not found.
Suggested Action
1 Run the WebLogic SPI configuration utility from the Application Bank. 
2 Verify that the correct information has been specified in the configuration for the managed 

node on which the error occurred. 
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WASSPI-218

WASSPI-219

Description  WebLogic monitoring has been turned OFF for <server_name>.

Severity Warning

Help Text Probable Cause
Collection has been turned off for the specified server.
Suggested Action
If desired, collection can be turned on by setting COLLECT = ON in the SiteConfig file in the 
WebLogic SPI configuration directory on the managed node. The configuration directory is 
/var/opt/OV/conf/wlsspi/ or /var/opt/OV/conf/wls/ on UNIX platforms or 
\usr\OV\wasspi\wls\conf\ on Windows platforms. 

Description WebLogic monitoring has been turned ON for <server_name>.

Severity Warning

Help Text Probable Cause
Collection has been turned on for the specified server.
Suggested Action
If desired, collection can be turned off by setting COLLECT = OFF in the SiteConfig file in 
the WebLogic SPI configuration directory on the managed node. The configuration directory is 
/var/opt/OV/conf/wlsspi or /var/opt/OV/conf/wls/ on UNIX platforms or 
\usr\OV\wasspi\wls\conf\ on Windows platforms.
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WASSPI-220

WASSPI-221

WASSPI-222

Description This feature only applies to WebLogic 5.1.

Severity Warning

Help Text Probable Cause
User attempted to perform a function on a WebLogic 6 server that only applies to WebLogic 5 
servers.
Suggested Action
This function can only be performed on a WebLogic Server version 6.0 and above.

Description <filename> does not exist.

Severity Critical

Help Text Probable Cause
The specified file does not exist. If it is a log file, no entries have ever been logged to it. If it is 
a property file, it has not been configured.
Suggested Action
• Log files– If there have never been any entries written to the file, no action is necessary. 

Otherwise, run the WebLogic SPI configuration utility from the Application Bank.
• Property files– Run the WebLogic SPI configuration utility from the Application Bank. 

Description <filename> is empty.

Severity Critical

Help Text Probable Cause
The specified file is empty. If it is a log file, no entries have ever been logged to it, or the 
entries have been cleaned out. If it is a property file, it is not properly configured.
Suggested Action
If the file is a configuration file, run the WebLogic SPI configuration utility from the 
Application Bank.
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WASSPI-223

WASSPI-224

WASSPI-225

Description Cannot read <filename>.

Severity Critical

Help Text Probable Cause
1 A file could not be opened or it could not be found.
2 Permissions might be incorrect or a directory might be corrupt.
Suggested Action
1 Run the WebLogic SPI configuration utility from the Application Bank. Verify that you 

specified the correct  information for the WebLogic Servers on the managed node on which 
the error occurred.

2 Verify that the permissions are correct for the ITO user to read this file.

Description ddfcomp returned an error configuring <name>.

Severity Warning

Help Text Probable Cause
ddfcomp returned an error.  This could be because neither MeasureWare nor CODA is 
installed on the system or because an error occurred while configuring the performance agent.
Suggested Action
1 If the performance agent is not installed, this error can be ignored.
2 Otherwise, identify the steps to reproduce the problem.
3 Turn on tracing and  reproduce the problem. See the HP Operations Smart Plug-in for 

BEA WebLogic Server Configuration Guide for instructions on how to turn on tracing.
4 Run the Gather Info application.
5 Contact HP support with the information gathered in the previous steps. 

Description No logfiles were found. Did you run Configure WLSSPI?

Severity Critical

Help Text Probable Cause
The logfile list is empty.
Suggested Action
Reinstall the SPI and run the WebLogic SPI configuration utility from the Application Bank. 
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WASSPI-226

WASSPI-227

WASSPI-228

Description Cannot read file <filename>.

Severity Critical

Help Text Probable Cause
1 A file could not be opened or it could not be found.
2 Permissions might be incorrect or a directory might be corrupt.
Suggested Action
1 Run the WebLogic SPI configuration utility from the Application Bank.
2 Verify that you specified the correct information for the WebLogic Servers on the managed 

node on which the error occurred.
3 Verify that the permissions are correct for the ITO user to read this file.

Description No performance agent is installed. Data source will not be configured.

Severity Warning

Help Text Probable Cause
If a performance product is available, the SPI will integrate with it. This warning indicates 
that none is available.
Suggested Action
If you must have a performance agent installed, verify that it is installed correctly and is 
running; reinstall it if necessary.  Otherwise, this message can be ignored.

Description ddflog returned an error logging <logfile-name>: <system-error-msg>

Severity Critical

Help Text Probable Cause
The agent on the managed node might be in an inconsistent state.
Suggested Action
Restart the agent on the managed node.
Probable Cause
 ddflog returned an error.  This could be because the SPI was not properly configured to 
support logging performance data.
Suggested Action
1 Try reconfiguring WebLogic SPI on the node having the problem.
2 Otherwise, examine the system error message, if any, for clues to the problem.
3 Turn on tracing and  reproduce the problem. See the HP Operations Smart Plug-in for 

BEA WebLogic Server Configuration Guide for instructions on how to turn on tracing.
4 Run the Gather Info application.
5 Contact HP support with the information gathered in the previous steps.
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WASSPI-229

WASSPI-230

WASSPI-231

Description Cannot connect to directory <directory_name>

Severity Critical

Help Text Probable Cause
The directory does not exist or the user, the agent is running under, does not have appropriate 
permissions to the directory.
Suggested Action
1 Run the WebLogic SPI configuration utility from the Application Bank.
2 Reinstall the SPI and run the WebLogic SPI configuration.

Description Cannot get lock <filename> after <time-interval>

Severity Critical

Help Text Probable Cause
The lock file <file> was not cleared in the <time> indicated. This could be due to a very slow 
running or hung SPI process. Also could be a SPI process that had a lock was killed before the 
lock it had open had been cleared.
Suggested Action
Make sure no SPI processes are running.  Manually remove the lock file.

Description Error starting JRE <JVM_file>: <message>

Severity Critical

Help Text Probable Cause
Some error occurred starting Java.  This could be that the specified JVM does not exist, has 
bad permissions, or that there are system resource limitations such as process table entries or 
memory, or that the JAVA_HOME variable in the SPI SiteConfig file is not set correctly.
Suggested Action
Check your JAVA_HOME or HOME variables in the SPI configuration file. Check for other 
errors generated at the same time. They might indicate the real cause.
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WASSPI-232

WASSPI-233

WASSPI-234 

Description Server <name> specified on command line, but not in configuration.

Severity Critical

Help Text Probable Cause
There was a -i or -e specified on the collector command line which specified a server name 
that was not listed in the SPI configuration file. The collector only knows about servers listed 
in the configuration file.
Suggested Action
1 Specify a correct server name on the command line. 
2 Run the WebLogic SPI configuration utility from the Application Bank. Verify the 

WebLogic Server names are correctly listed and spelled in the SPI configuration file.

Description Cannot get advanced monitoring for WLS 5.x server <name>

Severity Critical

Help Text Probable Cause
An attempt was made to get metrics from a WebLogic Server version 5 instance. Metrics and 
advanced monitoring are not supported with WLS version 5.
Suggested Action
1 Do not specify a WLS version 5 server on the command line of wasspi_wls_ca.
2 Run the WebLogic SPI configuration utility from the Application Bank. Verify that you 

specified the correct server versions.
3 Upgrade WebLogic Server to version 6.0 or greater.

Description Error running program <file>, return value: <n>

Severity Critical

Help Text Probable Cause
The SPI attempted to run some tool or auxiliary program and encountered an error doing so. 
The tool or program is shown in the message as <file> and the return code from attempting to 
run it is shown as <n>.
Suggested Action
If the tool is a SPI tool, make sure the SPI has been installed and configured correctly. If not, 
reinstall or reconfigure. If it is a system tool, make sure there are no system problems that 
prevent the tool from running.
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WASSPI-235 

WASSPI-236 

WASSPI-237 

WASSPI-238 

Description Restart of MeasureWare agent failed

Severity Warning

Help Text Probable Cause
The SPI attempted to automatically restart the MeasureWare agents and the automatic 
attempt failed.
Suggested Action
Restart the MeasureWare agents manually with the mwa restart server command.

Description Failure when running XSLT on <xml> with stylesheet <xsl>: <message>

Severity Critical

Help Text Probable Cause
As part of setting up graphing for user defined metrics, a translation of the UDM XML is 
done. This message indicated that translation failed for some reason.
Suggested Action
Review the message shown. It is most likely that there is an error in the XML.

Description Setting up Data Source <datasource>

Severity Normal

Help Text This is an informational message that indicates that a HP Performance Manager or HP 
Performance Agent datasource was set up.

Description No User Defined Metrics found

Severity Warning

Help Text Probable Cause
The UDM Graph Enable application was run, but no UDM metrics had been defined.
Suggested Action
Check that the UDM XML file has been named correctly.
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WASSPI-241 

WASSPI-244

WASSPI-245

Description Cannot delete file <file>

Severity Critical

Help Text Probable Cause
The SPI attempted to delete a file, but was unable to do so. It might be that the protection of 
the file is set so that the ITO user cannot delete it, or that there is some system problem 
preventing the file from being deleted.
Suggested Action
Make sure the protection of the file is correct.

Description Configuration for node <node> is invalid

Severity Critical

Help Text Probable Cause
The configuration for the node is not in the expected format.
Suggested Action
Launch the WLSSPI Discover Application from the HP Operations Manager console and 
select the node from the list. Verify that the properties configured for the node is valid. 
Re-initiate the Discovery process by selecting the OK button on the Confirm Operation 
window.

Description Unrecognized variable <var> is configured for node <node>

Severity Critical

Help Text Probable Cause
An unexpected variable was configured for the node.
Suggested Action
Launch the Discover WebLogic Application from the HP Operations Manager console and 
select the node from the list.  Look for the variable <var> included in the message and make 
sure that it is valid. Re-initiate the Discovery process by selecting the OK button on the 
'Confirm Operation' window.
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WASSPI-247

WASSPI-248

WASSPI-249

Description Failed to update the <product> configuration for node <node> in HPOM server.

Severity Critical

Help Text Probable Cause
The configuration for the node is not in the expected format.
Suggested Action
Launch the Discover WebLogic Application from the HP Operations Manager console and 
select the node from the list. Verify that the properties configured for the node is valid.  
Re-initiate the Discovery process by selecting the OK button on the Confirm Operation 
window.
If the problem still persists, call HP Support and provide the support representative with the 
following:
1 The steps and other information on reproducing the problem.
2 The trace files which are located in 

%OvInstallDir%\install\WASSPI\WLSSPI\English\Discovery\log directory

Description Cannot deploy <policy> policy group to <node>

Severity Warning

Help Text Suggested Action
Please see the section Deployment Troubleshooting in the HP Operations Manager for 
Windows online help. If the problem still persists, call HP Support.

Description Cannot get the agent installation directory for <node>

Severity Critical

Help Text Suggested Action
Redeploy the WLSSPI discovery policy on the managed node. Make sure to uncheck the 
Deploy policy only if version is newer checkbox if selected.
If the problem still persists, call HP Support and provide the support representative with the 
following:
1 The steps and other information on reproducing the problem
2 The trace files which are located in
%OvInstallDir%\install\WASSPI\WLSSPI\English\Discovery\log directory
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WASSPI-254

WASSPI-302 

WASSPI-303 

Description Java exited with an error

Severity Critical

Help Text Probable Cause
While running the collector or other java application, either Java encountered an error of 
some kind, or the Java application exited with an error exit.
Suggested Action
Check for other errors generated at the same time, they might indicate the real cause.
Review the SPI's error log, it might give some other clues.

Description Updating WebLogic SPI configuration in HPOM server

Help Text This is a normal operation performed by the WebLogic discovery process. If the operation is 
successful, the entry in the "A" (Action) column for this message should change from R 
(running) to S (success).
However, if the entry in this column changes to F (fail), the operation was not completed 
successfully. Select this node and launch the Discover WebLogic application again.
If problem persists, see the HP Operations Smart Plug-in for BEA WebLogic Server 
Configuration Guide. The chapter called Configuring the WebLogic SPI provides instructions 
on how to to manually configure the WebLogic SPI.

Description Updated WebLogic SPI configuration in HPOM server

Help Text WebLogic discovery has discovered some WebLogic Servers on the managed node. It has 
updated the WebLogic SPI configuration in the HPOM server.
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WASSPI-304 

Description No WebLogic Servers were found

Help Text Probable Cause: WebLogic Server was not installed on the node.
Suggested Action: Verify that WebLogic Server is not installed on the node. 

Probable Cause: There are no WebLogic Servers running in this node.
Suggested Action: Make sure that all the WebLogic Servers you want this SPI to monitor 
are up and running before the Discover WebLogic application is run on this node. Only those 
servers that are running when the Discover WebLogic runs will be automatically configured.
You can verify that a WebLogic Server is running by checking its status from its WebLogic 
administrator console. After starting the WebLogic Servers, launch the Discover WebLogic 
application again. Make sure to select this node before the application is launched. 

Probable Cause: Discovery needs some more information to find all the WebLogic Servers 
running on this node.
Suggested Action: Configure the following properties for this node using the Configure 
WLSSPI application. Make sure to select this node before launching the application.
• JAVA_HOME– The java installation directory used by the WebLogic Servers running on 

this node. If there are more than one WebLogic installation, select one java installation. 
For example, JAVA_HOME=/opt/bea/jdk1.3.1

• HOME_LIST– A list seperated by semicolon, containing the installation directories of all 
the WebLogic Servers in this node. For example, HOME_LIST=/opt/weblogic6.1;/opt/
weblogic7
Verify you enter the correct values. For example, if HOME_LIST=<home_dir1>;<home_dir2> 
and <home_dir1> is a WebLogic 7 or 8 home, verify that the file <home_dir1>/server/
lib/weblogic.jar exists.

• ADMIN_PORTS– A list, seperated by semicolons, containing the ports where the WebLogic 
Admin servers are listening. If the WebLogic Server is listening on a virtual IP address, the 
address should also be specified as shown below. For example : 
ADMIN_PORTS=15.8.155.197:7001;7045 where 15.8.155.197 is the virtual IP address on 
w hich the server is listening.

• LOGIN=<weblogic_user_id> and PASSWORD=<weblogic_user_password>– In this 
instance, <weblogic_user_id> is the WebLogic user you want this SPI to use for monitoring 
the server and <weblogic_user_password> is the password for that user.
Note: If there is more than one WebLogic admin server on this node and if they do not 
share the same login and password, set the LOGIN and PASSWORD to the most 
commonly used WebLogic login and password in the Set Access Info for Default Properties 
window. Select Customize to start the configuration editor and set the LOGIN, 
PASSWORD, NAME and PORT properties at the server-specific level, where NAME is the 
name of the WebLogic admin server and PORT is where this admin server is listening.

Select the node and launch the Discover WebLogic application.
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WASSPI-321 

Help Text 
(cont.)

Probable Cause: An incorrect value was entered for LOGIN, PASSWORD, NAME, 
HOME_LIST or ADMIN_PORTS.
Suggested Action: From the HPOM console, select the node and launch the Configure 
WLSSPI application. Verify that the login and password are correct. Verify that the values 
assigned to HOME_LIST is correct.
For example, if <home_dir1> is a WebLogic 7 or 8 home, verify that the file 
<home_dir1>/server/lib/weblogic.jar exists.
Verify that the ports given in the ADMIN_PORTS property are those of WebLogic admin 
server's and they are running. Select the node and launch the Discover WebLogic application. 

If problem persists, refer the HP Operations Smart Plug-in for BEA WebLogic Server 
Configuration Guide. The chapter called "Configuring the WebLogic SPI" provides 
instructions on how to manually configure the WebLogic SPI.
If manual configuration fails, follow these steps:
1 Select the node and launch the Gather Info Info application from the WLSSPI Admin 

application group
2 Contact your HP representative for assistance.

Description Invalid BEA home directory: <directory>

Help Text Probable Cause
The BEA_HOME_LIST property was set for the node and the directory (which appears in the 
message) is not a valid BEA home directory.
Suggested Action
Select the node and launch the Configure WLSSPI application.
Verify that BEA_HOME_LIST is set for the node and it contains the directory which was 
found to be invalid by discovery.
On the managed node, verify that the directory exists and it contains the flicense.bea and 
registry.xml files.
If the directory does not exist or does not contain the mentioned files, find the correct BEA 
home directories in the managed node and use the Configure WLSSPI application to correct 
the value set for the BEA_HOME_LIST property.
Select the managed node and launch the Discover WebLogic application.
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WASSPI-322 

Description Could not find BEA home directory: <directory> 

Help Text Probable Cause
The BEA_HOME_LIST property was set for the node and the directory (which appears in the 
message) does not exist. 
Suggested Action
Select the node and launch the Configure WLSSPI application.
Verify that BEA_HOME_LIST is set for the node and it contains the directory which was 
found to be invalid by discovery.
On the managed node, verify that the directory exists and it contains the flicense.bea and 
registry.xml files.
If the directory does not exist or does not contain the mentioned files, find the correct BEA 
home directories in the managed node and use the Configure WLSSPI application to correct 
the value set for the BEA_HOME_LIST property.
Select the managed node and launch the Discover WebLogic application.
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WASSPI-323 

Description Could not find BEA home directories

Help Text Probable Cause
The list of BEA home directories was not found. WebLogic Server was not installed on the 
node.
Suggested Action
Verify that WebLogic Server is not installed on the node. 

Probable Cause
The WebLogic discovery script did not find the BEA home directories on the node.
Suggested Action
Configure the following properties for this node using the Configure WLSSPI application. 
Make sure to select the node before launching the application.
• JAVA_HOME– The java installation directory used by the WebLogic Servers running on 

this node. If there are more than one WebLogic installation, select one java installation. 
For example, JAVA_HOME=/opt/bea/jdk1.3.1

• HOME_LIST– A list seperated by semicolon, containing the installation directories of all 
the WebLogic Servers in this node. For example, HOME_LIST=/opt/weblogic7;/opt/
weblogic7
Verify you enter the correct values. For example, if <home_dir1> is a WebLogic 7 or 8 home, 
verify that the file <home_dir1>/server/lib/weblogic.jar exists.

• ADMIN_PORTS– A list, seperated by semicolons, containing the ports where the 
WebLogic Admin servers are listening. If the WebLogic Server is listening on a virtual IP 
address, the address should also be specified as shown below. For example : 
ADMIN_PORTS=15.8.155.197:7001;7045 where 15.8.155.197 is the virtual IP address on 
w hich the server is listening.

• LOGIN=<weblogic_user_id> and PASSWORD=<weblogic_user_password>– In this 
instance, <weblogic_user_id> is the WebLogic user you want this SPI to use for monitoring 
the server and <weblogic_user_password> is the password for that user.
Note: If there is more than one WebLogic admin server on this node and if they do not 
share the same login and password, set the LOGIN and PASSWORD to the most 
commonly used WebLogic login and password in the Set Access Info for Default Properties 
window. Select Customize to start the configuration editor and set the LOGIN, 
PASSWORD, NAME and PORT properties at the server-specific level, where NAME is the 
name of the WebLogic admin server and PORT is where this admin server is listening.

Select the node and launch the Discover WebLogic application.
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WASSPI-324 

WASSPI-325 

Description Could not read WebLogic registry file <filename>

Help Text Probable Cause
The WebLogic registry file does not exist.
Suggested Actions
On the node, check if the file exists. If the file does not exist, the file was manually deleted. 
The registry.xml file is created by the WebLogic installation in the BEA home directory 
and should not be deleted. See the WebLogic installation document for more information 
about this file.

Probable Cause
The directory which contains the file is one of the values assigned to the BEA_HOME_LIST 
property for the node and is not a BEA home directory.
Suggested Action
Select the node and launch the Configure WLSSPI application.    
Verify that the BEA_HOME_LIST is configured for the node and its value includes the 
directory containing the registry file. Verify that the directory exists in the node and it 
contains the license.bea and registry.xml files.
If the directory does not exist or does not contain the files, find the correct BEA home 
directories in the node. Use the Configure WLSSPI application to correct the value specified 
for the BEA_HOME_LIST property.
Select the node and launch the Discover WebLogic application.

Description Security access failure. The LOGIN property is missing for WebLogic Server <server> on port 
<port_number>

Help Text Probable Cause
The LOGIN property was not set for a WebLogic Server
Suggested Action
1 If a WebLogic user is not already configured for this server, using the WebLogic 

administrator console, create a user that you want this SPI to use for monitoring this 
server.

2 Select the node and launch the Configure WLSSPI application. Set the correct LOGIN/
PASSWORD properties for this server (overwrite the existing encrypted data).

3 Select the node and launch the Discover WebLogic application.
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WASSPI-326 

WASSPI-327 

WASSPI-328 

Description Security access failure. The PASSWORD property is missing for WebLogic Server <server> on 
port <port_number>

Help Text Probable Cause
The PASSWORD property was not set for the WebLogic Server.
Suggested Action
1 If a WebLogic user is not already configured for this server, using the WebLogic 

administrator console, create a user that you want this SPI to use for monitoring this 
server.

2 Select the node and launch the Configure WLSSPI application. Set the correct LOGIN/
PASSWORD properties for this server (overwrite the existing encrypted data).

3 Select the node and launch the Discover WebLogic application.

Description Security access failure. The LOGIN and PASSWORD properties are missing for WebLogic 
Server <server> on port <port_number>

Help Text Probable Cause
The LOGIN and PASSWORD properties were not set for a WebLogic Server.
Suggested Action
1 If a WebLogic user is not already configured for this server, using the WebLogic 

administrator console, create a user that you want this SPI to use for monitoring this 
server.

2 Select the node and launch the Configure WLSSPI application. Set the correct LOGIN/
PASSWORD properties for this server (overwrite the existing encrypted data).

3 Select the node and launch the Discover WebLogic application.

Description Security access failure. Invalid LOGIN and/or PASSWORD for WebLogic Server <server> on 
port <port_number>

Help Text Probable Cause
An invalid LOGIN and/or PASSWORD was set for a WebLogic Server.
Suggested Action
1 If a WebLogic user is not already configured for this server, using the WebLogic 

administrator console, create a user that you want this SPI to use for monitoring this 
server.

2 Select the node and launch the Configure WLSSPI application. Set the correct LOGIN/
PASSWORD properties for this server (overwrite the existing encrypted data).

3 Select the node and launch the Discover WebLogic application.
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WASSPI-329 

WASSPI-330 

WASSPI-381 

Description A global login and password is required when ADMIN_PORTS property is configured

Help Text Probable Cause
The ADMIN_PORTS property was set but a global LOGIN and/or PASSWORD property was 
not set for a managed node.
Suggested Action
1 From the HPOM console, use the Configure WLSSPI application to view the value 

assigned to the ADMIN_PORTS property.
2 From the WebLogic administrator console, create a WebLogic user (if it does not already 

exist) that you want the WebLogic SPI to use for monitoring the server.
3 From the HPOM console, use the Configure WLSSPI application to set the LOGIN and 

PASSWORD properties for the node.
Note: If the ADMIN_PORTS property contains the ports of more than one WebLogic 
administrator server, verify that the same user ID is configured for those WebLogic 
administrator servers. If this is not possible, you must manually set the NAME, PORT, 
LOGIN, and PASSWORD properties for the administrator server.

4 Select the node and launch the Discover WebLogic application.

Description A global login and/or passwod is not configured

Help Text Probable Cause
The global LOGIN and PASSWORD property was not set. A global login and password is not 
required if the login and password for individual WebLogic admin servers was configured. But 
if all the WebLogic admin servers share the same login and password, you might set the global 
LOGIN and PASSWORD properties as follows:
Suggested Action
1 From the HPOM console, use the Configure WLSSPI application to add the LOGIN and 

PASSWORD properties for the node if it does not already exist.
2 Select the node and launch the Discover WebLogic application.

Description Could not find WebLogic SPI instrumentation

Help Text Probable Cause
WebLogic Discovery could not find some files that it needs to function correctly.
Suggested Action
Distribute actions, commands and monitors to the node.
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WASSPI-402 

WASSPI-403 

WASSPI-404 

Description Could not get local host

Help Text Probable Cause
Could not find the host name of the managed node because the IP address for the host could 
not be found or there was a security violation.
Suggested Action
Contact your system administrator.

Description Could not find WebLogic java installation

Help Text Probable Cause
The Java installation directory was manually deleted from each of the BEA home directories 
in the managed node or it was never installed by the WebLogic installation script.
Suggested Action
1 Find the Java installation used by the WebLogic Server running on the node.
2 Select the node and launch the Configure WLSSPI application. Add the JAVA_HOME 

property for that node. 
3 Select the node and launch the Discover WebLogic application.

Description Could not find weblogic.jar file

Help Text Probable Cause
WebLogic Server was not installed on the node.
Suggested Action
Verify that WebLogic Server is installed on the managed node.

Probable Cause
Discovery could not find the installation directory foWebLogic Server.
Suggested Action
1 From the HPOM console, select the node and launch the Configure WLSSPI application. 

Set the HOME_LIST property for this node.
2 Select the node and launch the Discover WebLogic application.
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WASSPI-405 

Description An error occured while reading SiteConfig file

Help Text Probable Cause
Permissions might be incorrect or a file or directory might be corrupt.
Suggested Action
1 Verify that the permissions are correct for the HP Operations agent user to write to the file 

%OvAgentDir%/conf/wlsspi/SiteConfig. Contact your system administrator to 
correct this.

2 Select the node and launch the Discover WebLogic application.
3 If the problem still persists, launch the Gather Info application and call HP Support. 

Provide the support representative with the following:
— The steps and other information on reproducing the problem.
— The file generated by the Gather Info application.
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WASSPI-406 

Description Retrieve WLSSPI configuratin for node timed out

Help Text Probable Cause
Communication failed between the management server and managed node.
Suggested Action
Select the node and launch the Discover WebLogic application. If it fails, contact your system 
administrator.

Probable Cause
It took more than 2 minutes for the WLSSPI configuration to reach the managed node from 
the management server.
Suggested Action
Select the node and launch the  Discover WebLogic application.

Probable Cause
The Configure WLSSPI application was being executed when WebLogic discovery was run on 
the node.
Suggested Action
Make sure that the Configure WLSSPI application is not running on the management server. 
Select the node and launch the Discover WebLogic Discovery application. 

Probable Cause
The discovery script in the management server failed.
Suggested Action
On the management server, open the trace file: 
%OvInstallDir%/install/WASSPI/WLSSPI/English/Discovery/log.

The trace file is <node_name>_disc_server.log where <node_name> is the primary node 
name of the managed node. If any error messages are reported in the trace file, follow these 
steps:
1 Select the node and launch the Gather Info application from the WLSSPI Admin 

application group.
2 Call HP Support and provide the support representative with the following:

— The steps and other information on reproducing the problem
— The file generated by the Gather Info application.
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All Other Errors 

Description An unknown error appears in the WebLogic SPI error log.

Severity Warning

Help Text Suggested Action
1 See the text following the error message in the WebLogic SPI error log to help identify the 

problem. You can view the SPI error log for a managed node by using the View Error File 
application in the Application Bank window. The error message can be identified by the 
date/time stamp.

2 Identify the steps to reproduce the problem.
3 Turn on tracing and  reproduce the problem. See the HP Operations Smart Plug-in for 

BEA WebLogic Server Configuration Guide for instructions on how to turn on tracing.
4 Run the Self-Healing Info application.
5 Contact HP support with the information gathered in the previous steps.
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A File Locations
You can find the WebLogic SPI configuration files and error logs in specific directories.

HPOM Management Server File Locations

Managed Node File Locations

On Windows or UNIX managed nodes that were already running the WebLogic SPI and are 
being switched to a non-root HTTPS agent environment (UNIX only. If these directories do 
not exist, see the next table for file locations): 

Operating System File File Location

HP-UX Configuration /opt/OV/conf/wlsspi

Solaris Configuration /opt/OV/conf/wlsspi

Operating System File File Location

HP-UX, Solaris, Linux Configuration /var/opt/OV/conf/wlsspi

HP-UX, Solaris, Linux Error Logs /var/opt/OV/log/wlsspi

AIX Configuration /usr/lpp/OV/conf/wlsspi

AIX Error Logs /usr/lpp/OV/log/wlsspi

Windows (HTTPS) Configuration \Documents and Settings\All 
Users\Application Data\HP\HP BTO 
Software\wasspi\wls\conf

Windows (HTTPS)  Error Logs \Documents and Settings\All 
Users\Application Data\HP\HP BTO 
Software\wasspi\wls\log
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On newly configured WebLogic SPI managed nodes in the non-root HTTPS agent 
environment (UNIX only):

Operating System File File Location

HP-UX, Solaris, Linux Configuration /var/opt/OV/conf/wlsspi

HP-UX, Solaris, Linux Error Logs /var/opt/OV/log/wlsspi

AIX Configuration /var/opt/OV/conf/wlsspi

AIX Error Logs /var/opt/OV/log/wlsspi
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B The Configuration 
This appendix explains the configuration structure and how to use the configuration editor, 
describes of the configuration properties, and provides samples of the configuration.

Structure

See Sample Configurations on page 178 for examples of the configuration. The basic structure 
of the configuration is given below. Lines preceded by # are treated as comments and are 
ignored.

# Global Properties
property=<value> ...

# GROUP Block
GROUP <group_name>
{
<node_name> ...
}

# NODE Block
NODE <node_name | group_name>
{
property=<value> ...
}

Global Properties

# Global Properties
<property>=<value> ...

Properties defined at the global level apply to all nodes. The global properties can be 
overridden by properties set within a GROUP or NODE block or by server-specific properties.

GROUP Block

# GROUP Block
GROUP <group_name>
{
<node_name> ...
}

You can use GROUP blocks to group together nodes having common properties. 
<group_name> denotes a group of nodes with common properties. If you repeat a GROUP 
block <group_name> within the configuration file, then the last definition takes precedence.
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<nodename> lists the nodes in the group and is the primary node name configured in HPOM. 

You can set the common properties using the NODE block. 

To view, set, or edit GROUP block properties, in the configuration editor, select the Default 
Properties item under the <Group_Name> folder. 

NODE Block

# NODE Block
NODE <node_name | group_name>
{
<property>=<value> ...
}

Properties set in a NODE block apply to nodes belonging to the group defined by 
<group_name> (to set common properties for a group) or to the specified <nodename> (to set 
properties for a single node). 

To set properties for a group, enter the <group_name> defined by the GROUP block and define 
the common properties. 

To set properties for a single node, enter the <nodename> and define the properties. 

<nodename> is the primary node name configured in HPOM. 

If you repeat a property definition within the NODE block, the last definition takes 
precedence. 

To view, set, or edit NODE block properties, in the configuration editor, select the Default 
Properties item under the <Node_Name> folder.

Server-Specific Properties

Apart from the high level properties, you can also view, set, or edit properties specific to a 
server. Each property specified as SERVER<n>_config_property refers to a specific WebLogic 
Server instance. When more than one WebLogic Servers are running on a given managed 
node, the number <n> differentiates the servers. Numbering begins at 1 and each WebLogic 
Server instance is assigned a unique number.

Property Precedence

The order of precedence (highest to lowest) of properties defined in the configuration are:

1 SERVER<n>_property (server-specific)

2 NODE <node_name> {<property>} (property defined for a node)

3 NODE <group_name> {<property>} (property defined for a group)

4 Global <property> 

The node name specified in a GROUP block matches the value returned by the HPOM 
variable $OPC_NODES, which is the primary node name configured in HPOM.
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The Configuration Editor

You can use the configuration editor to view and edit the configuration. You must update the 
configuration using the configuration editor only.

The main components of the configuration editor are:

• Tree

• Buttons

• Actions

Configure WLSSPI– Tree

The Configure WLSSPI tree that appears in the left pane of the WLSSPI Configure Tool: 
Configuration Editor window, shows the WebLogic SPI configuration in a tree structure.

The following is an example of the tree: 

 The icons are defined as follows:

If no application servers or groups are configured, the Application Servers and Groups folders 
do not appear. If you launch the Configure WLSSPI application for the first time without 
selecting any node, the Nodes folder does not appear in the tree.

The configuration properties can be viewed.

The configuration properties can be viewed and set.
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The following table lists each item in the tree and a brief description of the item.

Item Name Description

Application Servers Contains a list of all the application servers. This folder can 
appear under Defaults (global properties), Group_Name 
(GROUP block), or Node_Name (NODE block).

<Application_Server_Name> The server name as defined in the WebLogic Server.

Configuration Contains all the WebLogic SPI configuration information for 
the WebLogic environment.

Default Properties Lists the configuration properties that have been set. This 
item appears under Defaults (global properties), 
Group_Name (GROUP block), or Node_Name (NODE block).

Defaults Represents the global properties. Default properties set at 
this level apply to all nodes. However, these properties can be 
overridden by properties set under the Group_Name and 
Node_Name folders (for more information see Property 
Precedence on page 156).

Groups Represents the GROUP block.

<Group_Name> Identifies the name of a group of nodes with common 
properties. Default properties set at this level apply to all 
nodes that belong to the specified group. These properties can 
be overridden by properties set under the Node_Name folders 
(for more information see Property Precedence on page 156).

Nodes Represents the NODE block.

<Node_Name> Represents a single node whose name matches the value 
returned by the HPOM variable $OPC_NODES. This value is 
the primary node name configured in HPOM. Default 
properties set at this level apply to the specified node only (for 
more information see Property Precedence on page 156).
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Configure WLSSPI– Buttons

You can use the buttons available in the WebLogic SPI configuration editor to perform several 
functions. The following table lists the buttons and their description:

Configure WLSSPI– Actions

Actions that you can perform depend upon the item that is selected in the tree and from where 
you access the action. You can access the following Actions from the Actions menu, File menu, 
or by right-clicking on an item in the tree. 

Button Description

Cancel Exit the configuration editor.
If you click Cancel (without saving the changes) after adding or removing an 
application server, node, or group or modifying a configuration property, the 
Confirm Cancel window opens. Click Save and Exit to save the changes before 
exiting, click Exit without Save to exit without saving the changes, or click Return to 
Editing to continue editing the configuration (changes are not saved).

Next Exit the configuration editor.
When you click Next the Confirm Operation window opens. This window contains 
a list of the nodes you selected before launching Configure WLSSPI. The selected 
managed nodes’ configurations are updated with your changes. Changes made to 
the non-selected node (not displayed in the Confirm Operation window) are saved 
to the HPOM management server’s configuration. To save changes on those 
managed node’s configuration, you must select those managed nodes from the 
node bank, re-launch Configure WLSSPI, and then exit.

Finish Exit the configuration editor.
This button appears instead of the Next button if you launch Configure WLSSPI 
without selecting any nodes.

Save Save changes to the HPOM management server’s configuration and continue 
editing the configuration.
You can also click File  Save to save your changes.

Action Description Selected Tree Item

Add Application 
Server

To add an application server. For 
more information, see Add 
Application Server on page 160.

Application Servers
Defaults
<Group_Name>
<Node_Name>

Add Group To create a group to which you can 
assign nodes that have common 
properties. For more information, see 
Add Group on page 161.

Any item in the tree
Any item in the tree

Add Node To add a managed node to the Nodes 
folder. For more information, see Add 
Node on page 161.

Any item in the tree
Any item in the tree
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Add Application Server

You can add a WebLogic Server instance at the global properties, GROUP, or NODE level in 
the WebLogic SPI configuration.

If a node contains duplicate server names (the NAME property is set to the same value), you 
are prompted to set the ALIAS property (to uniquely identify each server). For more 
information about the ALIAS property, see Property Definitions on page 167.

To add an application server, follow these steps:

1 In the WLSSPI Configure Tool: Configuration Editor window, right-click one of the 
following items in the tree: Defaults (global properties level), Application Servers (global 
properties level), <Group_Name> (GROUP level), or <Node_Name> (NODE level) and 
select Add Application Server.

Exit To exit the configuration editor. This 
action is available from the File 
menu. If any changes have not been 
saved, the Confirm Cancel window 
opens.

Any item in the tree
Any item in the tree

Remove Application 
Server/Remove ALL 
App Servers

To remove one or all application 
servers listed. For more information, 
see Remove Application Server/
Remove ALL App Servers on 
page 162.

Application Servers
<Application_Server_Name>

Remove Group/
Remove ALL Groups

To remove one or all the WebLogic 
SPI groups listed. For more 
information, see Remove Group/
Remove ALL Groups on page 162.

Groups
<Group_Name>

Remove Node/
Remove ALL Nodes

To remove one or all managed nodes 
listed. For more information, see 
Remove Node/Remove ALL Nodes on 
page 163.

Nodes
<Node_Name>

Save To save changes to the configuration. 
This action is available from the File 
menu only if you make changes to the 
configuration.

Any item in the tree
Any item in the tree

Set Configuration 
Properties 

You can click Set Configuration 
Properties tab to set the WebLogic 
SPI configuration properties. For 
more information, see Set 
Configuration Properties Tab on 
page 163.

<Application_Server_Name>
Default Properties

View Current 
Configuration

You can click View Configuration 
Settings tab to view the WebLogic 
SPI configuration properties. For 
more information, see Set 
Configuration Properties Tab on 
page 163.

Any item in the tree
Any item in the tree

Action Description Selected Tree Item
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The WLSSPI Configure Tool: Configuration Editor: Add App Server window opens.

2 Enter the server name in the Application Server Name box. This is the name of the 
application server as defined in WebLogic Server and is case-sensitive. The WebLogic 
administration console displays the server names of all configured application servers in a 
domain. Use these names for the Application Server Name.

3 Enter the port name in the Application Server Port box. This is the port the WebLogic 
Server listens on. The WebLogic administration console displays the port numbers of all 
configured application servers in a domain. Use these for the Application Server Port.

4 Click OK.

The NAME and PORT properties are set.

The application server is added and you can view its properties. You might also set 
additional configuration properties for this server. For more information, see Set 
Configuration Properties Tab on page 163.

5 Click Save to save your changes.

If you do not want to add this application server, right-click the application server name, 
select Remove Application Server, and click Save.

Add Group

You can assign nodes with common properties to a group in the WebLogic SPI configuration.

To add a group, follow these steps:

1 In the WLSSPI Configure Tool: Configuration Editor window, right-click any item in the 
tree and select Add Group.

The WLSSPI Configure Tool: Configuration Editor: Add Group window opens.

2 Enter the group name in the Group Name box. The group name identifies the group of 
nodes with common properties and is not case-sensitive.

3 Click OK.

The group is added and the Set Configuration Properties tab for the group is active.

4 Click Add Node to Group, select one node from the list to add to the group, and click OK. 
Repeat this step until all nodes are added to the group.

5 Set the configuration properties for this group using the Select a Property to Set dropdown 
list. For more information, see Set Configuration Properties Tab on page 163.

6 Click Save to save your changes.

If you do not want to add the group, right-click the group name, select Remove Group, and 
select Save.

Add Node

To add a managed node to the WebLogic SPI configuration, follow these steps:

1 In the WLSSPI Configure Tool: Configuration Editor window, right-click any item in the 
tree and select Add Node. The WLSSPI Configure Tool: Configuration Editor: Add Node 
window opens.
The Configuration 161



2 From the dropdown list, select a node to add.

3 Click OK.

The node is added and the Set Configuration Properties tab for the node is active.

4 Set the configuration properties for this node using the Select a Property to Set... 
dropdown list. For more information, see Set Configuration Properties Tab on page 163.

5 Click Save to save your changes.

If you do not want to add the node, right-click the node name, select Remove Node, and 
select Save.

Remove Application Server/Remove ALL App Servers

To remove one WebLogic Servers listed from the WebLogic SPI configuration, follow these 
steps:

1 Right-click the application server name and select Remove Application Server.

The selected application server name is removed from the list and its configuration 
properties are removed from the configuration.

2 Click Save to permanently remove the application server from the configuration.

Click Cancel to cancel the removal of the application server (the application server name 
appears the next time you launch Configure WLSSPI). In the Confirm Cancel window, 
click Exit without Save.

To remove ALL application servers, follow these steps:

1 Right-click the Application Servers folder and select Remove ALL App Servers.

The selected Application Servers folder and all application servers listed in the selected 
folder are removed (all configuration properties for the listed application servers are 
removed from the configuration).

2 Click Save to permanently remove the application servers.

Select Cancel to cancel the removal of all application servers (the Application Servers 
folder and all application server names listed in the folder appear the next time you 
launch Configure WLSSPI). In the Confirm Cancel window, click Exit without Save.

Remove Group/Remove ALL Groups

To remove one or all the WebLogic SPI groups listed from the WebLogic SPI configuration, 
follow these steps:

1 Right-click the group server name and select Remove Group.

The selected group is removed from the list and its configuration properties are removed 
from the configuration.

2 Click Save to permanently remove the group.

If no additional managed nodes are available to add to the configuration, the 
following message appears:
 All available managed nodes have been added to the configuration.
Click OK to exit this action.
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Click Cancel to cancel the removal of the group (the group name appears the next time you 
launch Configure WLSSPI). In the Confirm Cancel window, click Exit without Save.

Remove Node/Remove ALL Nodes

To remove one managed node listed from the WebLogic SPI configuration, follow these steps:

1 Right-click the node name and select Remove Node.

The selected node is removed from the list and its configuration properties are removed 
from the configuration.

2 Click Save to permanently remove the node.

Select Cancel to cancel the removal of the node (the node name appears the next time you 
launch Configure WLSSPI). In the Confirm Cancel window, click Exit without Save.

To remove ALL nodes, follow these steps:

1 Right-click the Nodes folder and select Remove ALL Nodes.

The selected Nodes folder and all nodes listed in the selected folder are removed (all 
configuration properties for the listed nodes are removed from the configuration).

2 Click Save to permanently remove the nodes.

Click Cancel to cancel the removal of all nodes (the Nodes folder and all node names listed 
in the folder appear the next time you launch Configure WLSSPI). In the Confirm Cancel 
window, click Exit without Save.

Set Configuration Properties Tab

You can use this tab to set the WebLogic SPI configuration properties at the global properties 
level or for the selected application servers, groups (GROUP level), or nodes (NODE level).

Items with the  icon are the only items for which you can set configuration properties 
(Default Properties and <Application_Server_Name>).

To set the configuration properties of an item, in the configuration editor select the item and 
click the Set Configuration Properties tab in the right pane.

Setting a Property

To set a property in the configuration, follow these steps:

1 In the configuration editor, select a property from the Select a Property to Set... dropdown 
list.

2 Click Set Property. The property and an empty value filed appear in the table.

3 Click the empty value field and enter a value.

4 Repeat steps 1 - 3 for each property to set.

5 Click Save.

For more information about individual properties, see Configuration Properties on page 166.

For the LOGIN and PASSWORD properties, when you click Set Property, a separate window 
opens. Enter the login and password values in this window.
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Modifying a Property

To modify a property (except LOGIN) in the configuration, follow these steps:

1 In the configuration editor, select the property you want to modify.

2 Double-click the value field.

3 Edit the value.

If a node contains duplicate server names (the NAME property is set to the same value), 
you are prompted to set the ALIAS property (to uniquely identify each server). For more 
information about the ALIAS property, see Property Definitions on page 167.

4 Repeat steps 1 - 3 for each property to modify.

5 Click Save.

To modify the LOGIN property in the configuration, follow these steps:

1 Select LOGIN/PASSWORD from the Select a Property to add... dropdown list.

2 Click Set Property. The Set Access Info for Default Properties window opens.

3 Enter the new password and verify password. Click OK.

4 Click Save.

For more information about individual properties, see Configuration Properties on page 166. 

Removing a Property

To remove a property from the configuration, follow these steps:

1 In the configuration editor, select the property you want to remove.

2 Click Remove Property.

3 Repeat steps 1 - 2 for each property to remove.

4 Click Save.

AUTO_DISCOVER

The AUTO_DISCOVER check box that appears near the bottom of the window sets the 
AUTO_DISCOVER property. You can set this property only by selecting or clearing the check 
box.

Selecting the check box (default) causes the discovery templates (if distributed) to 
automatically update the WebLogic SPI configuration information in the service map and 
configuration. If the discovery templates are not distributed, the service map is created but 
not updated.

View Current Configuration Tab

You can use this tab to view all the WebLogic SPI configuration properties set in the 
configuration on the HPOM management server or the WebLogic SPI configuration properties 
for the selected application servers, groups, or nodes.

To view the configuration properties of an item, in the configuration editor select the item and 
click the View Configuration Settings tab in the right pane.
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The following table describes the view when the specified item is selected.

View Inherited Properties

A View Inherited Properties check box appears near the bottom of the window. If you select 
this check box, the view of the configuration properties changes to show all inherited 
properties (those properties defined at a global properties level or GROUP level) that affect 
the selected item. Inherited properties are denoted by “<*>” that appears after the property.

If you clear the View Inherited Properties check box, the view shows only the configuration 
properties set at that level for the selected item.

Inherited properties can only be modified at the level they are set. If “<*>” appears after a 
property, the property cannot be modified at that level. For example, if the property HOME is 
set at the global properties level (under the Defaults folder), it can only be modified in the 
Default Properties listed under the Defaults folder. Although HOME appears (with “<*>” 
after it) in a <Group_Name>’s Default Properties view, HOME cannot be modified at this 
level.

Properties set lower in the tree take precedence over those properties set higher in the tree. 
For example, if the property HOME is set at the global properties level (under the Defaults 
folder) and the property HOME is set at the GROUP level, the GROUP level property value 
takes precedence.

Configuration property precedence is as follows (listed from highest to lowest):

1 Server-specific

2 NODE level

3 GROUP level

4 Global properties level

Item Name Description of View

Application Servers View all configuration properties set for all the listed 
application servers.

<Application_Server_Name> View all configuration properties set for the application server 
(these properties can be modified by selecting the Set 
Configuration Properties tab).

Configurations View all configuration properties saved in the configuration on 
the HPOM management server.

Default Properties View all configuration properties that are set (these properties 
can be modified by selecting the Set Configuration Properties 
tab).

Defaults View all configuration properties set at the global properties 
level.

Groups View all configuration properties set for all the listed groups.

<Group_Name> View all configuration properties set for the specific group.

Nodes View all configuration properties set for the listed nodes.

<Node_Name> View all configuration properties set for the specific node.
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Configuration Properties 

The WebLogic SPI maintains a configuration that consists of property values that are 
discovered by the discovery process or are user defined.

Table 16 lists the following properties by WebLogic SPI requirements: 

For a description of the property, see Table 17.

Property Name of the property.

Requirements Property requirements for specific components are the 
following:

R - Required: The property must be set.

C - Conditional: The property might need to be set if 
certain conditions are met.

O - Optional: The property is not required for the 
component to work.

blank - Not Applicable: The property does not affect this 
component.

WebLogic SPI The configuration requirements for the WebLogic SPI to work.

Discovery Process The requirements for the discover process to work.

Auto-Discovered The property is automatically set by the discover process.

Level of Configuration The level at which this property can be set within the 
configuration structure.

Default Properties The global, group, or node level within the configuration 
structure.

Application Server The server-specific level within the configuration structure.
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Property Definitions 

Table 16 Properties Listed by WebLogic SPI Requirements

Property

     Requirements

Auto-Discovered

          Level of Configuration

WebLogi
c SPI

Discovery 
Process

Default 
Properties

Application 
Server

HOME R O

JAVA_HOME R C

LOGIN R R

NAME R

PASSWORD R R

PORT R  

ADDRESS C O a

ADMIN_HOST C

ADMIN_PORTS C

ADMIN_PORTS C C

ALIAS C

AUTO_DISCOVER C

BEA_HOME_LIST C O

COLLECT_METADATA C O

GRAPH_URL C

HOME_LIST C C

JMB_JAVA_HOME C

JMX_CLASSPATH C

KEYSTORE C

LOGFILE C

NODE_NAMES C C

PASSPHRASE C

PROTOCOL C

RMID_PORT C

RMID_START_TIME C

START_CMD C

STOP_CMD C

USER C

URL_PATH C

VERSION C

EXCLUDE_SAMPLES O
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MAX_ERROR_LOG_SIZE O

TIMEOUT O

TYPE O

UDM_DEFINITIONS_ 
SOURCE

O

a. If a WebLogic Admin server is managing a remote WebLogic Server that is listening on a virtual IP address, you 
must configure the managed node on which the remote WebLogic Server is running with an alias in HPOM, for 
ADDRESS to be automatically discovered. To configure the virtual IP address in HPOM, see the Description 
section of the ADDRESS property.

Table 16 Properties Listed by WebLogic SPI Requirements (cont’d)

Property

     Requirements

Auto-Discovered

          Level of Configuration

WebLogi
c SPI

Discovery 
Process

Default 
Properties

Application 
Server

In Table 17, Application Server A is mentioned repeatedly. Application Server A represents 
the WebLogic Application Server for which you are setting the properties. 

Table 17 Configuration Properties

Property

Applicable 
WebLogic 
Version

Required/
Conditional/
Optional Description

ADDRESS 7.0, 8.1, 9.x, 
10.0

Conditional
Required if the server is 
running on a virtual IP 
address, is on a remote 
node, or is not using the 
primary IP address of 
that node.

The domain name or IP address where 
the server is listening. If ADDRESS is 
not set, the WebLogic SPI connects to 
the server using the node’s primary 
address.
Example: 
SERVER1_ADDRESS = product.hp.com

ADMIN_HOST 7.0, 8.1, 9.x, 
10.0

Conditional
Required if you want to 
start and stop the 
WebLogic console using 
the Start WebLogic 
Console application

Name of the node on which the 
WebLogic administration server, which 
is managing Application Server A is 
running. This property must be set to 
start the WebLogic Server Console 
application.
Example: 
SERVER1_ADMIN_HOST=localhost

ADMIN_PORTS 7.0, 8.1, 9.x, 
10.0

Conditional
Required if you want to 
start and stop the 
WebLogic console using 
the Start WebLogic 
Console application

The port of the WebLogic 
administration server managing 
Application Server A. Must be set in 
order to start the WebLogic Server 
Console application.
Example: SERVER1_ADMIN_PORT=7005
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ADMIN_PORTS 7.0, 8.1, 9.x, 
10.0

Conditional
Required if the domain 
configuration file of the 
WebLogic Admin servers 
is not located in the 
default directory.

The port numbers of WebLogic Admin 
servers whose domain configuration file, 
config.xml, is not located in the 
default directory listed below:  
• For WebLogic 7 or 8 

<BEA_Home_Dir>/
user_projects/
<WebLogic_Domain>/

• For WebLogic 9.x, 10.0

<BEA_Home_Dir>/
user_projects/domains/
<domain_name>

where, <WebLogic_Install_Dir> is the 
directory where the WebLogic Server is 
installed, <BEA_Home_Dir> is the 
directory that contains the 
registry.xml file, and 
<WebLogic_Domain> is the WebLogic 
domain name. 
If the WebLogic Admin server is 
listening on a virtual IP address, 
include this virtual IP address before 
the port number, separated by a colon. 
For example, <virtual_ip_address>:
<port_number>. 
The LOGIN and PASSWORD for the 
WebLogic Admin servers must be set at 
the NODE block level. The LOGIN and 
PASSWORD must be the same for all 
WebLogic Admin servers running on the 
same node. The port numbers set by 
this property are the ports used by the 
WebLogic Admin servers.

Table 17 Configuration Properties (cont’d)

Property

Applicable 
WebLogic 
Version

Required/
Conditional/
Optional Description
The Configuration 169



ALIAS 7.0, 8.1, 9.x, 
10.0

Conditional
Required if more than 
one application server on 
a system share the same 
server name.

Unique name assigned to an application 
server on a managed node if more than 
one application server on a node share 
the same server name. The alias, if set, 
is the name used in messages, reports, 
and graphs (otherwise, NAME is used).
If you modify the ALIAS, the data for 
the old alias is saved, but is not mapped 
to the new alias.
Example: 
NODE petstore.hp.com {
SERVER1_NAME=dog
SERVER1_ALIAS=beagle
SERVER2_NAME=dog
SERVER2_ALIAS=dachshund 

}

NODE flying_ace.hp.com {
SERVER1_NAME=snoopy
SERVER1_ALIAS=beagle
SERVER2_NAME=snoopy
SERVER2_ALIAS=red_baron 

}

AUTO_DISCOVER 7.0, 8.1, 9.x, 
10.0

Conditional
Required if you do not 
want the discovery 
policy to automatically 
overwrite the 
configuration 
information.

Select the AUTO_DISCOVER check box 
in the configuration editor to 
automatically update the WebLogic 
Server configuration information in the 
service map and configuration. 
Clear the AUTO_DISCOVER check box 
in the configuration editor if you want 
to manually configure the WebLogic 
Server configuration and do not want 
the discovery policy to automatically 
overwrite the configuration 
information. 

Table 17 Configuration Properties (cont’d)

Property

Applicable 
WebLogic 
Version

Required/
Conditional/
Optional Description
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BEA_HOME_LIST 7.0, 8.1, 9.x, 
10.0

Conditional
Required if the 
WebLogic Server 
software registry does 
not exist on a managed 
node.

This is the software registry used by all 
WebLogic products. It contains 
information about all WebLogic 
products installed on the system. 
If you do not use BEA's installation 
scripts to install the WebLogic Server, 
the software registry is not created. 
On a UNIX managed node, the software 
registry is created in the file 
$HOME/bea/beahomelist, where 
$HOME is the home directory of the user 
who installed the WebLogic Server. On 
a Windows managed node, the software 
registry is created in the file 
beahomelist or is defined by the 
BEAHOMELIST registry. 
On a UNIX managed node, directory 
names with spaces are not supported. 
If the software registry does not exist 
and this property is not set, the 
Discovery templates generate an error 
message.

COLLECT_METADATA 7.0, 8.1, 9.x, 
10.0

Conditional
Required if you want to 
use the MBean Explorer 
in the JMX Metric 
Builder application.

Set the value of 
COLLECT_METADATA to ON to collect 
metadata (MBean information) 
displayed by the JMX Metric Builder 
application. This metadata is used to 
create UDMs (user defined metrics).
Metadata for each MBean server is 
saved in the following file: /var/opt/
OV/wasspi/wls/metadata/
<managed_node>/
<NAME|ALIAS>.xml, 
/var/opt/OV/metadata/wls/
<managed_node>/
<NAME|ALIAS>.xml, or 
\<%OvAgentDir%>\wasspi\wls\
metadata\<managed_node>\
<NAME|ALIAS>.xml where NAME 
and ALIAS are the properties set for the 
managed node and ALIAS is always 
used if it is set.
Default: OFF. 

Table 17 Configuration Properties (cont’d)

Property

Applicable 
WebLogic 
Version

Required/
Conditional/
Optional Description
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EXCLUDE_SAMPLES 7.0, 8.1, 9.x, 
10.0

Optional Set the value to true to not discover 
WebLogic Server sample programs. 
This reduces the time taken by the 
discovery process. Sample programs are 
located in the following directories:
WebLogic 7, 8, 9.x, and 10.0
<WL_Install_Dir>/samples/
domains/medrec

Default: false.
Example: EXCLUDE_SAMPLES = true

GRAPH_URL 7.0, 8.1, 9.x, 
10.0

Conditional
Required if you want to 
use the View Graphs 
application (HP Open 
View Performance 
Manager must be 
installed).

The URL used to launch HP 
Performance Manager. Set the 
GRAPH_URL property at the global 
level only.
Examples: GRAPH_URL = http://
<server_name>:<port_no>/OVPM (PM 
8.10 on UNIX and Windows), the 
default port number is 8081.

HOME 7.0, 8.1, 9.x, 
10.0

Required The directory where the WebLogic 
Server is installed. 
Example: HOME = /opt/bea/
wlserver6.0sp1

HOME_LIST 7.0, 8.1, 9.x, 
10.0

Conditional
Required if the BEA 
registry.xml file is not 
accurate or cannot be 
found. You can face this 
problem if you do not use 
BEA's installation 
scripts to install the 
WebLogic Server 
software and Service 
Packs.

List of directories where the WebLogic 
Server is installed. Each directory is 
separated by a semicolon. This list is 
used by discovery. 
On a UNIX managed node, directory 
names with spaces are not supported.

JAVA_HOME 7.0, 8.1, 9.x, 
10.0

Required
Required by the 
discovery process if there 
is more than one 
directory where Java is 
installed.

The directory where Java, that is used 
by the collector, is installed . The java 
engine is expected to be $JAVA_HOME/
bin/java.
Example: JAVA_HOME = /opt/bea/
jdk130

JMB_JAVA_HOME N/A Conditional
Required if you are using 
the JMX Metric Builder.

The directory where Java (JDK 1.4.1 or 
higher) is installed. This is the java that 
is used by the JMX Metric Builder on 
the HPOM management server. The 
JDK must be version 1.4.1 or higher. 

Table 17 Configuration Properties (cont’d)

Property

Applicable 
WebLogic 
Version

Required/
Conditional/
Optional Description
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JMX_CLASSPATH N/A Conditional
Required if you are using 
the JMX connector to 
monitor a non-WebLogic 
MBean server. 

The location of the jar file(s) 
implementing JMX.
Example: JMX_CLASSPATH = /opt/
JMX/Sun/lib/jmxri.jar

KEYSTORE 8.1, 9.x, 
10.0

Conditional
Required if using SSL. 

The fully-qualified path to the SSL 
trust keystore file.
Default: WebLogic’s demo keystore

LOGFILE 7.0, 8.1, 9.x, 
10.0

Conditional
Required only if the 
logfile names returned 
by WebLogic Server are 
not those desired to be 
monitored.

A comma-separated list of fully 
qualified file names of WebLogic Server 
log files.
Setting this property overrides any 
logfiles that the SPI would otherwise be 
monitoring for this server.
Default: <home>/<NAME>/
weblogic.log

LOGIN 7.0, 8.1, 9.x, 
10.0

Required The WebLogic Server admin user 
configured at installation.
Example: SERVER1_LOGIN = johndoe

MAX_ERROR_LOG_SIZE 7.0, 8.1, 9.x, 
10.0

Conditional
Required if you want an 
error log file larger than 
2MB

The maximum size allowed for the error 
log file. When the error log file reaches 
the maximum size, it is renamed as a 
backup file and logging resumes. When 
a new backup file replaces an old 
backup file, the old backup is deleted.
Default: 2MB
Example: 
MAX_ERROR_LOG_SIZE = 20

NAMEa 7.0, 8.1, 9.x, 
10.0

Required The server name as defined in the 
WebLogic Server. Use the WebLogic 
administration console to obtain this 
information. If a system shares the 
same server name (the value of NAME 
is the same within a NODE block), use 
ALIAS to uniquely identify each server. 
This name is used in messages, reports, 
and graphs unless ALIAS is set.
Example: SERVER1_NAME = 
exampleServer

Table 17 Configuration Properties (cont’d)

Property

Applicable 
WebLogic 
Version

Required/
Conditional/
Optional Description
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NODE_NAMES 7.0, 8.1, 9.x, 
10.0

Conditional
Required if a remote 
WebLogic Server is 
running on a virtual IP 
address.

The virtual IP address where the server 
is listening. If NODE_NAME is not set 
for the remote WebLogic Server, it is 
not automatically discovered.
Example: SERVER1_NODE_NAMES = 
15.19.20.21

NUM_SERVERS 7.0, 8.1, 9.x, 
10.0

Optional The number of WebLogic Servers on the 
managed node.
Example: NUM_SERVERS = 3

PASSPHRASE 8.1, 9.x, 
10.0

Conditional
Required if the 
configured keystore 
requires a passphrase 
for read operations. 

The passphrase defined when the 
keystore was created on your WebLogic 
Server. If a keystore was not defined 
with a password, do not set this 
property.
When you type in the PASSPHRASE, it 
displays as plain text in the GUI. When 
you save the properties or change the 
view in the GUI, the PASSPHRASE is 
encrypted.
A PASSPHRASE must contain at least 
two characters. 

PASSWORD 7.0, 8.1, 9.x, 
10.0

Required The password for the LOGIN. If LOGIN 
is configured, a password must be 
defined. 
Example: 
SERVER1_PASSWORD = johndoe123

PORT 7.0, 8.1, 9.x, 
10.0

Required The port the WebLogic Server listens 
on. Use the WebLogic administration 
console to get the port number.
Example: SERVER1_PORT = 7001

PROTOCOL 8.1, 9.x, 
10.0

Conditional
Required if using SSL on 
the application server 
port.

Specifies if the application server port is 
using SSL or non-SSL. Valid values are:
• t3 for non-SSL
• t3s for SSL
If PROTOCOL is not set, it takes the 
default, which is t3. If PROTOCOL is 
set and you click Set Property, the 
default value becomes t3s.
If an invalid PROTOCOL is set or it 
does not match the application port, 
HPOM reports the application server as 
down.

Table 17 Configuration Properties (cont’d)

Property
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WebLogic 
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RMID_PORT 8.1, 9.x, 
10.0

Conditional
Required if the default 
port on which rmid 
listens is already in use.

The port on which rmid listens.
By default, if an HPOM managed node 
is monitoring application servers and 
MBean servers using the JMX 
connector, the SPI uses two ports - one 
for the application servers and one for 
the MBean servers. For example, if you 
are monitoring a WebLogic Server and 
an MBean server, the SPI uses ports 
9240 and 9241 respectively.
But, if RMID_PORT is set, the SPI uses 
this one port for all servers. For 
example, if you are monitoring a 
WebLogic Server and an MBean server 
and set RMID_PORT to 9250, the SPI 
uses port 9250 only for both the servers.
You cannot set this property at the 
application server level.
Default: WebLogic Server: 9240; JMX 
connector: 9241
Examples: RMID_PORT = 9250 

RMID_START_TIME 8.1, 9.x, 
10.0

Conditional
Required if rmid takes 
longer than 30 seconds 
to start.

The amount of time, in seconds, to wait 
for rmid to start before timing out.
Default: 30 (seconds)
Examples: RMID_START_TIME = 60

START_CMD 7.0, 8.1, 9.x, 
10.0

Conditional
Required if you want to 
start the WebLogic 
Server from the HPOM 
console

This system command is run when the 
Start WebLogic application is used. 
This command is run by USER, which 
must be set for the Start WebLogic 
application to work.
Note: This command must exit. That is, 
the WebLogic Server process must run 
in the background or as a service and it 
must be protected from its parent 
process dying. 
Example: SERVER1_START_CMD = /
sbin/init.d/weblogic start

STOP_CMD 7.0, 8.1, 9.x, 
10.0

Conditional
Required if you want to 
stop the WebLogic 
Server from the HPOM 
console

This system command is run when the 
Stop WebLogic application is used. This 
command is run by USER, which must 
be set for the Start WebLogic 
application to work.
Example: SERVER1_STOP_CMD = /
sbin/init.d/weblogic stop

Table 17 Configuration Properties (cont’d)
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TIMEOUT 7.0, 8.1, 9.x, 
10.0

Optional The maximum amount of time (in 
seconds) that the WebLogic SPI can 
take to connect to the WebLogic Server. 
When the specified time is exceeded, the 
WebLogic SPI sends an alarm to the 
message browser indicating that the 
WebLogic Server is unavailable. If 
metric B002_ServerStatusRep is being 
collected, the unavailability of the 
server is logged. 
If you do not want a time limit, set this 
property to -1. 
Default: 120 (seconds).

TYPE 7.0, 8.1, 9.x, 
10.0

Optional
Required if you are 
configuring a JMX 
connector

The type of JMX connector. Set TYPE to 
ovrmi if you are configuring a JMX 
connector.
Do not change the default value of 
TYPE if you are using WebLogic’s 
MBean server.
Default: weblogic.
Example: SERVER1_TYPE=weblogic

UDM_DEFINITIONS_SO
URCE

7.0, 8.1, 9.x, 
10.0

Optional The path name to or file name of the 
metric definitions XML file on the 
HPOM management server. If a path 
name is set, the 
wasspi_wls_udmDefinitions.xml file 
is the assumed file name of the UDM 
file.
Default: /opt/OV/conf/wlsspi/
wasspi_wls_udmDefinitions.xml. 
Example: 
SERVER1_UDM_DEFINITIONS_SOURCE = 
/opt/OV/conf/wlsspi/udm.xml

URL_PATH 9.x, 10.0 Conditional The path part of the JSR-160 connector 
server URL.
Example: SERVER1_URL_PATH=jndi/
weblogic.management.mbeanserve
rs.domainruntime

USER 7.0, 8.1, 9.x, 
10.0

Conditional
Required if you want to 
start and/or stop the 
WebLogic Server from 
the HPOM console

The system username for starting and 
stopping the WebLogic Server from the 
HPOM Console. 
Default: the username under which the 
HP Operations agent runs.
Example: USER = weblogic

Table 17 Configuration Properties (cont’d)
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Optional Description
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VERSION 7.0, 8.1, 9.x, 
10.0

Conditional
Required for WebLogic 
Versions 7 and 8

The version number of the WebLogic 
Server in the format Major# [Minor#] 
where:
Major# - The primary version number 
(for example, 7.0) 
Minor# - The service pack installed (for 
example, 1 for SP1). If Minor# is not 
specified, the default value 0 is taken 
(no service pack installed). 

a. The WebLogic administration console displays the server names and port numbers of all configured application 
servers in a domain. Use these names and numbers when defining NAME and PORT. 

Table 17 Configuration Properties (cont’d)
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Sample Configurations

The following examples illustrate various features and utilization methods.

Example 1: Single Node/Two Servers

The following example is of two servers, an administration server and a managed server, 
running on a single node. The properties HOME and JAVA_HOME are global defaults that 
apply to all servers and nodes. When the configuration is saved, passwords are encrypted. 

HOME = /opt/bea/wlserver_10
JAVA_HOME=/opt/bea/jdk131
NODE main.rose.hp.com
{
SERVER1_NAME= adminserver
SERVER1_PORT= 7001
SERVER1_LOGIN= system
SERVER1_PASSWORD = password
SERVER2_NAME= managedserver
SERVER2_PORT= 7005
SERVER2_LOGIN= system
SERVER2_PASSWORD= password

}
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Example 2: Multiple Nodes/Repeated Properties

The example that follows shows how you can configure a group of related systems that have 
numerous properties in common. Some nodes, however, might have one or two properties that 
you need to set differently. You can address these kinds of situations in three steps: 

1 Use the Add Group action in the configuration editor to name the group, specify the nodes 
in it, and set the configuration properties. For more information, see Add Group on 
page 161.

2 Use the Add Node action in the configuration editor to define individual node properties 
(either for nodes not in the group or for nodes in the group that have some unique/
separate properties). For more information, see Add Node on page 161.

In the example, the global default properties HOME and JAVA_HOME are overridden for 
node europa.rose.hp.com. Since the start command uses the system init command —/sbin/
init.d/weblogic start which runs when the system starts and starts all of the WebLogic 
Servers, you must set USER to root. In this environment, this command takes care of starting 
the servers with the correct user, such as weblogic.

HOME   = /opt/bea/wlserver_10
JAVA_HOME = /opt/bea/jdk131
USER   = root
GROUP production
{
mercury.rose.hp.com
venus.rose.hp.com
mars.rose.hp.com
jupiter.rose.hp.com

}
NODE production
{
SERVER1_NAME= partsserver
SERVER1_PORT= 7001
SERVER1_LOGIN= system
SERVER1_PASSWORD= password
SERVER1_ADMIN_HOST= earth.rose.hp.com
SERVER1_ADMIN_PORT= 7001
SERVER1_START_CMD /sbin/init.d/weblogic start
SERVER2_NAME= orderserver
SERVER2_PORT= 7010
SERVER2_LOGIN= system
SERVER2_PASSWORD= moresecret
SERVER2_START_CMD /sbin/init.d/weblogic start

}
NODE jupiter.rose.hp.com
{
SERVER1_PASSWORD= different1password
SERVER2_PASSWORD= different2password

}
NODE europa.hp.com
{
SERVER1_HOME = /opt/bea/wls

Properties set for a node take precedence over the same properties set for a group. 
For the complete order of property precedence, see Property Precedence on 
page 156.
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SERVER1_JAVA_HOME = /opt/bea/jdk132
SERVER1_NAME= testserver
SERVER1_PORT= 7100
SERVER1_LOGIN= system
SERVER1_PASSWORD= mypssword

}

Example 3: Multiple WebLogic Server Versions

This example shows how to set up an environment with two different versions of WebLogic 
Server running on a single managed node. Note that SERVER1_HOME and 
SERVER2_HOME are set to different directories for the different versions of WebLogic 
Server.

NODE callisto.rose.hp.com
{
SERVER1_HOME = /opt/bea/weblogic90
SERVER1_JAVA_HOME = /opt/bea/jdk131
SERVER1_NAME= prodserver
SERVER1_PORT= 7001
SERVER1_LOGIN= system
SERVER1_PASSWORD= mypssword
SERVER1_HOME = /opt/bea/wlserver_10
SERVER1_JAVA_HOME = /opt/bea/jdk131
SERVER1_NAME= testserver
SERVER1_PORT= 7100
SERVER1_LOGIN= system
SERVER1_PASSWORD= mypssword

}

Example 4: WebLogic Servers with Virtual IP Addresses

This example shows how to configure WebLogic Servers that have virtual IP addresses. 
ADDRESS is set to the name or IP address where the server is listening.

NODE saturn.rose.hp.com
{
SERVER1_HOME = /opt/bea/weblogic90
SERVER1_JAVA_HOME = /opt/bea/jdk131
SERVER1_NAME= partsserver
SERVER1_PORT= 7001
SERVER1_ADDRESS= juno.rose.hp.com
SERVER1_LOGIN= system
SERVER1_PASSWORD= mypssword

 SERVER2_HOME = /opt/bea/wlserver_10
SERVER2_JAVA_HOME = /opt/bea/jdk131
SERVER2_NAME= orderserver
SERVER2_PORT= 7001
SERVER2_ADDRESS= 15.15.1.1
SERVER2_LOGIN= system
SERVER2_PASSWORD= mypssword

}
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Example 5: Non-default WebLogic Server Startup Location 

This example addresses the case where the command that starts WebLogic Server does not cd 
to the HOME directory before it starts. The WebLogic SPI might not be able to locate the 
WebLogic Server log files in order to monitor them. To ensure that the WebLogic SPI can 
monitor the log files, either set LAUNCH_DIR to the directory the server was run from as on 
neptune (in the example), or set LOGFILES as on pluto (in the example).

NODE neptune.rose.hp.com
{
SERVER1_HOME = /opt/bea/wlserver_10
SERVER1_JAVA_HOME = /opt/bea/jdk131
SERVER1_NAME= exampleServer
SERVER1_PORT= 7001
SERVER1_LOGIN= system
SERVER1_PASSWORD= mypssword
SERVER1_LAUNCH_DIR = /home/weblogic

}
NODE pluto.rose.hp.com
{
SERVER1_HOME = /opt/bea/wlserver_10
SERVER1_JAVA_HOME = /opt/bea/jdk131
SERVER1_NAME= exampleServer
SERVER1_PORT= 7001
SERVER1_LOGIN= system
SERVER1_PASSWORD= mypssword
SERVER1_LOGFILES = 

/opt/bea/wlserver_10/config/mydomain/logs/weblogic.log, 
/opt/bea/wlserver_10/config/mydomain/logs/wl-domain.log
}

The SERVER1_LOGFILES are set on a single long line separated by commas.
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C Applications
The WebLogic SPI applications include configuration and troubleshooting utilities.

WLSSPI Admin group includes the following applications:

• Configure WLSSPI

• Discover WebLogic

• Init Non-Root

• Self-Healing Info

• Start/Stop Monitoring

• Start/Stop Tracing

• Verify

• View Error File

• View Graphs

WebLogic group includes the following applications:

• Check WebLogic

• Start WLS Console

• Start/Stop WebLogic

• View Deployed Apps

• View WebLogic Log

• View WebLogic Servers

• View Application Activation Status

• View Application Timeout

Additional WLSSPI Admin applications for user defined metrics (UDMs) are available with 
the SPIJMB software. See the HP Operations Smart Plug-in User Defined Metrics User Guide 
for more information about how to install the software and the additional applications.
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The WLSSPI Admin Applications Group

The WLSSPI Admin application group contains the following applications. These applications 
require the “root” user permission, therefore it is recommended that this group is assigned to 
the HPOM administrator.

Configure WLSSPI

Configure the WebLogic SPI application launches the configuration editor. You can use the 
configuration editor to maintain the WebLogic SPI configuration by viewing, editing, or 
setting configuration properties.

If you are configuring the WebLogic SPI for the first time, use the Discover WebLogic 
application to automatically set basic configuration properties. For more information, see 
Chapter 3, Configuring the WebLogic SPI.

Function

Configure WLSSPI application performs the following functions:

• Updates the configuration on the HPOM management server and managed nodes.

• Creates the directories and files required by the WebLogic SPI on the selected managed 
nodes.

• Sets up data sources for reporting and graphing

• Sets up the WebLogic Server log files and the WebLogic SPI error log file for monitoring

Configuration information about all the WebLogic Servers running on all managed nodes is 
maintained on the management server. In addition, every managed node maintains 
information about WebLogic Servers running on that node.

When you make changes using the configuration editor, the changes are saved on the HPOM 
management server. However, when launching the Configure WLSSPI application if you 
select a node, the changes affecting the selected node are saved on that node itself.

To save any changes on a managed node, you must select that node before launching the 
Configure WLSSPI application otherwise the changes are saved on the management server by 
default.

To Launch the Configure WLSSPI Application

1 At the HPOM console, double-click OVO Node Bank. The OVO Node Bank window opens.

2 From the Window menu, select Application Bank. The OVO Application Bank window 
opens.

3 Double-click WLSSPI. The Application Group: WebLogic SPI window opens.

4 Double-click WLSSPI Admin. The Application Group: WLSSPI Admin window opens. All 
the WLSSPI Admin applications appear in this window.

5 Select a node from the OVO Node Bank window and double-click Configure WLSSPI (If the 
items do not appear as mentioned, select Map  Reload). The Introduction window opens.

6 Click Next. The configuration editor opens. For more information about using 
configuration editor, see The Configuration Editor on page 157.
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7 Click Save to save any changes made to the configuration. After you save your changes, 
you cannot automatically undo them.

8 Select Finish or Next to save changes and exit the editor.

If you select Next, the Confirm Operation window opens. Click OK to save the changes.

 

9 During configuration, if you added an application server or added/edited the 
ADMIN_PORTS, HOME, HOME_LIST, or JAVA_HOME properties, you must launch the 
Discover WebLogic Application on the nodes on which the application server/properties 
were added or edited. Running the Discover application updates the service map.

Discover WebLogic

The Discover WebLogic application sets basic configuration properties needed for discovery. It 
also launches the configuration editor through which you can configure the WebLogic SPI by 
setting initial configuration properties.

Function

Discover WebLogic updates the configuration on the HPOM management server and selected 
managed nodes.

Configuration information about the all the WebLogic Servers running on all managed nodes 
is maintained on the management server. In addition, every managed node maintains 
information about WebLogic Servers running on that node.

When you make changes using the configuration editor, the changes are saved on the HPOM 
management server. However, when launching the Configure WLSSPI application if you 
select a node, the changes affecting the selected node are saved on that node itself.

To save any changes on a managed node, you must select that node before launching the 
Configure WebLogic SPI application otherwise the changes are saved on the management 
server by default.

To Launch the Discover WebLogic Application

1 From the HPOM console, double-click OVO Node Bank. The OVO Node Bank window 
opens.

2 From the Window menu, select Application Bank. The OVO Application Bank window 
opens.

3 Double-click WLSSPI. The Application Group: WebLogic SPI window opens.

4 Double-click WLSSPI Admin. The Application Group: WLSSPI Admin window opens. All 
the WLSSPI Admin applications appear in this window.

If you click Cancel in the Confirm Operation window, the changes made by you are 
not saved to the selected managed nodes’ configuration and remain in the 
configuration on the management server. To make the changes to the selected 
managed nodes’ configuration, you must select those nodes in the Node Bank 
window, launch the Discovery application, click Next in the configuration editor, 
and then click OK in the Confirm Operation window.
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5 Select a node from the OVO Node Bank window and double-click Discover WebLogic (If the 
above does not appear as described, select Map  Reload.) The Introduction window opens. 
This window contains brief information about the Discovery application.

6 Click Next. A second Introduction window opens. This window displays information about 
which properties might be required for the discovery process to work.

7 Click Next. If you have not set the WebLogic SPI LOGIN and PASSWORD properties, the 
Set Access Info for Default Properties window opens.

Set the LOGIN and PASSWORD properties same as the WebLogic Server login and 
password configured in Task 2: Configure a WebLogic Server User on page 41.

If the WebLogic Server login and password are the same for all WebLogic Servers on all 
HPOM managed nodes, follow these steps:

a In the Set Access Info for Default Properties window, set the LOGIN and PASSWORD 
properties.

b Click Next.

c Go to step 9.

If the WebLogic Server login and password are different for different instances of 
WebLogic, you must customize the WebLogic SPI configuration by setting the LOGIN and 
PASSWORD properties at the NODE or server-specific level (for more information about 
the configuration structure, see Structure on page 155):

a In the Set Access Info for Default Properties window set the LOGIN and PASSWORD 
properties to the most commonly used WebLogic login and password.

b Select Customize to open the configuration editor.

8 In the configuration editor, set the configuration properties. For more information about 
using the configuration editor, see The Configuration Editor on page 157.

9 Click Next to save changes and exit the editor. The Confirm Operation window opens.

10  Click OK. 

If you already configured the LOGIN and PASSWORD properties, the 
configuration editor appears. Skip this step and go to step 8.

The LOGIN and PASSWORD properties set in this window are used as the default 
WebLogic Server login and password (they are set at the global properties level). If 
no NODE level or server-specific LOGIN and PASSWORD properties are set, 
WebLogic SPI uses this WebLogic login and password to access all WebLogic 
Servers. For more information about the configuration structure, see Structure on 
page 155.

If you click Cancel in the Confirm Operation window, the changes made by you are 
not saved to the selected managed nodes’ configuration and remain in the 
configuration on the management server. To make the changes to the selected 
managed nodes’ configuration, you must select those nodes in the Node Bank 
window, launch the Discovery application, click Next in the configuration editor, 
and then click OK in the Confirm Operation window
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Init Non-Root

Init Non-Root application simplifies the configuration of a non-root HTTPS agent on a UNIX 
managed node (OVO 8.x only). For information about configuring a non-root HTTPS agent on 
a UNIX managed node, see Configuring a Non-Root HTTPS Agent on a UNIX Managed Node 
(OVO 8.x Only) on page 52. 

Function

Init Non-Root performs the following functions on the selected managed nodes:

1 Runs the wasspi_wls_perl -S wasspi_wls_makePlatdef -force command to set the 
proper SPI path configuration and updates the 
/var/opt/OV/bin/instrumentation/wasspi_wls_platdef.pm and 
wasspi_wls_platdef.prop files.

2 Generates the wasspi_wls_sudoers configuration file.

To Launch the Init Non-Root Application

1 From the HPOM console, double-click OVO Node Bank. The OVO Node Bank window 
opens.

2 From the Window menu, select Application Bank. The OVO Application Bank window 
opens.

3 Double-click WLSSPI. The Application Group: WebLogic SPI window opens.

4 Double-click WLSSPI Admin. The Application Group: WLSSPI Admin window opens. All 
the WLSSPI Admin applications appear in this window.

5 Select a node from the OVO Node Bank window and double-click Init Non-Root.

Self-Healing Info 

The Self-Healing Info Application collects data that you can send to your HP support 
representative.

Required Setup

If you are collecting data for a reproducible problem, follow these steps before running the 
Self-Healing Info application:

1 Run the Start Tracing application. For more information, see Start/Stop Tracing on 
page 189.

2 Reproduce the problem.

Function

Self-Healing Info application performs the following functions:

• Saves data in the following file:

— on a UNIX managed node: /tmp/wasspi_wls_support.tar
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— on a Windows managed node: wasspi_wls_support.zip in %TEMP% directory.

• Launches and saves data using the Verify application (for more information, see Verify on 
page 189).

To Launch the Self-Healing Info Application

1 From the HPOM console, select a node in the Node Bank window. 

2 From the Window menu, select Application Bank.

In the Application Bank window select WLSSPI  WLSSPI Admin  Self-Healing Info. You can 
launch this application to collect data that you can send to the HP support representative. 

Start/Stop Monitoring

You can launch this application to start/stop the WebLogic SPI from collecting metrics from an 
application server.

The WebLogic SPI collects metrics to get performance or availability related data. Metrics are 
also used to create reports (automatically or manually generated) and graphs. These reports 
and graphs are used to analyze trends in server usage, availability, and performance.

Typically, you would stop monitoring on a managed node if the node is not running for a 
known reason. For example, the node is down for maintenance. Stopping the monitoring 
prevents unnecessary alarms from being generated.

Launch the Verify application to determine if monitoring is started or stopped. By default, 
monitoring is on.

Function

Start Monitoring application starts the collection of metrics for one or all application servers 
on a managed node.

Stop Monitoring application stops the collection of metrics for one or all application servers on 
a managed node.

This file might be hidden on some Windows managed nodes. If you do not see the 
file, open Windows Explorer and, from the Tools menu, select Folder Options. Click 
the View tab. Under Hidden files and folders, select Show hidden files and folders.
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To Launch the Start or Stop Monitoring Application

1 From the HPOM console, double-click OVO Node Bank. The OVO Node Bank window 
opens.

2  From the Window menu, select Application Bank. The OVO Application Bank window 
opens.

3 Double-click WLSSPI. The Application Group: WebLogic SPI window opens.

4 Double-click WLSSPI Admin. The Application Group: WLSSPI Admin window opens. All 
the WLSSPI Admin applications appear in this window.

5 Select a node in the Node Bank window and double-click Start Monitoring or Stop 
Monitoring.

Start/Stop Tracing

You can launch this application to starts/stop tracing the collection of metrics. You must 
launch this application only when instructed by your HP support representative.

Launch the Self-Healing Info application to collect the files created by Start Tracing. These 
files contain data that the HP support representative will use.

Function

Start Tracing saves information about the collection of metrics into a file.

Stop Tracing stops saving information about the collection of metrics.

To Launch the Start or Stop Tracing Application

1 From the HPOM console, double-click OVO Node Bank. The OVO Node Bank window 
opens. 

2 From the Window menu, select Application Bank. The OVO Application Bank window 
opens.

3 Double-click WLSSPI. The Application Group: WebLogic SPI window opens.

4 Double-click WLSSPI Admin. The Application Group: WLSSPI Admin window opens. All 
the WLSSPI Admin applications appear in this window.

5 Select a node in the Node Bank window and double-click Start Tracing or Stop Tracing. 

Verify

You can launch this application to verify whether the WebLogic SPI is properly installed on 
the server and managed node.

Function

Verify application performs the following functions:

• For all managed nodes:

• Checks that the following directories exist:

— <OV_AGT_DIR>/conf/wlsspi/
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— <OV_AGT_DIR>/wasspi/wls/datalog/

— <OV_AGT_DIR>/wasspi/wls/history/

— <OV_AGT_DIR>/wasspi/wls/lib/

— <OV_AGT_DIR>/log/wlsspi/

— <OV_AGT_DIR>/wasspi/wls/tmp/

• Checks that the following files exist:

— <OV_AGT_DIR>/conf/wlsspi/MBeanReports.dtd

— <OV_AGT_DIR>/conf/wlsspi/MBeanReports.xsl

— <OV_AGT_DIR>/conf/wlsspi/MetricDefinitions.ser

— <OV_AGT_DIR>/conf/wlsspi/MetricDefinitions.dtd

— <OV_AGT_DIR>/conf/wlsspi/MetricMap

— <OV_AGT_DIR>/conf/wlsspi/OVTrace.sample

— <OV_AGT_DIR>/conf/wlsspi/ReportsHeader.xsl

— <OV_AGT_DIR>/conf/wlsspi/SiteConfig

— <OV_AGT_DIR>/conf/wlsspi/SPIConfig

— <OV_AGT_DIR>/conf/wlsspi/SPIConfigLogFiles

— <OV_AGT_DIR>/conf/wlsspi/SPIConfigCfgFiles

— <OV_AGT_DIR>/conf/wlsspi/trigger

— <OV_AGT_DIR>/conf/wlsspi/ReportsUtil.xsl

— <OV_AGT_DIR>/wasspi/wls/lib/GraphSP.xsl

— <OV_AGT_DIR>/wasspi/wls/lib/JspiCola.jar

— <OV_AGT_DIR>/wasspi/wls/lib/MetricMap.xsl

— <OV_AGT_DIR>/wasspi/wls/lib/xalan.jar

— <OV_AGT_DIR>/wasspi/wls/lib/xerces.jar

• For Windows managed nodes:

• Checks that the following files exist:

— <OV_AGT_DIR>\bin\OpC\cmds\wasspi_wls_admin.exe

— <OV_AGT_DIR>\bin\OpC\cmds\wasspi_wls_debug.exe

— <OV_AGT_DIR>\bin\OpC\cmds\wasspi_wls_spiapps.exe

— <OV_AGT_DIR>\bin\OpC\cmds\wasspi_wls_udmgraphs.exe

— <OV_AGT_DIR>\bin\OpC\cmds\wasspi_wls_verify.exe

— <OV_AGT_DIR>\bin\OpC\monitor\wasspi_wls_ca.exe

— <OV_AGT_DIR>\bin\OpC\monitor\wasspi_wls_config.exe

— <OV_AGT_DIR>\bin\OpC\monitor\wasspi_wls_files.exe

— <OV_AGT_DIR>\bin\OpC\monitor\wasspi_wls_le.exe

— <OV_AGT_DIR>\bin\OpC\monitor\wasspi_wls_logdata.exe

— <OV_AGT_DIR>\bin\OpC\monitor\wasspi_wls_setpath.exe
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• Checks that the following files exist and the version is higher than A.01:

— <OV_AGT_DIR>\bin\OpC\monitor\ddfcomp.exe

— <OV_AGT_DIR>\bin\OpC\monitor\ddfcomp_coda.exe

— <OV_AGT_DIR>\bin\OpC\monitor\ddflog.exe

— <OV_AGT_DIR>\bin\OpC\monitor\ddflog_coda.exe

— <OV_AGT_DIR>\bin\OpC\monitor\ddfutil.exe

— <OV_AGT_DIR>\bin\OpC\monitor\ddfutil_coda.exe

• For UNIX managed nodes:

• Checks that the following files exist:

— <OV_AGT_DIR>/bin/OpC/cmds/wasspi_wls_admin

— <OV_AGT_DIR>/bin/OpC/cmds/wasspi_wls_debug

— <OV_AGT_DIR>/bin/OpC/cmds/wasspi_wls_spiapps

— <OV_AGT_DIR>/bin/OpC/cmds/wasspi_wls_udmgraphs

— <OV_AGT_DIR>/bin/OpC/cmds/wasspi_wls_verify

— <OV_AGT_DIR>/bin/OpC/monitor/wasspi_setpath

— <OV_AGT_DIR>/bin/OpC/monitor/wasspi_wls_ca

— <OV_AGT_DIR>/bin/OpC/monitor/wasspi_wls_config

— <OV_AGT_DIR>/bin/OpC/monitor/wasspi_wls_config.pl

— <OV_AGT_DIR>/bin/OpC/monitor/wasspi_wls_files

— <OV_AGT_DIR>/bin/OpC/monitor/wasspi_wls_le

— <OV_AGT_DIR>/bin/OpC/monitor/wasspi_wls_lib.pl

— <OV_AGT_DIR>/bin/OpC/monitor/wasspi_wls_logdata

— <OV_AGT_DIR>/bin/OpC/monitor/wasspi_xterm

• Checks that the following files exist and the version is higher than A.01:

— <OV_AGT_DIR>/bin/OpC/monitor/ddfcomp

— <OV_AGT_DIR>/bin/OpC/monitor/ddfcomp_coda

— <OV_AGT_DIR>/bin/OpC/monitor/ddflog

— <OV_AGT_DIR>/bin/OpC/monitor/ddflog_coda

— <OV_AGT_DIR>/bin/OpC/monitor/ddfutil

— <OV_AGT_DIR>/bin/OpC/monitor/ddfutil_coda

In this instance,  <OV_AGT_DIR> is:

• On a UNIX managed node: /var/opt/OV 
• On a Windows managed node: depends on the installation of the product
Applications 191



 To Launch the Verify Application

1 From the HPOM console, double-click OVO Node Bank. The OVO Node Bank window 
opens.

2 From the Window menu, select Application Bank. The OVO Application Bank window 
opens.

3 Double-click WLSSPI. The Application Group: WebLogic SPI window opens.

4 Double-click WLSSPI Admin. The Application Group: WLSSPI Admin window opens. All 
the WLSSPI Admin applications appear in this window. 

5 Select a node in the Node Bank window and double-click Verify.

If the application is successful the following message appears:

Installation is clean

View Error File

You can launch the Verify Error File application to view the contents of the WebLogic SPI 
error log file.

Function

View Error File application displays the contents of the WebLogic SPI error log file 
<OV_AGT_DIR>/log/wlsspi/errorlog, where <OV_AGT_DIR> typically is:

• /var/opt/OV on UNIX managed nodes

• \Program Files\HP OpenView\Installed Packages\{790 ...} on Windows 
managed nodes

To Launch the View Error File Application

1 From the HPOM console, double-click OVO Node Bank. The OVO Node Bank window 
opens.

2 From the Window menu, select Application Bank. The OVO Application Bank window 
opens.

3 Double-click WLSSPI. The Application Group: WebLogic SPI window opens.

4 Double-click WLSSPI Admin. The Application Group: WLSSPI Admin window opens. All 
the WLSSPI Admin applications appear in this window. 

5 Select a node in the Node Bank window and double-click View Error File to view the error 
logs.
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View Graphs

You can launch View Graphs application to view HP Performance Manager graphs in a web 
browser. 

Required Setup

Before running the View Graphs application:

1 Install HP Performance Manager

2 edit the ovweb.conf file (for more information see Task 1: Configure the Management 
Server to Launch Your Web Browser on page 37.)

Function

View Graphs application launches a web browser to display HP Performance Manager graphs 
generated by the WebLogic SPI metric data. 

To Launch the View Graphs Application

1 From the HPOM console, double-click OVO Node Bank. The OVO Node Bank window 
opens.

2 From the Window menu, select Application Bank. The OVO Application Bank window 
opens.

3 Double-click WLSSPI. The Application Group: WebLogic SPI window opens.

4 Double-click WLSSPI Admin. The Application Group: WLSSPI Admin window opens. All 
the WLSSPI Admin applications appear in this window. 

5 Select a node in the Node Bank window and double-click View Graphs to view the graphs.
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The WebLogic Applications Group

The WLSSPI Admin application group contains the following applications:

Check WebLogic

You can use this application to check the status of each WebLogic Server running on a selected 
managed node.

Function

Check WebLogic displays the following information for each WLS server on the selected 
nodes:

If the WebLogic SPI is configured to not collect metrics for the WebLogic Server, the following 
message appears:

Collection is temporarily OFF for <server_name>

To Launch the Check WebLogic Application

1 From the HPOM console, double-click OVO Node Bank. The OVO Node Bank window 
opens.

2 From the Window menu, select Application Bank. The OVO Application Bank window 
opens.

3 Double-click WLSSPI. The Application Group: WebLogic SPI window opens.

4 Double-click WebLogic Admin. The Application Group: WebLogic window opens. All the 
WebLogic applications appear in this window. 

5 Select a node in the Node Bank window and double-click Check WebLogic to check the 
status.

Information Description

Server Name The server name as defined in the WebLogic Server.

State The status of the WebLogic Server.

Listen Address The name and IP address used to listen for incoming connections.

Health State Numerical representation of the current state of the WebLogic Server.

Health State String What the WebLogic Server is reporting using self-health monitoring.
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Start WLS Console

You can use Start WLS Console to launch the WebLogic Administration Server console from 
the HPOM console. You can bring up the console for one instance or more instances of 
application servers on the selected managed nodes.

Required Setup

The ADMIN_HOST and ADMIN_PORTS configuration properties must be set before this 
application can run successfully.

Function

Start WLS Console launches the WebLogic Administration Server console, in a web browser, 
for one or more instances of application servers on the selected nodes.

To Launch the Start WLS Console Application

1 From the HPOM console, double-click OVO Node Bank. The OVO Node Bank window 
opens.

2 From the Window menu, select Application Bank. The OVO Application Bank window 
opens.

3 Double-click WLSSPI. The Application Group:WebLogic SPI window opens.

4 Double-click WebLogic Admin. The Application Group: WebLogic window opens. All the 
WebLogic applications appear in this window. 

5 Select a node in the Node Bank window and double-click Start WLS Console to launch the 
WebLogic Administration Server console.

Start/Stop WebLogic

You can use the Start WebLogic or Stop WebLogic application to start and stop WebLogic 
Servers from the HPOM console. You can start and stop one or more instances of application 
servers running on the selected managed nodes without logging on to each WebLogic 
Administration Server.

Required Setup

The START_CMD, STOP_CMD, and USER configuration properties must be set before 
launching this application.

Function

Start WebLogic application starts one or more instances of application servers on the selected 
managed nodes.

Stop WebLogic application stops one or more instances of application servers on the selected 
managed nodes.
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To Launch the Start or Stop WebLogic Application

1 From the HPOM console, double-click OVO Node Bank. The OVO Node Bank window 
opens.

2 From the Window menu, select Application Bank. The OVO Application Bank window 
opens.

3 Double-click WLSSPI. The Application Group: WebLogic SPI window opens.

4 Double-click WebLogic Admin. The Application Group: WebLogic window opens. All the 
WebLogic applications appear in this window. 

5 Select a node in the Node Bank window and double-click Start WebLogic or Stop WebLogic.

View Deployed Apps

You can use the View Deployed Apps application to view applications running on a WebLogic 
Server instance without logging on to the system on which the WebLogic Server is running.

Function

View Deployed Apps displays the following information for each WebLogic Server instance on 
the selected managed node (the WLS Version column denotes the information that is 
displayed based on the WebLogic Server version):

To Launch the View Deployed Apps Application

1 From the HPOM console, double-click OVO Node Bank. The OVO Node Bank window 
opens.

2 From the Window menu, select Application Bank. The OVO Application Bank window 
opens.

3 Double-click WLSSPI. The Application Group: WebLogic SPI window opens.

4 Double-click WebLogic Admin. The Application Group: WebLogic window opens. All the 
WebLogic applications appear in this window. 

5 Select a node in the Node Bank window and double-click View Deployed Apps.

Information WLS Version Description

Application 7.0, 8.1, 9.x, 
10.0

The application instance.

Name 7.0, 8.1, 9.x, 
10.0

The name of the application.

Version 9.x, 10.0 The application version (if the application is not 
versioned, “null” is displayed).

Module Type 9.x, 10.0 The J2EE module type such as CAR, EAR, EJB, RAR, or 
WAR.
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View WebLogic Log

You can use the View WebLogic Log application to view WebLogic Server log files without 
logging on to the system on which the WebLogic Server is running.

Function

View WebLogic Log application displays the following information:

• If you launch View WebLogic Log without a parameter: a numbered list of available log 
files for the managed node.

• If you launch View WebLogic Log with a non-valid parameter (a non-numeric value or a 
number not corresponding to the list of available log files): a numbered list of available log 
files for the managed node.

• If you launch View WebLogic Log with a valid parameter: the contents of the 
corresponding log file for the managed node.

You can enter only one numeric value in the parameter field. You will be able to view (for all 
selected managed nodes) the log file designated to this number. Each time you launch this 
application select one log file per managed node to view.

To Launch the View WebLogic Log Application

1 From the HPOM console, double-click OVO Node Bank. The OVO Node Bank window 
opens.

2 From the Window menu, select Application Bank. The OVO Application Bank window 
opens. 

3 Double-click WLSSPI. The Application Group: WLSSPI window opens.

4 Double-click WebLogic. The Application Group: WebLogic window opens. All the WebLogic 
applications appear in this window.

5 Select a node in the Node Bank window and double-click View WebLogic Log. The WLS 
LOGS window opens.

The WLS LOGS window contains the node name and a list of options. Enter the option of 
your choice and press Enter.

Scroll through the WebLogic SPI window to view the log file data.

6 Enter q to exit the window.
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View WebLogic Servers

You can use the View WebLogic Severs application to view the WebLogic domain 
configuration, cluster information, and physical machines without logging on to the system on 
which the WebLogic Server is running.

Function

View WebLogic Servers displays the following information for each WebLogic Server instance 
on the selected managed node (the WLS Version column denotes the information that is 
displayed based on the WebLogic Server version):

Information WLS Version Description

Domain 7.0, 8.1, 9.x, 
10.0

The WebLogic domain instance.

Admin Server 9.x, 10.0 The name of the WebLogic administration server 
instance.

Version 9.x, 10.0 The release identifier for the configuration.

Server 7.0, 8.1, 9.x, 
10.0

The WebLogic Server instance.

Name 7.0, 8.1, 9.x, 
10.0

The name of the server instance. This is the name 
displayed in the Administration Console and is used to 
identify the server.

Listen Port 7.0, 8.1, 9.x, 
10.0

The default TCP port that the WebLogic Server instance 
uses to listen for regular (non-SSL) incoming 
connections.

Listen Address 7.0, 8.1, 9.x, 
10.0

The IP address or DNS name the WebLogic Server 
instance uses to listen for incoming connections.

Cluster 7.0, 8.1, 9.x, 
10.0

The cluster instance.

Name 7.0, 8.1, 9.x, 
10.0

The user-specified name of the cluster instance.

Type 9.x, 10.0 How clustered servers send data for optimization of 
cross-cluster replication such as man (metro area 
network), wan, or none.

Address 7.0, 8.1, 9.x, 
10.0

The address used by clients to connect to the cluster and 
what is used for generating EJB handles and entity EJB 
failover addresses.

Multicast Address 7.0, 8.1, 9.x, 
10.0

The address used by cluster members to communicate 
with each other.

Machine 7.0, 8.1, 9.x, 
10.0

The machine instance.

Name 7.0, 8.1, 9.x, 
10.0

The user-specified name of the machine instance.
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To Launch the View WebLogic Severs Application

1 From the HPOM console, double-click OVO Node Bank. The OVO Node Bank window 
opens.

2 From the Window menu, select Application Bank. The OVO Application Bank window 
opens. 

3 Double-click WLSSPI. The Application Group: WLSSPI window opens.

4 Double-click WebLogic. The Application Group: WebLogic window opens. All the WebLogic 
applications appear in this window.

5 Select a node in the Node Bank window and double-click View WebLogic Servers.

View Application Activation Status

You can use View Application Activation Status application to view the activation status of 
the applications, deployed and running on a WebLogic Server instance, without logging in to 
the system on which the WebLogic Server is running. 

Required Setup

Before launching View Application Activation Status application, set the following value for 
the configuration property URL_PATH (for information on configuration properties see 
Configuration Properties on page 166):
/jndi/weblogic.management.mbeanservers.domainruntime

Function

View Application Activation Status application gives the following information for each 
WebLogic Server instance on the selected managed node. The information given in the 
Description column is dependent on the WebLogic Server version.

Table 18

Information WLS Version Description

AppRuntimeStateRuntime 9.x, 10.0 AppRuntimeStateRuntime MBean

Application ID 9.x, 10.0 Serial Number for the Application ID 
(generated by the SPI)

Application-ID 9.x, 10.0 The name of the application

Is Active? 9.x, 10.0 If "true" is displayed in this field, the 
application is active. If "false" is 
displayed, the application is inactive 
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To Launch the View Application Activation Status Application

1 From the HPOM console, double-click OVO Node Bank. The OVO Node Bank window 
opens.

2 From the Window menu, select Application Bank. The OVO Application Bank window 
opens. 

3 Double-click WLSSPI. The Application Group: WLSSPI window opens.

4 Double-click WebLogic. The Application Group: WebLogic window opens. All the WebLogic 
applications appear in this window.

5 Select a node in the Node Bank window and double-click View Application Activation Status.

View Application Timeout

View Application Timeout application enables you to view the time left before retiring 
applications, deployed and running on a WebLogic Server instance, will timeout. You can view 
the time left without logging in to the system on which the WebLogic Server is running.

Required Setup

Before launching View Application Timeout application, set the following value for the 
configuration property URL_PATH (for information on configuration properties see 
Configuration Properties on page 166):
/jndi/weblogic.management.mbeanservers.domainruntime

Function

You can use the View Application Timeout application to get the following information for 
each WebLogic Server instance on the selected managed node. The information given in the 
Description column is dependent on the WebLogic Server version.

Table 19

Information WLS Version Description

AppRuntimeStateRuntime 9.x, 10.0 AppRuntimeStateRuntime MBean

Application ID 9.x, 10.0 Serial Number for the Application ID 
(generated by the SPI)

Application-ID 9.x, 10.0 The name of the application

Time Left to Retire 9.x, 10.0 The amount of time the application is 
given to retire (This returns the value 
"-1" if only one version of the 
application exists on the server and no 
timeout is set for the applications). 
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To Launch the View Application Timeout Application

1 From the HPOM console, double-click OVO Node Bank. The OVO Node Bank window 
opens.

2 From the Window menu, select Application Bank. The OVO Application Bank window 
opens. 

3 Double-click WLSSPI. The Application Group: WLSSPI window opens.

4 Double-click WebLogic. The Application Group: WebLogic window opens. All the WebLogic 
applications appear in this window.

5 Select a node in the Node Bank window and double-click View Application Timeout.
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Glossary
agent

A program or process running on a remote device or computer system that responds to 
management requests, performs management operations, or sends performance and event 
notification. An agent can provide access to managed objects and MIB variables, interpret 
policy for resources and do configuration of resources.

application

Packaged software that provides functionality that is designed to accomplish a set of related 
tasks. An application is generally more complex than a tool.

ASCII

American Standard Code for Information Interchange.

assigned policy

A policy that has been assigned to one or more resources in the computing environment but 
which has not yet been deployed or installed on those resources.

automatic action

A pre-configured program or script that is executed in response to an event, message, or a 
change in information in the management database. without operator intervention.

client

When the context is network systems, a computer system on a network that accesses a service 
from another computer (server). When the context is software, a program or executable 
process that requests a service from a server.

client console

An instance of the user interface that appears on the client system while the application runs 
on a server.

command

An instruction to a computer program that causes a specified operation to be carried out. 
Commands are typically typed by users on a command line.

configuration

In a network context, the complete set of inter-related systems, devices and programs that 
make up the network. For example the components of a network may include computer 
systems, routers, switches, hubs, operating systems and network software. The configuration 
of the network determines the way that it works and the way that it is used. In a software 
context, the combination of settings of software parameters and attributes that determine the 
way the software works, the way it is used, and how it appears.
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configuration file

A file that contains specifications or information that can be used for determining how a 
software program should look and operate.

configure

To define and modify specified software settings to fulfill the requirements of a specified 
environment, application or usage. 

connection

A representation of a logical or physical relationship between objects.

console

An instance of the user interface from which the user can control an application or set of 
applications.

customization

The process of designing, constructing or modifying software to meet the needs and 
preferences of a particular customer or user.

customize

To design, construct or modify software to meet the needs and preferences of a particular 
customer or user.

data type

A particular kind of data; for example database A repository of data that is electronically 
stored. Typically databases are organized so that data can be retrieved and updated.

deploy

To install and start software, hardware, capabilities, or services so that they work in the 
business environment.

Deployed application

An application and its components that have been installed and started to work in the 
business environment.

deployed policy

A policy that is deployed on one or more resources in the computing environment.

deployment

The process of installing and activating software, hardware, capabilities or services so that 
they work in the business environment.

Deployment package

A software package that can be deployed automatically and installed on a managed node.

error log

An output file containing error messages.
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event

An event is an unsolicited notification such as an SNMP trap or WMI notification generated 
by an agent or process in a managed object or by a user action. Events usually indicate a 
change in the state of a managed object or cause an action to occur. 

HP Operations Manager

A family of network and system management products, and an architecture for those 
products. HP Operations Manager includes development environments and a wide variety of 
management applications.

Hypertext Transfer Protocol (HTTP).

The protocol that World Wide Web clients and servers use to communicate.

HTTPS

Hypertext Transfer Protocol Secure. 

icon

An on-screen image that represents objects that can be monitored or manipulated by the user 
or actions that can be executed by the user.

managed object

A network, system, software or service object that is both monitored for performance, status 
and messages and is manipulated by means of actions in the management software.

management console

An instance of the user interface from which the user can control the management application 
or set of management applications. The console may be on the system that contains the 
management software or it may be on another system in the management domain.

management server

A server that provides management services, processes, or a management user interface to 
clients. A management server is a type of management station.

message

A structured, readable notification that is generated as a result of an event, the evaluation of 
one or more events relative to specified conditions, or a change in application, system, 
network, or service status.

message browser

A graphical user interface that presents notifications that are generated as a result of an 
event, the evaluation of one or more events relative to specified conditions or a change in 
application, system, network, or service status.

message description

Detailed information about an event or message.
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message key

A message attribute that is a string used to identify messages that were triggered from 
particular events.The string summarizes the important characteristics of the event. Message 
keys can be used to allow messages to acknowledge other messages, and allows for the 
identification of duplicate messages.

message severity level

A property of a message indicating the level of impact of the event or notification that 
initiated the message. See also severity level.

metadata

Data that defines data.

metric

A measurement that defines a specific operational or performance characteristic.

Microsoft Management Console (MMC)

A Microsoft product that provides a software framework for the management of IT 
environments. Management products are added or "snapped into" the management console 
and thus extend the management capability of the Microsoft Management Console.

module

A self-contained software component that performs a specific type of task or provides for the 
presentation of a specific type of data. Modules can interact with one another and with other 
software.

node

When the context is network, a computer system or device (for example, printer, router, 
bridge) in a network. When the context is a graphical point to point layout, a graphical 
element in a drawing that acts as a junction or connection point for other graphical elements.

parameter

A variable or attribute that may be given an arbitrary value for use during an execution of 
either a computer program or a procedure within a program.

parameter type

An abstraction or categorization of a parameter that determines the particular kind of data 
that is valid for the parameter. For example a parameter type could be IP Address which 
indicates that parameter values must have 4 numbers separated by decimals with the value 
for each number being in the range of 0 to 255.

parameter value

A value that is given to a variable.

policy

A set of one or more specifications rules and other information that help automate network, 
system, service, and process management. Policies can be deployed to various targets (for 
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example, managed systems, devices, network interfaces) providing consistent, automated 
administration across the network.

Policy management

The process of controlling policies (for example, creating, editing, tracking, deploying, 
deleting) for the purposes of network, system or service management.

policy type

An abstraction or categorization of policies based on the function of the policy or the services 
that the policy supports.

port

If the context is hardware, a location for passing information into and out of a network device. 
If the context is ECS, a location for passing information into and out of a correlation node.

server

If the context is hardware plus software, a computer system that provides a service (for 
example, management capabilities, file storage capabilities) to other computer systems 
(clients) on the network. If the context is a software component, a program or executable 
process that responds to and services requests issued by clients.

severity level

A property of an object indicating the status of the object. Severity level is based on the impact 
of events or messages associated with the object.

SMART Plug-In (SPI)

Prepackaged software that installs into a management console and provides management 
capabilities specific to a given type of business application, database, operating system, or 
service.

trace log

An output file containing records of the execution of application software
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Index
A
actions

automatic, 61
customizing, 61
distributing, 44
operator-initiated, 61

Add Application Server action, 159, 160

adding
nodes to WebLogic SPI node group, 49

Add Node action, 159, 161

ADDRESS property, 47, 168

ADMIN_HOST property, 168

ADMIN_PORTS property, 47, 168, 169

alarms
modifying, 62

ALIAS property, 170

application bank
reports, 72

applications, 18, 183
Check WebLogic, 20, 194
Configure WLSSPI, 19, 184
Deploy UDM, 21
Discover, 45, 185
Discover WebLogic, 19
Gather MBean Data, 21
Init Non-Root, 19, 187
JMX Metric Builder, 22
Self-Healing Info, 19, 187
Start Monitoring, 19, 188
Start Tracing, 19, 189
Start WebLogic, 20, 195
Start WLS Console, 20, 195
Stop Monitoring, 19, 188
Stop Tracing, 19, 189
Stop WebLogic, 20, 195
UDM Graph Disable, 22
UDM Graph Enable, 22
Verify, 19, 189
View Application Activation Status, 20
View Application Timeout, 21
View Deployed Apps, 20, 196
View Error File, 19, 192
View Graphs, 20, 193
View WebLogic Log, 20, 197
View WebLogic Servers, 20, 198
WebLogic group, 20
WebLogic SPI Reports group, 21
WLSSPI Admin group, 18

application server
verifying status, 41

Application Servers tree item, 158

ASCII-Text Reports, 15

assigning operator responsibilities, 31, 38

AUTO_DISCOVER, 164

AUTO_DISCOVER property, 170

automatic action reports, 71

automatic actions, 61

B
BEA_HOME_LIST property, 171
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C
Cancel button, 159

Check WebLogic application, 20, 194
what it does, 194

CODA
using, 82

COLLECT_METADATA property, 171

collection intervals
changing, 67
changing for selected metrics, 68

collector
wasspi_wls_ca command, 63

collector templates, 22

commands
distributing, 44

components, 18

conditional properties
configuring, 51
setting, 51

configuration
properties, 166
structure, 155
syntax, 155

configuration editor
 See Config WLSSPI

configuration example
group and node properties, 179
multiple WLS versions, 180
non-default WLS startup location, 181
single node/two servers, 178
virtual IP addresses, 180

Configuration tree item, 158

Configure WLSSPI application, 184
what it does, 184

configuring
HP Performance Manager, 37
managed nodes, 41
management server, 37, 43
ovweb.conf, 37
prerequisites, 37
remote systems, 77
WebLogic Server user, 41

Config WLSSPI
actions, 159
Add Application Server action, 159, 160
Add Group action, 159, 161
Add Node action, 159, 161
Application Servers tree item, 158
buttons, 159
Cancel button, 159
Configuration tree item, 158
Default Properties tree item, 158
Defaults tree item, 158
Exit action, 160
Finish button, 159
Groups tree item, 158
icons, 157
Next button, 159
Nodes tree item, 158
Remove ALL App Servers action, 160, 162
Remove ALL Groups, 160, 162
Remove ALL Nodes action, 160, 163
Remove Application Server action, 160, 162
Remove Group action, 160, 162
Remove Node action, 160, 163
Save action, 160
Save button, 159
Set Configuration Properties tab, 160, 163
tree, 157
using, 157
View Configuration Settings tab, 160, 164

Config WLSSPI application, 19

customization, 14

customizing
actions, 61
duration, 60
message text, 61
severity, 60
thresholds, 60

D
Default Properties tree item, 158

Defaults tree item, 158

Deploy UDM application, 21

directories
locations for trace file/error logs, 104

Discover application, 19, 45, 185
setting LOGIN and PASSWORD, 46
what it does, 185

discovery process
verifying, 48

discovery template, 23

displaying graphed metrics, 37
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distributing
actions, monitors, and commands, 44
templates, 49

duration
customizing, 60

E
editing

alarms, 62
templates, 59

error messages, 111 to 152

EXCLUDE_SAMPLES property, 48, 172

Exit action, 160

F
files, locations on management server/managed 

nodes, 102, 104

Finish button, 159

G
Gather MBean Data application, 21

global properties, 155

GRAPH_URL property, 172

graphs
date range, 91
generating, 91
HP Performance Manager, 81
metrics used to generate, 88
operator action, 91
viewing alarm conditions, 87
viewing conditions, 88

GROUP block, 155

Groups tree item, 158

H
HOME_LIST property, 47, 172

HOME property, 172

HP Performance Agent, 81

HP Performance Insight reports, 86

HP Performance Manager
integrating with WebLogic SPI, 37, 87

I
Init Non-Root application, 19, 187

what it does, 187

installing, 25
swinstall, 25
WebLogic SPI report package, 82

instruction text
location, 15

J
JAVA_HOME property, 48, 172

JMB_JAVA_HOME property, 172

JMX_CLASSPATH property, 173

JMX Metric Builder application, 22

K
KEYSTORE property, 173

L
license count, 80

limitations
remote systems, 80

LOGFILE property, 173

logfiles templates, 22

LOGIN property (WLS version 7.0, 8.1), 173

M
managed nodes

adding to WebLogic SPI node group, 49
configuring, 41

management server
configuring, 43

MAX_ERROR_LOG_SIZE property, 173

messages
instruction text, 15
message browser, 14

message template, 23

message text
customizing, 61

metrics
data collected, 13
graphs generated from, 88
HP Performance Insight reports generated from, 

86
Reporter reports generated from, 84

metrics templates, 22

modifying
alarms, 62
templates, 59
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monitoring
logfiles on remote systems, 79
unsupported platforms, 76

monitors
distributing, 44

N
NAME property, 173

Next button, 159

NODE_NAMES property, 48, 174

NODE block, 156

Nodes tree item, 158

NUM_SERVERS property, 174

O
operator

assigning responsibilities, 31, 38

operator-initiated actions, 61

ov.envvars.sh, 37

OV_CONF environment variable, 37

ovweb.conf
configuring, 37
OV_CONF environment variable, 37

P
PASSPHRASE property, 174

PASSWORD property (WLS version 7.0, 8.1), 174

PORT property, 174

prerequisites
configuring, 37

properties, 166
configuring conditional, 51
definitions, 167 to 177
global, 155
listed by WebLogic SPI requirements, 167
precedence, 156
server-specific, 156
setting conditional, 51

PROTOCOL, 48

PROTOCOL property, 174

R
reinstalling

templates, 70

remote systems, 76
configuration requirements, 77
configuring, 77
how it works, 76
limitations, 80
logfile monitoring, 79
overview, 76
requirements, 76
template requirements, 77

Remove ALL App Servers action, 160, 162

Remove ALL Groups action, 160, 162

Remove All Nodes action, 160, 163

Remove Application Server action, 160, 162

Remove Group action, 160, 162

Remove Node action, 160, 163

removing
swremove, 30
WebLogic SPI, 26

Reporter
integrating with WebLogic SPI, 82

Reporter reports, 84

Report package, 16

report package
installing, 34, 82
removing, 28

reports
application bank, 72
automatic action, 71
generated from alarms, 21
HP Performance Insight, 81
included, 16
Manually Generated Reports, 72
metrics used to generate in OVPI, 86
metrics used to generate in Reporter, 84
OVPI, 86
Reporter, 81, 84
viewing, 72, 73

requirements
remote systems, 76

resetting thresholds, 62

RMID_PORT property, 175

RMID_START_TIME property, 175

S
Sample Reports, 73

Save action, 160

Save button, 159

schedule templates, 22
212



Self-Healing Info application, 19, 187
how to run, 188
required setup, 187
what it does, 187

server-specific properties, 156

Set Configuration Properties, 160

Set Configuration Properties tab, 163

Set Configuration Settings tab
AUTO_DISCOVER, 164
modifying a property, 164
removing a property, 164
setting a property, 163

setting
conditional properties, 51

severity
customizing, 60

START_CMD property, 175

Start Monitoring application, 19, 188
what it does, 188

Start Tracing application, 19, 189
what it does, 189

Start WebLogic application, 20, 195
required setup, 195
what it does, 195

Start WLS Console application, 20, 195
required setup, 195
what it does, 195

status of application server
verifying, 41

STOP_CMD property, 175

Stop Monitoring application, 19, 188
what it does, 188

Stop Tracing application, 19, 189
what it does, 189

Stop WebLogic application, 20, 195
required setup, 195
what it does, 195

structure
configuration, 155

swinstall, 25
reinstalling templates, 70

swremove, 30

syntax
configuration, 155

T
tag option

creating custom template groups, 69

template groups, 22
changing collection intervals, 68
customizing, 69
WLSSPI Discovery, 23
WLSSPI-Logfiles, 22
WLSSPI-Metrics, 22
WLSSPI-Schedule, 22

templates, 22
collector, 22
continuously setting, 62
customizing, 59
discovery, 23
distributing, 49
logfiles, 22
message, 23
metrics, 22
modifying, 59
reinstalling, 70
resetting thresholds, 62
Schedule, 22
thresholds without reset, 62
WLSSPI-Messages, 23

thresholds
customizing, 60
resetting, 62
settings for different servers, 68
without reset, 62

TIMEOUT property, 176

To Launch Check WebLogic application, 194

To Launch Configure WLSSPI application, 184

To Launch Discover WebLogic application, 185

To Launch Init Non-Root application, 187

To Launch Start/Stop Monitoring application, 189

To Launch Start/Stop Tracing application, 189

To Launch Start/Stop WebLogic application, 196

To Launch Start WLS Console application, 195

To Launch Verify application, 192

To Launch View Application Activation Status 
application, 200

To Launch View Application Timeout application, 
201

To Launch View Deployed Apps application, 196

To Launch View Error File application, 192

To Launch View Graphs application, 193

To Launch View WebLogic Log application, 197

To Launch View WebLogic Severs application, 199

TYPE property, 176
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U
UDM_DEFINITONS_SOURCE property, 176

UDM Graph Disable application, 22

UDM Graph Enable application, 22

unsupported platforms
monitoring, 76

upgrading, 29
WebLogic SPI, 30
WebLogic SPI graph package, 34
WebLogic SPI report package, 28, 34

URL, 176

URL_PATH Property, 176

user
configuring WebLogic Server, 41

user defined metrics
graphing, 100

USER property, 176

using
Config WLSSPI, 157

Using the JMX Command Parameters, 65

V
Verify application, 19, 189

what it does, 189

verifying
application server status, 41
discovery process, 48

VERSION property, 177

View Application Activation Status, 199

View Application Activation Status application, 199
Function, 199
Required Setup, 199

View Application Timeout, 200

View Application Timeout application, 200
Function, 200

View Configuration Settings tab
View Inherited Properties, 165

View Current Configuration, 160

View Current Configuration tab, 164

View Deployed Apps application, 20, 196
what it does, 196

View Error File application, 19, 192
what it does, 192

View Graphs application, 20, 193
required setup, 193
what it does, 193

viewing
reports, 72, 73

Viewing Text-based Reports, 71

View Inherited Properties, 165

View WebLogic Log application, 20, 197
what it does, 197

View WebLogic Servers application, 20, 198
what it does, 198

W
WASSPI-35, 123, 124, 125, 126

wasspi_wls_ca command, 63
parameters, 63

WebLogic application group, 20

WebLogic Server user
configuring, 41

WebLogic SPI
components, 18
overview, 14

WebLogic SPI node group
adding nodes, 49

WebLogic SPI Reports application group, 21

WLSSPI Admin application group, 18

WLSSPI Discovery template group, 23

WLSSPI-Logfiles template group, 22

WLSSPI-Messages template, 23

WLSSPI-Metrics template group, 22

WLSSPI-Schedule template group, 22
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